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How to Use this Workbook

Each Main Heading describes a

/ high-level valuable learning topic.

1. Measuring the Process Against Database Values

Your objectives are skills you

Objectives can expect to learn in this
o  Createa Pl ProcessBook Isplar™ | ~~m~immae +
e Inserta Trend into a Display

e (Create an ODBC Dataset

1.1 Using ODBC DataSets

From Wikipedia

2, ODBC (Open Database Conneciiviy | New Concepts are presented as
tabase management systems (DBMS) T} Ievel 2 headlngS

1.2 Group Question

The folloWmg question(s)s a .
chapter or sectidr Throughout the class you will be
presented with questions and

challenges to help you learn.

Questions

1 What scenanos can you think of where relaesatdatascnld be s bl o DL Do cacs Back
dapay? The majority of your time will be
spent learning new skills via
/ hand-son exercises, either in
small groups or on your own.

1.3 Exercise - Create and Display

The following questions are intended to reinforce key information presented in this
chapter or section. The answers can be found in the next ste
section

»-by-step instruction

Problem Description

Icons help you identify themes,
The control system reports the current ) like exerCiseS, tOOIS, tipS, or

This number can change from0to 10d .

has its own target. high reject limit. and documentatlon references-

User manuals, Learning workbooks, and other materials used in class can be
downloaded from http://techsupport.osisoft.com. Login to an OSlsoft technical
support account is required.
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Software Versions Used in this Document

The list below describes the software versions used in this version of the course.

Software Version

PI DataLink 2017 SP2
Microsoft Office 2016

P1 ODBC Driver 2016 R2

PI Integrator for Business Analytics Advanced Edition 2018

PI OLEDB Enterprise 2017 R2
Microsoft SQL Server 2014

PI Data Archive 2018

Pl Asset Framework 2018

PI Vision 2017 R2 SP1
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1 Welcome

Welcome to the Analyzing Pl System Data Course!

Since you are attending this class, you should have some experience with OSlsoft
Client Tools (PI ProcessBook, PI DataLink, Pl WebParts and PI Vision), either using
displays, reports or webpages previously created to analyze your data, or creating
these displays, reports and webpages so that others in your organization have
access to all the powerful data that resides in the Data Archive and data external to
the Pl System.

The basic tasks within these tools are presumed to be understood; what you will
experience here can be seen as a factory of ideas, a space for OSlsoft customers to
realize how powerful existing data can be when analyzed with the advanced options
of our tools and additional third party tools, and integrated with non-PI data.

Hope you enjoy!

1.1 Course Environment

The environment for this course is being hosted with Azure. The environment has 3
VM and contain the following:

e PIDC — Domain Controller
o PISRVO1 — The server environment
o Microsoft SQL Server 2014
PI Data Archive 2018
Pl AF Server 2018
PI AF Client 2018
PI Vision 2017 R2 SP1
o Pl Integrator for Business Analytics Advanced Edition 2018
e PICLIENTO1 — This is the primary working environment.
o Pl System Explorer 2018
o Microsoft Office Professional Plus 2016 (64-bit)
o Microsoft PowerBI Desktop 2.59.5135.781
o Google Chrome 68.0.3440.106

O
O
O
O

The userid for each student is pischool\student01, password will be provided by
the instructor.

fg) OSlsoft.
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1.2 Review Pl System Architecture

Objectives:

¢ Define the components of a Pl System
o Draw a diagram of the architecture of a Pl System

1.2.1 The Pl System Described

The Pl System collects, stores, and manages data from your plant or process. You
connect your data sources to one or more Pl Interface nodes. The Interface Nodes
get the data from your data sources (control systems, instrumentation, etc) and send
it to the Data Archive. The data is organized and given context using Pl Asset
Framework. Users get data from the Data Archive and Asset Framework and work
with it using a variety of client tools, such as Pl Vision and PI DataL.ink.

Pl Server Data
consumer
Data Q
Source —o— (@) P! Visualization Tool {—o—o @
Asset Framework
(@ Pl Interface —— @
Data Archive
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1.2.2 Architecture of a Typical Pl System

Sometimes the architecture can be very simple. Some customers have as few as
one or two interfaces feeding data to a single Data Archive. Access to data is

through the single Data Archive.

Network Devices  [g@y,
IT Monitor 3

Process
Controls
DCS/PLC
OopPC

Relational
Database

HTML /
Web Service
PI Cloud
Connect

Text/
Flat Files

Plto Pl

Data Sources

There are often several Data Archives in an organization, aggregating data from
lower levels. Some corporations have Data Archives dedicated to servicing their

3R

450+ Pl Interfaces and
PI Connectors
(Failover)

<d |
X

Pl Manual Logger

Process Control
Network (PCN)

clients with restricted company data.

N

Site Pl Data
Archive

DMZ

Pl AF Server
Asset Analytics
Event Frames
Notifications

HQ PI Data
Archive

YA

Pl Vision
Pl Web API

77
®

SQL Server

% &0

Pl ProcessBook

]
VY, PI DataLink

ey

Corporate LAN

Mobile Devices

Pl Vision

VPN

N
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1.3 Assets and Tags — The Basic Building Blocks in the Pl System

Objectives:

o Define an AF Asset with its components element and attributes.
Define four attribute types: Static (None), Pl Point, Formula, and Table
Lookup.

o Define a Data Archive Tag with the attributes Tag Name, Descriptor, and
Point Source.

o Define the different data types that can be stored in Data Archive Tags.

Figure 3: Tag Auto Creation

1.3.1 What is an Asset?

The AF Server is a part of the Pl System. It contains asset or “metadata” usually
organized according to the assets containing the attributes being monitored. AF can
be helpful to users of the Data Archive who know the assets, but are not familiar with
attribute nomenclature. With assets, data can be located without understanding the
technical details of each piece of equipment. Organized assets help find all of the
attributes associated with a specific piece of equipment.

1.3.2 What is an AF Attribute?

Attributes represent a unigue property associated with an asset. The attribute
maybe a constant, a value from an internal AF table, a value from an external
database or a storage point for data in the Data Archive. An AF attribute is simply a
single point of measurement. The point has been the traditional storage method of
data in the Data Archive. The AF Server can automatically generate points as
assets are created.

1.3.3 Some Basic Properties and Why They Are Important to You

AF attributes and Data Archive points have a set of properties that define them.
Some common properties used in client tools are for display or informational
purposes.
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Attribute name

The attribute name is similar in concept to the point description. A detailed name for
the attribute may help the user identify the source of the information.

General | Attribute Templates | Ports | Analysis Templates

‘ Fiter

|s°’ 1% Name | Description

= Category: <None>

=3 CarbonEmissions grams of CO2 ge...

=m Rate Average generati...

Figure 6: Attribute Name

Tag name

Unique name is used to create points for storage in the Data Archive. Points for data
attributes storage can be built through AF templates using substitution parameters
for local naming convention or can be searched for on the Data Archive.
Creating points through templates, lends consistency in nomenclature making
searches easier for Pl Administrators. For example, which might be easier to locate
in a search?

Point: M03_E1P1 _MOTDRV1202 RUNSTAT
Attribute: Machine3 Enclosure 1 Panel 1 Motor Drive 1202 Run Status

Substitution parameters are variables placed in attribute templates for PI point and Pl point
array data references representing portions of the AF hierarchy.

For example, %Element% is a substitution parameter that represents the element name. After
you create an element based on that template, you tell AF to create the data reference. When
AF creates the reference, it substitutes the current element name wherever %Element% is
present.

Ig) OSlsoft. Page 9



Analyzing Pl System Data

Descriptor

This is the human-friendly description of the Data Archive Point, similar to the
attribute. The descriptor is often a search criterion since the point name is not
always intuitive. Often the point name is some sort of abbreviated convention and
the descriptor captures the “full name.”

Point source

Points can be related to their interfaces that collect the data by a point attribute
called pointsource. Grouping by point source allows all of points associated with a
particular device to be identified by searching for all points of a certain point source.
This assumes that the user knows the point sources in use and that will not be true in
most situations.

Point type

The PI point attribute that specifies the data type for the values that a point stores.
The possible point types include intl16, int32, float16, float32, float64, digital, string,
BLOB, and timestamp.

PI Point Data Reference &J
PI Server: %aServerts A B
@ Tag name:  %Element%.%Attribute%
Tag Creation
pointtype=Floate4
() Attribute: r ; ” ~——
Tag Creation Settings ﬁ
Unit of Measure
s
TR T Point Class: ’base '] m
Value retrieval methods Point Type: ’F\oat64 - ]
By Time: Automatic
Point Attribute Value o
Relative Time: descriptor
- exdesc
By Time Range: End Time )
typicalvalue 50
Calculation basis: Time Weighted engunits L
Min percent good: 80 2810 0
span 100
pointsource Lab
Read only scan 1
o ][ | oom o
EXCmax 600
excdev 1
shutdown 1
archiving 1
compressing 1
step 0
compmin 0
COMNMAY 28R00 i
oK l l Cancel

10
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1.4 Discussion

This is a discussion designed to maximize learning in a specific topic area.
Your instructor will have questions, and will prompt for communication within
the class. This is an open ended section and the result depends on your
needs.

Objective: The AF data is to be included within our Business Intelligence tools.
What data do we want to see? This can be in the context of your own system, or the
example AF databases available in the class.

Approach

e What do we currently use our AF databases for regrading report generation?
¢ Within the example database, what else do we want to know? What is
missing?
Pros and cons of including external asset related data within the AF structure
e What sort of Bl tools would we want to use to view this data?

Estimated Completion time 15 minutes.

y
vf
]
{

| &
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2 Business Intelligence

Business intelligence (BI) tools offer solutions to quickly analyze raw, un-normalized,
multidimensional data. In concert with historical values from the Data Archive,
metadata and calculations from Asset Framework, and business intelligence tools,
users can quickly create interactive reports to gain insight on business and
operational processes.

Later on in the course, we will explore the process of preparing the Asset Framework
model to add additional dimensions of information to our AF database. The next step
is extracting desired information (process data, metadata, and event frame data)
from the Pl System through PI Data Access tools. This data will be incorporated into
a Bl cube and used to develop interactive reports that allow us to “slice and dice” our
data and bring meaning to our multidimensional data cube.

The Distribution Network and Fleet
Generation databases have a GAooL n n
comprehensive amount of information e , I
including a hierarchy of substations,
metadata for each asset. The figure to the (a0 - H o m

right depicts a data cube that captures — e
metadata and real-time data of generating scuor
units. » m m »
[ | I I I
-‘ i i i L
A A Opersor Technology Yeld  GrossGen. NetGen.

N

Inclusion of additional attributes
through table lookups and analytics
on existing attributes allow for the
expansion of additional columns (or
dimensions) to the data cube above.

Further, historical data, interpolated
or compressed, add an additional

| dimension of information that bring
-‘ B § P P Tmal more meaning in Business

Operator Technology  Vield  Gross Gen. NetGen. ’ Intelligence reports.

ST W

B
NI ST
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In the next several chapters in the course, we will be using a pair of AF databases to
expose meaningful data that will help management and engineers make better, more
informed decisions. Specifically, we will add value through the following:

Expose the database in a simpler structure for data processing.
Develop analytics within PI AF and PI Integrator for Business Analytics

Import the data into Microsoft Power BI

AP w DN PRE

Draw actionable conclusions from the resulting data sets in our reports

2.1 Intro to Power Bl

Power Bl is a business analytics service and client provided by Microsoft. It provides interactive
visualizations with self-service business intelligence capabilities, where end users can create
reports and dashboards by themselves, without having to depend on information technology
staff or database administrators.

Some of the benefits of Power BI:

e Less work than Excel for more complex analysis and visuals

e Can solve problems that are simply too large for Excel and Pl DatalLink
e Cheap — Free download or $9.99 / month per user for Power Bl Pro

e Live reporting and centralized web-based dashboards in Office 365

e Slick visuals including 3" Party Visuals in Microsoft AppSource

2.2 Directed Activity — Inspect a Sample Power Bl Report

In this part of the class you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

e Explore a sample Power Bl Report.

é) OSlsoft. Page 13
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Approach

We'll start by getting a feel for Power Bl using a pre-built report. Open C:\Class\Part 1 - PI
Integrator for BA\Solutions\Transformer Loading.pbix

Transformer High Loading

High Circuit Loading Pole Transformers

Secondary Transformer  Phaze Service Hours 3:;@;; of Loading Pl Vision

. PT_XYZ0109 X Phase 2208 13050 @

- PT_XYZ0911 X Phase 2208 12220 @

PT_XYZ0377 Z Phase 2208 M1 @

I PT_XYZ0096 X Phase 2208 1699 @

PT_XYZ0884 Z Phase 2208 10306 @

PT_XYZ0566 Y Phase 2208 %66 @

I PT_XYZ0071 'Y Phase 2208 9568 @

PT_XYZ0410 Z Phase 2208 9294 @

PT_XYZ0&844 X Phase 2208 8750 @

PT_XYZ1470 X Phase 2208 8337 @

T PT_XYZ0126 X Phase 2208 8292 @

PT_XYZ0589 X Phase 2208 8163 @

PT_XYZ0428 Z Phase 2208 81.24 @

PT_XYZ0254 X Phase 2208 8108 @

X PT_XYZ0195 'Y Phase 2208 80.18 @

o PT_XYZ0210 X Phase 2208 7963 @

Loading (25%) 150 175 200 @225 @250 @275 PT_XYZ0587 X Phase 2208 7953 @

PT_XYZ0063 X Phase 2208 7823 @

PT_XYZ0065 Y Phase 2208 7801 @

PT_XYZ0603 X Phase 2208 7636 @

Right now we’re looking at the Report View where the report and visuals are configured. Start
clicking on the visuals and the rest of the report will be filtered to only include the selected items.
This is often referred to as slicing and dicing the data.

Click on the Data Tab to inspect the data set we’ll be working with:

sl | H S = | Transformer Loading Scratch - Power Bl Desktop

Home View Modeling Help

(5o B B 3 &g
() 5}
) ,/J L L |_—'|;|Image

Copy
Paste . Get Recent  Enter Edit Refresh Mew  New
Format Painter  pata~ Sources~ Data  Queries~ Page~ Visual CFShapes~
Clipboard External data Insert

H-

Transforn

High Circuit Loading

Colegio Cientifico .

14
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Note that all the columns are available in the Fields List:

ol | H = | Transformer Loading Scratch - Power Bl Desktop — O X |
Home IModeling Help Sign in o

A=Y m

Paste Get Recent Enter Edit Refresh Mew  New From From Publish
Data = Sources = Data Queries = Page ~ Visual Marketplace File

External data

gl Mew Measure

|j MNew Column
Manage

Relationships L@l New Quick Measure

Clipboard Insert Custoam visuals Relationships Caleulations Share

FIELDS
Circuit

San Pablo Transformer 1 Escuelaloaguin PT_XYZ1579
PT_XYZ1579
PT_XYZ1579
PT_XYZ1579 |
PT_XYZ1579
PT_XYZ1579
PT_XYZ1579

PT_XYZ1579

San Pablo Transformer 1 Escuela loaquin

San Pablo Transformer 1 Escuelaloaquin

4 B Transformer Loading

San Pablo Transformer 1 EscuelaJoaguin

| Circuit

i Day

2 Day Name
Headqguarters

Headguarters Hi...

San Pablo Transformer 1 Escuela Joaguin

San Pablo Transformer 1 Escuelaloaguin

San Pablo Transformer 1 Escuelaloaguin

VI - T ¥ R - TR T

San Pablo Transformer 1 Escuelaloaguin

2

Go back to the Report View, click on the Pole Transformers Table visual, and note the
Visualizations Pane and Fields Pane. These sections are where the bulk of the configuration
takes place. Columns from the data set are dragged and dropped from the Fields Pane onto the
various sections in the Visualizations Pane. We can see that the Secondary Transformer,
Phase, Service Hours, Average of Loading, and PI Vision columns are being displayed in the
table.

VISUALIZATIONS FIELDS

<« B Tan
W Circuit
M iE Day
M 2 Day Name
W Headquarters
W " : Headquarters ...
W = Hour
W= d

Secondary Transformer
Phase

Service Hours

Average of Loading

Pl Vision

FILTERS

Visual level filters
Average of Loading (All)
Phase (All)

Pl Vision (All)

Secondary Transformer
top 20 by Average of ...

5 Loading
W Loading (25%)
W 5 Maximum KVA
W = Month

W Month Name
Phase

P21 Pl Vision

W = PlintShapelD
M = PlintTSTicks
M = Rated KVA

Secondary Tra...

® Service Hours

M  Single Transfo...

W  Substation
W TimeStamp

OSlsoft.

Page 15
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Add the Voltage Average column to the table by selecting the table and doing a drag and drop:

M i Day
W F# Day Name
W Headquarters
W " : Headquarters ...
W = Hour
W= d

= Loading
W Loading (25%)
W = Maximum KVA
Average of Loading B = Month

PlVision W Month Name
= = Voltage fve—
Phase
FILTERS M4 2 Pl Vision
W = PlintShapelD
W = PlintTSTicks
Average of Loading (All) W = Rated KVA

Secondary Transformer
Phase

Service Hours

Visual level filters

Phase (All} Secondary Tra...
B Service Hours
Single Transfo...
Secondary Transformer Substation

Pl Vision (All)

top 20 by Average of ... TimeStamp

Service Hours (All) Transformer T...

The Voltage Average will be displayed in the table, but by default all the voltages from all the
rows will be summed by transformer. It makes more sense to summarize these as an average,
so click the drop down and change the summary to Average:

=]

i

= of Voltage
Phase
: Service Hours
Average of Loading

Pl Vision

Remaove field
Rename
Conditional formatting ¢
Remove conditional formatting
Don't summarize

Sum

o/ Awverage

16
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Resize the column directly on the visual similar to Excel:

ours  Average of Loading Pl Vision | Awerage of "
Voltage
Average

08 13050 @ 164,18

no 477 N L ) S FE N

Average of Voltage Average is a pretty weird header name, so rename it to Average Voltage:

245.34 - e o Venlane A
24 Remove field
24 Rename
24
74 Conditional formatting b
24 Remove conditional formatting
23 Don't summarize
24
Sum
24

74 ' Average
23 Minimum

VISUALIZATIONS > FIELDS

<« B Transformer Loading
W Circuit
N i Day
W FiZ Day Name
Headquarters

" - Headquarters ...

Secondary Transformer

Phase

WL Loading (25%)
W = Maximum KVA

Service Hours

: OSlsoft. Page 17
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We’'ll go over more formatting options in the exercises, so for now just bump up the text size of
the column headers and resize columns and visuals so everything fits:

' General

“ Table style

# Column headers

Font color

Background color H -
Outline Bottom only ~

Auto-siz... On —.

Font fam... |Segoe Ul

Alignment  Auto

Word wr... On —.

Your report should now look something like this.

Transformer High Loading

High Circuit Loading Pole Transformers
Secondary  Phase Service Average of Pl Vision Average
Parque San Jose . Transformer Hours  Loading Voltage
-~
Colegio Cientifico . PT_XYZ0109 X Phase 2208 130.50 @ 164.16
R PT_XYZ0911 X Phase 2208 122.20 @ 241.95
Angels Basilica I
PT_XYZ0377 Z Phase 2208 7.1 @ 24745
Merced District PT_XYZ0096 X Phase 2208 11699 @ 24534
Museo de los Ninos PTXYZ0884 ZPhase 2208 10306 @ 245.29
PT_XYZ0566 Y Phase 2208 96.66 @ 240.83
Universidad PTXYZOOT1 Y Phase 2208 9568 @ 245,31
Escuela Joaquin PT_XYZ0410  Z Phase 2208 9294 @ 246,65
. PT_XYZ0644 X Phase 2208 87.80 @ 240.23
Turistica Mamtezur PT XYZ1470 XPhase 2208 8337 @ 238.83
Cementerios PT_XYZ0126 X Phase 2208 8292 @ 24238
PT_XYZ0589 X Phase 2208 8163 @ 24070
Paseo Colon
PT_XYZ(0428 Z Phase 2208 81.24 @ 245,09
0 200 400 600 L 1 PT_XYZ0254 X Phase 2208 51.08 @ 238.50
@
Loading (25%) © 150 ®175 ©200 ®225 @250 @275 PIXYZ0195 ¥ Phase 2208 ge = 24338
PT_XYZ0210 X Phase 2208 7963 @& 24532
PT_XYZ0587 X Phase 2208 79.53 @ 24057
PT_XYZ0063 X Phase 2208 7823 @ 24439
PT_XYZ0065 Y Phase 2208 78.01 @ 24214
June July August
PT_XYZ0608 X Phase 2208 76.36 @ 240.81

We will build this report from scratch in a future exercise.

18
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3 Part 1 — Power Bl Reports using PI Integrator for BA

This course will be broken down into two main sets of exercises. In Part 1, we’'ll use
PI Integrator for BA to publish data from Pl and spend a lot of time configuring Power
Bl. In Part 2, we’ll make modifications to a Pl AF hierarchy and then use PI OLEDB
Enterprise to extract the report data.

In Part 1, we will be working with a data set for a power distribution company, which
includes electrical characteristics for over 1500 single-phase transformers. The
source data comes from a real Pl System and will be published in a data-science
ready format using PI Integrator for BA. Once this is done, we'll configure an array of
Power Bl visuals and integrate the results with Pl Asset Framework and Pl Vision.

The transformers we will be analyzing are secondary transformers that deliver power
to homes and businesses, which you may have seen on a pad or pole in your own
neighborhood. There are thousands of them to keep track of, making this a difficult
problem to solve using Excel.

The transformers themselves are not actually instrumented. The power and voltage
characteristics we will analyze have actually been computed by rolling up child
Meters in Pl AF.

3.1 Directed Activity — Pl AF Hierarchy and Data Set

In this part of the class you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

e Better understand the data set used in the following chapters

We will take a few minutes to understand where the data set came from and relate the sample
Power BI report back to the Pl System. We are working with a data set for a fictitious power
distribution company. They have built a Pl AF Hierarchy for their transformers and meters
serving a number of geographical areas. In this course, we will focus on analyzing the
transformers.

fg) OSlsoft. Page 19
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Open PI System Explorer and head to the Distribution Network AF database. Drill down to a
level with transformers (names starting with PT_) and inspect the available attributes. We will be
using a sub-set of these attributes for all of our analysis, in addition to leveraging the AF
hierarchy.

Note that because the Transformers are not instrumented, Voltages, Voltage Quality, and Wh
Delivered are rolled up from the child meters using Asset Analytics.
D \\PISRVOT\Distribution Network - PI System Explorer (Administrator)

File Search View Go Tools Help
@ Database [ QueryDate ~ © @5 | Back H, Checkin <3 « [£]Refresh |3 New Element = =1 New Attribute

Elements PT_XYZ0343
i Elements General Chid Elements Attributes Ports  Analyses Notification Rules  Version
- @ Alajuela
= @ Avenida Central
£ (@ Transformer 1 Fiter
= (J Colegio Cientifico 2 ¢ @ &R Name 2| Value
- (X Phase T 1
- &9 PT_XYZ0343 | =1 Connection Py
- &9 PT_XY20378 ”
= =1 Feed 01
& PT_Xv20380 b
&@ PT_XYZ0381 B =1 Load Contral Point 05171
&9 PT_XYz0387
- &9 PT %7038 ] =1 Loading 11,564 %
- PT_XYZ0383 =1 Maximum KVA 8.3
- &9 PT_XY20330
&0 PT_XY20393 L} =1 Phase X
&9 PT_XY20395 a ’
5 PT xvz0385 =1 Rated kvA 25
- ) PT_XY20357 =1 subDistance oft
- &9 PT_XYZ0415
- 53 PT_XYZ0415 =1 Substation 0856
&0 PT_XYZ0417 - .
B Pixvzons =1 Transformer Type POLE
&9 PT_XYZ0419 B & | ¥ voltage Average 247,583333333333 V
- @ ¥ Phase
- 9 7Phase s BE | F Voltage Maximum 248,050003051758 V
(G Cartago s B % | ¢ voltage Minimum 247.324996948242 V
@@ Heredia
(J San Jeronimo s B@ | ¥ voltage Quality 114,609953552419 %
- & San Jose z 7
- & Secondary Transformers =1 Voltage Standard Deviation 0
- (§ Service Delivery Paints 5 € | ¢ whDelivered Load 2891 Wh
(£}, Element Searches

Data from this PI AF hierarchy will be published for use in a Power Bl report in a later
exercise.
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4 Pl Integrator for Business Analytics

Getting the data out of the AF structure and into the client tools requires the use of integration
software such as the PI Integrator for Business Analytics or PI OLEDB Enterprise. This chapter
will discuss the former method of extracting the data.

4.1 Architecture

The PI Integrator for Business Analytics resides on a web server between the client
machines and the source AF server. As such, we are not connecting directly to the
AF Server but instead to a web server that contains a cache of our desired
information. The architecture within our class system however has both the AF
Server and Web Server residing on the PISRV01 machine. The PI Integrator for
Business Analytics site can be accessed via https://pisrv01.pischool.int:777 or from
the desktop. If prompted for credentials, enter your student account, as this has
been given access rights.

>

Client
Pl AF Server Web Server Microsoft Excel
[ Pl AF databases [ Pl Integrator for Business Microsoft Power BI
Analytics Tibco Spotfire
Pl SQL DAS Etc.

4.2 Pl Integrator Web Ul

Views can be created within the PI Integrator portal that is hosted on the Web Server
machine.

A list of previously generated views is present within the portal on the My Views
page, allowing for previewing and maintenance. These existing views can also be
cloned and modified, allowing different views to be created and utilized within Bl
client tools.

The following is a breakdown of the My Views page layout, and the different
operations available.
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Note: The information regarding the My Views page layout is available within the PI Integrator
for Business Analytics User Guide.

& PISCHOON\studentD 5

% Remove View e
v

& Modify View
data viewr

Mame Fun Status ‘ Type Fun Mode | Start Time End Time Last Run Time |
Distribution Network Sample 1@ Published Asset Once $01-Jun-17 31-Aug-17 23:00:00 Aug 24, 2018 816:28 PM
Feeder Voltage Monitoring Assets Published Asset once *1s > Jan 12, 2017 12:48:33 AM
Feeder Voltage Monitoring Events Example 'Smpped Event Continuous P qdd * Aug 1, 2018 822018 AM

+ Create Asset View
Build a data view starting with your
asset hiarchy

=+ Create Streaming View
Euild . a
custom output shape

+ Create Event View
Build 2 ur
avent hame hierarchy

Feeder voltage Monitoring High Phase Violat._. | Scheetuled Event Continuous =70
Feeder valtage Monitaring High Voltage Published Event Once 01-Jar-18 07-Jan-18 23:59:59
Feeder Voltage Monitaring Sample View Scheduled Asset Continuaus *7d

ALG 24, 2018 25712 A
Jan 10, 2018 4:57:30 PM
Al 24, 2018 3:54:40 AM

—ml

Overview  Log@  Seeurity  View Configuration  Statisties
Run Status o Published Search Shape
View Name # Distribution Network Sample Asset Shape

4 () Headquarters
Pl AF Database Distribution Network

4 [ substation

Publish Target Pl View + @ single Transformer
View Type Asset 4 @oireutt

4 @ Phase
Run Mode Once @
4 () single Phase Transformer
Loading

Your Start Time is Ol-hun-17 =] mazimurm rva

Last Run Time Aug 24,2016 816:26 PM

The My Views page shows details about your views.

All the views to which you have access are listed in the table

Click to create an Asset View that is based on Elements and Element Templates

Click to create an Event View that is based on Event Frames and Event Frame Templates
Click to create a Streaming View that is based on Event Frames and Event Frame
Templates

To modify a view, select the view in the table and click Modify View.

To delete it, click Remove View. Deleting a view removes data from the buffer, therefore
freeing up space. However, this does not free up the available output streams allowed with
your license.

7. For the selected view, the Overview, Log and Security tabs provide the following details
about that view:

Overview indicates whether the view has been published. This tab also summarizes
information about the view, such the Pl AF database it uses, when the view was last run,
and the shape that it uses. If the view is currently being published, the run status bar
indicates progress and you have the option to stop the publishing process.

Log displays log information. You can adjust the start and end times, and you can filter
the messages to display those of a certain severity, for example, critical errors.
Security shows who has access to the view, and if you have sufficient privileges, allows
you to change the level of access

8. The red message counter icon at top right show that there are warning and error messages

PN E

o u
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recorded by PI Integrator for Business Analytics. Click the icon to open the message list.

9. Click the gear icon H at top right to see the version of Pl Integrator for Business
Analytics and AF you are using.

4.3 Directed Activity — Create the Transformer Loading View

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:
e Use the PI Integrator for Business Analytics to create an Asset View, which
will be used in later exercises.
Approach:

Open Google Chrome and Navigate to the PI Integrator for BA Web Ul at
https://pisrv01.pischool.int:777

Click Create Asset View and name it Transformer Loading, click Create View:
_/“ Advanced Edition x \D

&« C | & Secure | https://pisrv01.pischool.int777

E=' Apps Pl Vision 11" Pl Integrator for Busi

Create New Asset View ®

Asset View Name

| Transformer Loading |

Acnass Permissions €

‘ Administrators A

Click Create a New Shape

Create a Maw Shape

( OSlsoft. Page 23
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Select Distribution Network as the AF Database, then drill down to PT_XYZ0343.

@Snume,ﬂlssets b ﬁjS&ar{

FAE-TT,
Server PISRYD " -
Database Distribution Metwark = T

() Assets

E () alajuela
E@I Awvenida Central
Elf:j Transformer 1
E@ Colegio Cientifico
Elf:j ¥ Phase

» () PT_XvZ0343

e

Drag and drop Alajuela to the Shape Builder

Transfermer Loading

Select Data > Modify View > Publish

@Souroe.i\ssets v @Search Shape

Assat Shape
Ea PISRVOT v = =

Datahase

Distribution Metwork

Auto drop and place

c v
i % osw

||‘ ) Alajuela —

4 [ avenida Central

4 () Transformer 1
4 @ Coleqio Cientifico

4 (¥ Phase

> ) PTXYVZ0343

Edit the Filter on Alajuela:

Select Data > Modify View > Publish

@ Source Assets v Ea Search Shape

Server PISRYDT . To Asset Shape \‘
Eeicleee Distribution Metwork ooy © Alsjuels "
D Aasets

“ ) alajuela |
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Clear the Asset Name Checkbox, Change it to filter on the Headquarters template,
click Save:

Edit Filters x

Asset Name

Alajuela

¥ Asset Template Search Derived Templates

Headguarters v

Asset Category

() Add Filter

Drag and drop Avenida Central to the Shape configuration, and change it to filter on
the Substation Template:

Edit Filters x

Agset Name

Avenida Central

¥ Asset Tamplata Search Darived Templatas

Substation v

Asset Category

DECADA, &

() Add Filter

) ostsot Page 25
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Repeat this pattern for Transformer 1 (Template = Single Transformer), Colegio
Cientifico (Template = Circuit), X Phase (Template = Phase).

Drag and drop PT_XYZ0343 and select Secondary Transformer as the Template,
this time check the box to search derived templates.

Edit Filters »*

Asset Mame

FT_X¥Z0343

¢ Asset Template ¥ Search Derived Templates

secondary Transformer | ¥

Asset Category

Single Phase ¥

(+) Add Filter

The shape configuration should look like this:

@ Search Shape
7= Asset Shape

- @ Headguarters

4 [ substation

4 [ single Transformer
4 D Circuit
4 [ Phase

A @ Secondary Transformer

AR A T
X X X X X X

26
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Click PT_XYZ0343 then hold control and multi-select Loading, Maximum KVA, Rated
KVA, Transformer Type, Voltage Average, Voltage Maximum, Voltage Minimum,
Voltage Quality, and Wh Delivered Load. Drag and drop these selections to the
Shape configuration.

Transformer Loading

Select Data > Modify View > Publish

@ Source Assets v @ Search Shape

T Asset Shape

BERE] ‘ FISRVDT v

Database ‘ Distribution Netwark

“ @ Headquartars

v

~
L]

4 (D) Substation

@ Assels 4 [ single Transformer
4 @Alajue\a A @ Circuit
4 (D) Avenida Central 4 (D Phase
4 @D Transformer 1 4 [D) Secondary Transformer
4 [ Colagio Cientifico Loading
4 [DXPhasa

Iaximum KA
‘ 4 QPT XYZ0343 Rated IKVA

8 MTR_K1EZH513771

L S S S Y. T T T T U T L S Y
X X X X X X X X X X X X X X X

[=] Transformer Typa
) MTR_K1E2H313773 . & Voltaga Average
— . # Voltaga Maximum
Attributes ‘ Filter * ‘ 15 4 Voltaga Minimum
O select All & voltaga Quality

=] SubDistance o . & Wh Delivered Load
=] substation 1]
[=] Transformer Type i)
# volage Average 1]
& Voltage Maximum (1)
& Voltaga Minimum i)
& vohtage Quality (L]
VuHageSiandard Daviation (1)

|__ @ wh Dalivarad | gad al

There should be over 100 matches in the preview, click Next in the top right corner.
FISCHODL\studenti

+ Matches
Found 100+ Matches

&’ » D alajuela

Page 27
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We now see a preview of the data using the default Time Range and interpolation
mode.

Transformer Loading + X PiSCHD tudentdl 4§

Select Data > Modify View & Publish

+ Add Golumn Y it Row Fiters i Edit Value Mocle S e (Ee T
16 columns 0 Row Filters Interpolated Values
Buery | minute 8n ‘ ‘ © ‘
Headguarters TimeStamp Substation  Single Transformer Circuit Phase Single Phase Transformer Loading Maximum Kv4 Rated KvA Transformer Type Voltage Average Voltage Maximum Voltage | =
Alajuela 8/24/2018 1:28:20.975 PM  Avenida Central Transformer 1 Colegio Cientifico % Phase | PT_XYZ0389 31998 679 a0 IPAD 1243553 243,725 242,65
Alajuela 8/24/2018 1:29:20.975 PM  Avenida Central Transformer 1 Colegio Cientifico X Phase PT_XvZ0389 31998 679 20 EF'AD 5243.553 243,725 242,65
Alajuela 8/24/2018 1:30:20.875 PM  Avenida Central Transformer 1 Colegio Cientifico x Phase : PT_XYZ0388 31898 B74 a0 FAD 243553 243725 24285

We want to publish Hourly data for the time period 01-Jun-17 00:00:00 to 31-Aug-17
23:00:00. Modify the Start Time and End Time and click Apply:

Start Time End Time

01-Jun-17 3-Aug-17 23:00:00 Apply

aase Transfarmer Loading Maximum KVA Rated KVA Transformer Type Woltage Average Voltage Maximum Voltage [ =

1391 28 N7 125 FPOLE 249,542 249675 249425

Click Edit Value Mode and change the time step to 1 hour, then Save Changes:

Edit Value Mode ®

® Sampled Yalues

® Sample values every 1+ | hours =

® Interpolate o
Exact &

Use Key Column | Violtage Average 7

The TimeStamp column should now reflect changes to the Start, End, and Value
Mode:

& Add Column Y Edit Row Filters i= Edit Value Mode
16 celumns [ Row Filters Interpolated Values
Ewery 1 hour

rFi

o
Headguarters TimeStamp /Sﬁbstatiun Single Transformer Circuit Phase |30
Alajuela Br2017 12:00:00 Al Mﬂwenida Central : Transformer 1 Colegio Cientifico 1% Phase | P
Alajuela Bi2017 1:00:00 AM éAvenida Central: Transformer 1 Colegio Cientifico {3 Phase | P
Alajuela Br1/2017 2:00:00 Ak éAvenida Central | Tranzformer 1 Colegio Cientifico §% Phase | P
Alajuela Br1/2017 2:00:00 Ak éAvenida Central : Tranzformer 1 Colegio Cientifico §% Phase | P
LA ESTREA B EAAMO17T A O0-m0 Ahd I Msmmidl = T ARl D Temmefmemm s Talmmis TimebiF e s Y Dlm s 1O
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Now we’ll add some additional time columns that will come in handy later when
building the reports. Click Add Colum. Select the Time Column tab. Select Month,
Month Name, Week of the Year, and Hour, then click the arrow to bump them over to
the right:

Add Column x

Cata Column Time Column Static Value

Select Time Column Options for | Local *

Year (2018) TimeStamp (Local)
Month (&)
Month Mame (August)

Week of the Year (34}
Day (24}
&

DCay of the Week (Friday)
| Hour (213 |
Minute (38}

o

Click Display 5 Time Columns:

Add Column x

Cata Column Time Column Static Value

Select Time Column Options for |Local v

Year (2018} TimeStamp (Local)

Day (24) Month (Local)

DCay of the Week (Friday) Month Name (Local)
Minute (38} Week of the Year (Local)
Second (47} Hour (Local)

Milliseconds (820)

UTC Seconds (15357146727 82)
UTC Milliseconds (1535746721820)
Ticks (636707435218200000)

Time Zone Offset (0)

+v

Dizplay & time columns

( OSlsoft. Page 29
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Now the time ranges and columns have been specified, click Next.
o

Transformer Loading = L FISCHOO studento] €

Back
Start Time End Time
01-Jun-17 ‘ ‘ S1-AUGH17 = m
Manth Name VWeek of the Year Hour Substation |E

ne 22 D é;’-\venida Central T

Now we can choose what target to publish to. This depends on the platform used to
support front-end application, but for our purposes we’ll publish to a SQL Server.
Select SQL Server for the Target Configuration, Leave Run Once checked, and click
Publish:

Transformer

Select Data > Modify View » Publish

Target Configuration Summary

SCIL Server v Shape and Matches

= There are 100+ Matching Instances

Run MOde Tirmeframe and Interval
L]
* Your Start Tirme is 01-Jun-17
Run on A Schedule * YourEnd Timeis 31—Aug—1}' 23:00:00
* Your Tirme Interval gets an interpolated measurernent Every 1
heur

Publish

It will take a few minutes to publish the data.
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5 Building the Distribution Network Reports

We will now spend a significant amount of time configuring Microsoft Power Bl
reports. The first step is importing the data.

5.1 Preparing and Importing the Tables

Now that the Transformer Loading table has been published, we will import the SQL table into
Power BI.

5.1.1 Directed Activity — Import Data from Microsoft SQL Server.

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:
Import the Transformer Loading table.

Approach:
Open Microsoft Power BI

Select Get Data -> SQL Server.

al | H = | Untitled - Power Bl Desktop

“ Home View Modeling Help
8 o B [

Lopy

Paste ) Get Recent Enter
Format Painter | pata~ |Sources~ Data Qu:
Clipboard Most Common ta

0 Auto recovery 51l
/ E Excel

Power Bl service

SQL Server

Analysis Services

7 b |

Text/CsV

j{) OSlsoft. Page 31
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Enter PISRVO01 as the server name and click OK.

SQL Server database

Server (i

| PisRVO1| |

Database (optional)

Data Connectivity mode G
® Import
DirectQuery

I Advanced options

oK Cancel

If Prompted, Leave “use my current credentials” selected and click Connect:

SOL Server database X

Windows pisrvOT1

Use your Windows credentials to access this database,

Database

Microsoft account Use alternate credentials

Back Connect Cancel

There may be a warning that the connection is not encrypted, this can be safely ignored, click
OK:

Encryption Support

We were unable to connect to the data source using an encrypted
connection. To access this data source using an unencrypted
connection, click OK.
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Expand the Plint database and Select the Transformer Loading table, click Load

Navigator
el
Display Options ~ D;.

4 PISRVO1 [9]

3 Coresight

2 FleetGeneration
3 PIFD

pl Plint [1]

| I ¥ E Transformer Loading I

2 PlintegratorDB

[ PlintegratorLogs

= PlintegratorStats

2 ReportServer

[ ReportServerTempDE
Select Related Tables

o X
Transformer Loading ¥
Id H Ters TimeStamp Month Month Name Weel
1 Algjuela 6/1/2017 12:00:00 AM & lune
2 Algjuela 6/1/2017 1:00:00 AM & June ~
3 Alajuela 6/1/2017 2:00:00 AM & lune
4 Alzjuela 6/1/2017 3:00:00 AM & June
5 Alajuela 6/1/2017 4:00:00 AM & lune
& Alzjuela 6/1/2017 5:00:00 AM & June
7 Alajuela 6/1/2017 6:00:00 AM & lune
2 Alzjuela 6/1/2017 7:00:00 AM & June
9 Algjuela 6/1/2017 8:00:00 AM & lune
10 Algjuela 6/1/2017 9:00:00 AM & June
11 Alajuela 6/1/2017 10:00:00 AM & lune
12 Algjuela 6/1/2017 11:00:00 AM & June
13 Alajuela 6/1/2017 12:00:00 PM & lune
14 Algjuela 6/1/2017 1:00:00 PM & June
15 Alajuela 6/1/2017 2:00:00 P\ & lune
16 Algjuela 6/1/2017 3:00:00 PM & June
17 Alajuela 6/1/2017 4:00:00 PM & lune
18 Alsjuela 6/1/2017 5:00:00 PM & June
19 Alzjuela 6/1/2017 6:00:00 PM & lune
20 Algjuela 6/1/2017 7:00:00 PM & June
21 Alzjuela 6/1/2017 8:00:00 P\ & June
0 The data in the preview has been truncated due to size limits. LV
< >
Edit Cancel

Note that about 3.8 million rows have been imported.

OSlsoft.
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5.2 Building the Report Visuals

Now that the Transformer Loading table has been imported, the rest of the chapter will be a
walkthrough of configuring various report visuals.

In case there were mistakes or problems with the previous steps, a starter .pbix file
has been created with the raw data set already imported with columns that will match
the exercises exactly.

Open C:\Class\Part 1 - PI Integrator for BA\Starter File - Part 1 Distribution
Network.pbix and use this as a starting point for the remaining exercises.

5.2.1 Directed Activity — Network Load Profile

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objectives:

e Configure a Hierarchy

e Configure a Matrix to show average loading per transformer

e Configure a Clustered Column Chart to show the average energy delivered by
Headquarters

o Configure a Line Chart to show the average energy delivered by hour of the day and by
day of the week

In this exercise, we are going to analyze the loading characteristics of the transformers in our
distribution network. We want to look at the demand curve for various levels of the distribution
network to help forecast the demand seen by various transformers based on the hour of the day
and day of the week.

Loads are expressed as a percentage of the rated value, as well as a raw watt-hours value. The
resulting report will help us understand which transformers are working under the highest loads,
and see how power consumption changes over time. General Steps:
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Approach:

Configuring the Hierarchy

We will now create a hierarchy. In the Fields List, click the ellipses next to Headquarters and

select New hierarchy:

FIELDS

Utility Transformer ...

Circuit

Add filter

New hierarchy

MNew measure

Within the fields list, drag and drop the Substation field on top of the new Headquarters

hierarchy:

FIELDS

Utility Transformer ...
Circuit

Headquarters

L Substatign
W HeadquaWrs
Hour
Id
Loading
Maximum KVA
Month
Month Name
Phase
PlintShapelD
PlintT5Ticks
Rated KVA
Secondary Tra...
Single Transfo...

' OSlsoft.
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Repeat for Single Transformer, Circuit, Phase, and Secondary Transformer and reorder so
that Substation is below Headquarters in the hierarchy.

4 M " : Headquarters ...
Headquarters
Substation

Single Transf...

Circuit
Phase
Secondary Tr...

Monthly Average Loading - Matrix
We’'re going to display the monthly average loading on a per transformer basis and leverage the
Hierarchy we just set up.

Add a Matrix to the canvas by clicking the Matrix icon in the Visualization Pane:
VISUALIZATIONS

— — ||

&l N

M [ & 6

—

L Y
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Drag and drop the Headquarters Hierarchy for the Rows, Month Name for the columns, and
Loading for the Values:

VISUALIZATIONS > FIELDS
i& Transformer Loading

Circuit

Headquarters

W = Maximum KVA

Headquarters Hied

Headquarters W = Month

Substation Month Name

Single Transformer Phase
PlintShapelD
PlintTSTicks
Rated KVA
Secondary Tra...
Single Transfo...
Substation

Circuit
Phase

Secondary Transg

Month Npfme

TimeStamp

Transformer T...

Loading

Voltage Avera...

Change the value field to summarize by Average Loading:

- ———

Remaove field

Rename

Conditional formatting 4
Remove conditional formatting
Sum

Minimum

Maximum

Count (Distinct)

Count

Standard deviation

Variance

Median

Show value as 4

New quick measura

EEEEEEEEEEOEEOEEOE N
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Now we will drill down into the hierarchy. Press the drill down button:

= —
Headquarters August  July Junz  Total
Alzjusls 2470 2097 2617 26.95
Cartago 2393 3563 3027 31.98
Herediz 1330 1619 1402 14.54
San Jeronimo 540 6.15 5&5¥2 L5.7B
San Jose 2009 25068 2217 2275
Total 20.84 2490 21.B1 22.52

Next, navigate through the layers by clicking on the Headquarters or going right click -> drill
down:

M= @ = 7 o1
g e T o =
Headquarters  August  July Jung  Total
Alzjusla 2470 2887 2517 26.95
Cartago 2998 35463 30.27 31.98
Herediz 1338 1679 1402 14.54
San Jeronimo 540 6.15 E79 578
Zan loze 2005 2506 2217 22.75
Total 20.84 2490 21.81 22.52
| r - = |
(R — © E
Headquarters August  July June  Total
Alzjuslz 24.70 2997 26.17 2695

| 24.70 2997 26.17 26.95
Transformer 1 | 2470 29497 2617 26.95%
Total | 2470 2997 2617 2695

38



Analyzing Pl System Data

Expand all the way to the bottom until the Matrix looks like this:

Headgquarters August  July Juns  Total
Alajusla 16.42 20,07 1730 17.94
Avenida Central 16.42 20.07 1730 17.94
Transformer 1 16.42 2007 1730 17.94
Colegio Cientifico 16.42 20,07 17.30 17.94
¥ Phaze 16.42 20,07 1730 17.94
PT_XYZ0343 3340 3953 3605 36.33
PT_XYZ0379 3573 4749 3975 4101
PT_XYZ0380 2172 3401 2564 27.14
PT_XYZD381 2343 3745 32956 3296
PT_XYZD387T 3030 3766 3347 33.81
PT_XYZD388 2353 3053 2516 26.42
PT_XYZ0389 3529 4116 3626 3I7.59
PT_XYZ0390 2549 3296 3039 29.61
PT_XYZ03093 1186 633 545 T7.90
PT_XYZ0305 0oy 196 404 230
PT_XYZ03096 3TE 454 344 3.92
PT_XYZ0397 20082 1996 13593 18.28
PT_XYZ0415 oo 0.01 001 0.01
PT_XYZ0416 052 066 056 058
PT_XYZ0417 423 425 426 425
PT_XYZ0418 oEx 041 057 0.48
PT_XYZ0419 247 236 223 235

Total 16.42 20,07 1730 17.94

Navigate back up the layers by clicking the Up Arrow on the top left of the visual:

O =2

Headguarters August  July June  Total
Alzjusla 24,70 2997 26,17 2695
Avenida Central 24.70 29.97 26.17 26.95
Transformer 1 24.70 2997 2617 2695
Colegio Cientifico 24.70 2997 26,17 26.95

¥ Phaze 1642 2007 1730 17.94

¥ Phaze 2425 3021 2564 26.71

Z Phaze 3231 3308 3436 3492

Total 24.70 2997 26,17 2695

7 ) OSlsoft.
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Drill back down to the lowest level, and turn off Drill Down mode. This will allow us to filter
the rest of the report by clicking on levels and transformers rather than drilling.

= = T & -]
Headguarters August  July Juns  Total
Alzjuela 16.42 20,07 17.30 17.94
Avenida Central | 16.42 20,07 17.30 17.94
Transformer 1 16.42 20,07 17.30 17.94
Colegio Cientifico | 16.42 20.07 17.30 17.94
X Phase 16.42 20,07 17.30 17.94
PT_XYZ0343 | 3340 3953 3605 36.33 h
PT_XYZ0372 3573 4740 397E 4101
PT_XYZ0380 | 2172 3401 2564 27.14
PT_XYZ0381 2348 3745 3296 32.96
PT_XYZ0387 | 3030 3766 3347 33.81
| PT_XYZ0388 2353 3053 2516 26.42 |
PT_XYZ0389 | 3529 4116 3626 37.59
PT_XYZ0390 2543 3296 3039 29.61
PT_XYZ0393 | 1186 633 G545 7.90
PT_XYZ0395 097 96 404 2,30
PT_XYZ0396 | 376 454 344 392
PT_XYZ0397 2082 1996 13.93 18.28
PT_XYZ0415 | 0o 001 001 001
PT_XYZ0416 052 066 056 0.58
PT_XYZ0417 | 423 435 426 4.25
PT_XYZ0418 0.50 0.41 051 0.48
PT_XYZ0419 | 247 236 223 235
Total 16.42 20,07 17.30 17.94
L - |

To put the Months in the correct order, we will sort the Month Name column in the data set by
the Month column where the months are numbered. Go to the Data View, select Month Name,
open the Modeling Ribbon, and Sort by Column -> Month:

wl | H = | PIWorld Lab Development - Power Bl Desktop

Home Maodeling Help
LE] ﬂ !J m Data type: Text ~ Home

Format: Text - Data
Manage New Mew  Mew New Sort by A "
Relationships ~ Measure Column Table Parameter |Column~ Y o [Auto O Defau
Relationships Calculations What IT +/  Month Name [Default) 0
Id
Meonth Name Headquarters Fr—
i} 7 fuy TimeStamp Transformer 1
0 7 Puly Month _raﬁrmerl
2 7 = Week of the Year Trartformer 1
0 7 Puly Hour ransformer 1
0 7 Puly X Transformer 1
Substation
0 7 Huly Transformer 1
Single Ti i
0 7 Puly MR A Transformer 1
0 7 uly Circuit Transformer 1
0 7 futy Fhase Transformer 1
0 7 Puly Secondary Transformer Transformer 1
0 7 fluly Loading Transformer 1
0 7 Puly Maximum KV ransformer 1
0 7 Puly Transformer 1
Rated KviA
0 7 Lty Transformer 1
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Go back to the Report View, the Month headers should now display in chronological order.

Headquarters June  July August | Total
Alajuela 26,17 29.97 2470 26.95
Avenida Central 26,17 29.97 2470 26.95
Transformer 1 26,17 29.97 2470 26.95
Colegio Cientifico | 26.17 29.97 2470 26.95

X Phase 17.30 20.07 16.42 17.94
PT_XYZ0343 | 3605 3953 3340 36.33
PT_XYZ0379 | 39.78 4749 3573 411
PT_XYZ0380 | 2564 3401 2172 27.14
PT_XYZ0381 3296 3745 2848 32.96
PT_XYZ0387 | 3347 3766 3030 33.81
PT_XYZ0388 | 25.16 3053 2353 26.42

NT ¥W7N2>on IR IR A1 1s 2870 27 Q0

Total 26,17 29.97 2470 26.95

Next, we will add conditional formatting to highlight transformers with high loading. Conditional
formatting is set from the Values field in the Visualizations Pane. Select the drop down by
Average of Loading and click Conditional Formatting -> Background Color Scales:

VISUALIZATIONS

=
e
Remaove field

Rename

Conditional formatting I

Remove conditional formatting
Sum

Average

Minimum
Maximum

Count (Distinct)
Count

Standard deviation
Wariance

Median

Show value as

Mew guick measure

Average of Loading

FIELDS

4 B Transformer Loading

Background color scales I

Font color scales

Data bars

. Maximum KVA
. Month

Manth Name

Phase

> PlintShapelD
~ PlintTSTicks
» Rated KVA

Secondary Tra...
Single Transfo...
Substation

' OSlsoft.
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Reverse the minimum and maximum colors so that high numbers are Red. Enable the Diverging
option. Click OK.

X
Rackground color scales
Format cells with color based on a value,
Apply color to Color based on @ Surnmarization
Average of Loading | | fuerage of Loading - ‘ Auverage v

Caolor by rules

Format blank values

(s ]

Minimum

Center

| tiddle value

v

B

Lowest value g 1]
=
(Lawest value)

¥ Diverging

{hiddle walue)

Maximum

Highest value 14 |
(Highest value)

Turn off the Subtotals using the formatting options:

42

' General
' Matrix style

Gnd

Column headers

Row headers

Values

# Subtotals

Row sub...

Column ...

Font color
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Add a Title to the Matrix using the Formatting Options. Call it Monthly Average Loading, change
the color to black, and bump up the font size:

" Subtotals

“ Grand total

“ Field formatting

“ Conditional formatting

Title Text Monthly Aver...

Font color b

Background color
Alignment
Text size

Font fam... Segoe Ul

v General

' Matrix style

* Column headers

' Row headers
v Values
' Subtotals

* Grand total

~ Field formatting

v Conditional formatting

: OSlsoft.
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The matrix should look something like this:

Monthly Average Loading
Headquarter s Jurme  July  DBugust

Alajuela
Anvenida Central
Trarsfomn er 1
Colegio Cientifico
¥ Phase

PT_ =¥ Z0543 3005 3953 3340
PTYZOs79  |30.78 [4RA8| 35.73
PT_RYZ0550 2564 340 2102
PT_ =¥ Z0551 32090 3745 2843
PT_SYZ0557 3347 37e6 3030
PT ¥ Z0555 2516 3053 2353
PT_RYZ0559 io2o 4116 3529
PT Ry Z 0500 30 30 3296 2549

PT {20893
PT ¥ 70895

FToazoRos A 45
PTAZ0397 1383 19.96 2082

PT Y205

iy o
PT XYZOM 7
PT XYZOME

223236 247

PT XYZOH 9

Watt-hours Delivered by Headquarters — Clustered Column Chart

Next we’ll configure a new visual to show Average watt-hours delivered on a per month basis.
Click some blank space and add a Clustered Column Chart:

VISUALIZATIONS
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Use Month Name for the Axis, Headquarters for the Legend, and Wh Delivered as the Value:

Month Name

Headquarters

Wh Delwered Load

W = PlintTSTicks
7 Rated EVA
Remove fisld

Rename

Sum

+/ Average

L. [ .

Note that only 1 headquarters is shown. This is because the visual is being filtered by the
Matrix configuration.
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In the Matrix, drill up to the top level by repeatedly clicking the Drill Up button:

Monthly Average Loading
Headquarters June July  August

Alajuela
Avenida Central
Transformer 1
Colegio Cientifico
X Phase

PTxvzo343  |GI0SIISSISSI ISSH0)
PT xvz0379 (SIS ARSI ISSNE)

PT_XYZ0380 ---

Eventually we’ll see the summary broken down by headquarters and all 5 headquarters will be
shown in the Clustered Column Chart.

Note that Cartago seems to be the HQ with the highest transformer loads. Turn on Drill mode
and drill down and follow the highlighting (drill down wherever the load is highest) to discover
that transformer PT_XYZ0109 is consistently overloaded. Consider that these are averages, not
maximums.

Turn off drill mode and click on PT_XYZ0109 to see the month to month watt-hours delivered
for this particular transformer.

Monthly Average Loading Headquarters  @Cartago

Headquarters June  July August o

Cartago
Estacion Los Angeles |

Transformer 2

Universidad | 40

X Phase

rozoos | EEENEERNE0

Optionally search for PT_XYZ0109 in Pl System Explorer and note how many meters it is
responsible for.
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In Power BI, Click PT_XYZ0109 again to deselect it and remove the filtering.

Select the Clustered Column Chart visual, and adjust the formatting:

Move the legend to the bottom, remove the legend title, and increase the text size

“ General

# Legend On

Posrhon Bottom -

Title off O—
Legend ... |Headquarters
Color

Font fam... Segoe Ul -

Text size 12

e
w

Change the Chart Title to “Average Wh Delivered by Headquarters” with black text,

increase the text size

Change the colors used for the headquarters. You will have to Drill Up in the matrix to
get all the headquarters to show up first.
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- Data colors

Alajuela

Cartago

Heredia

San Jeronimo

San Jose

Watt-hours Delivered by Weekday — Line Chart

We also want to see how the delivered watt-hours change throughout the day and on different
days of the week. We’'ll display this information using a Line Chart.

First some setup. We do not have a day of the week column in the original data set like we did
for the Month, so we will add one using a DAX formula.

Go to the Data View. Select any column, then go right click -> New Column:

al | H = | PIWorld Lab Development - Power Bl Desktop

Home Modeling Help
|__I ﬂ !J m Data type: Date/Time =
E Format: 14-kMar-01 13:30

Manage Mew Mew  Mew Mew Sort by o
Relationships  Measure Column Table Parameter Column~ * Lo | Auto
Relationships Calculations What If Sort Farn

Sort Ascending
815497 Heredia 02-Jui-170-00:0
#15498 Heredia 02-Jui-17 1:00:0 sort Descending
815499 Heredia 02-tuw-1 7 2:00:0 Clear Sort
815500 Heredia 02-Jui-173-00:0 ~

Copy
815501 Heredia 02-Jui-1 7 4:00:0

i "
815502 Heredia 02-Jui-17 5-00:0 Copy Table
815505 Heredia 02-1ui-17 6:00:0 New Measure
815504 Heredia 02-Jui-17 7-00-0

Mew Column
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Add the following DAX formula in the formula bar and click the check box or hit enter. Note
that this sets the column name to “Day Name”.

Day Name = FORMAT(('Transformer Loading'[TimeStamp], "dddd")

al | H = | PI'World Lab Development - Power Bl Desktop

Home Modeling Help
|__] ﬂ !J m Data type: Whole Number = Home Table: .\.,
E Data Category: Uncategorized - a“

Format: =
Manage Mew Mew Mew Mew Sort by 9 g - o Mana:
Relationships  Measure Column Table  Parameter Column~ ™ % * .o |Auto I | Default Summarization: Sum = Role
Relationships Calculations What If Sort Formatting Properties S

Day Name = FORMAT/("Transformer Loading®[TimeStamp], "dddd”)

Hour

Month Name Week of the Year
815497 Heredia 02-ful-17 0:00:00 7 July 27 0 San Pablo

815498 Heredia 02-twi-17 1:00:00 7 July 27 1 SanPablo

: OSlsoft. Page 49
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In order for the days of the week to display in the correct order, we will add another
column for the numerical day of the week using the WEEKDAY () function:

Day = WEEKDAY (‘Transformer Loading'[TimeStamp])

We can then sort the Day Name column by this new Day column:

50

al |

Home

Modeling Help

= | Pl'World Lab Developrment - Power Bl Desktop

@ = &

=)

Data type: Text ~
Format: Text =

S [Aute 2

Manage MNew MNew MNew Mew Sort by
Relationships  Measure Column Table Parameter JColumn = ’
Relationships Calculations What If Diay Mame [Default]
Day Mame = FORMAT('Transfc Id
Headquarters
Voltage Quality Wh Delivered Load
100.520833333333 130: TimeStamp
100.89553 0790202 118 Maonth
100.499998728434 313 Month Name
i 215 Week of the Year
100.51041 9209795 277
Hour
100.02083 4604899 88!
Substati
99.9375025431315 272 Hbstation
99 7291692097982 124: R e
89 8229153951009 175 Circuit
89 5104153951003 275, Phase
58937405 7284343 340 Secondary Transformer
89 1458320617676 382 )
Loading
B8 FRI124R7IR4343 404
Maximum KVA
BB 6979166666667 391,
58.3333333333333 4501 Rated KA
98416665 3951009 423, LEDE IR B TS
99 6458307902018 473 Voltage Average
899 5416641235352 703 Yoltage Maximum
95.6875 462! Yoltage Minimum
99 364584 6048991 191! Voltage Quality
100.69791 7938232 215
Wh Delivered Load
100.564582061765 164,
100.77083 5876465 2081 FllntT=Ticks
100.708332061768 1231 ST FETELE
100 854167938232 116  Day |

Home Table:
Data Category:

Default Summa

1

» "dddd™])

apeID Day Mame I

Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday
Sunday

o o o o o o o O o O O o O o O o O O O o o o o O O

Monday

i
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Now it’s time to configure the visual. Click some blank space, and add a Line Chart:

VISUALIZATIONS

Use Hour as the Axis, Day Name as the Legend, and Average of Wh Delivered as the values
(summarize Wh Delivered as an Average):

Day Name

Average of Wh Delivere

Adjust the formatting of the Line Chart:

e Move the Legend to the bottom
Change the title to “Average Wh by Weekday”, text color black, and increase the text

size of the title to match the other visuals
e Optionally change the trend colors

:@ OSlsoft. Page 51
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Add a report title by inserting a text box:

al | E € @ 5 | Network Load Profile - Power Bl Desktop

File View  Modeling Help

pic GLEE D OWE e & £ oo o

L_'glmage ﬂNewCqumn
Paste . . Get Recent  Enter Edit Refresh Mew  MNew From From Manage . Publish
¥ Format Painter  Data~ Sources= Data  Queries~ Page = Visual H shapes ~ Marketplace  File Relationships /2| New Quick Measure
Clipboard External data Insert Custom visuals Relationships Calculations Share

The end result should look something like this:

Network Load Profile

Maonthly Average Loading

Average of Wh Delivered by Headgu arters
Headquarters June  Juby Bugust -

20

Cartago

Estacion Los Angeles 15¢
Trarsfomer 2
Uniwersidad .
¥ Phase

PT_MYZ008S IET TS0 3214
PTZOO9 | 4382 5032 3740 *

PT _¥Z0093 Ineo 4311 3577
3229 2614 e

PT_RVZ0095 2727
PT_RYZ009%8 3ded 3741 3439
PT V200 53,24 6110 5966

Procvzonos  [RSHITSIG0 NS

PToozO0s (I Eie g Wh Delivered by Weekday
FT_XVZ 107 3466 4256 3584

PT _YZON03
Pronzonos (125,68 HE5EE|
PTaovzorio 2483 042 asas
FT WYZOI12 3437 4234 3454
FT4ZON4 | 6187 7808 6580
prowzoro (NG TSR 0
FT4ZONZE | Ta72 0246 7744
PTOOZOI2E | 70.02 8116 7206 oy 5 10 15 = b

E:ﬁig 2: ﬁ gg:: % v Cay Narne ®3unday @honday @ Tuesday @Wednesday @Thursday @ Friday @ Saturday

lunz Juke huqust

® Cartago

Finally experiment with drilling up and down the hierarchy and filtering the report.
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5.2.2 Directed Activity — Transformer Loading Analysis

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objectives:

e Configure a Measure to calculate service hours

e Configure a Group to create bins for different load ranges which can then be used for
highlighting and filtering

e Configure a Stacked Bar Chart to display the service hours spent in each Load Range
by circuit

e Configure a Table to show the top 20 transformers by average Loading

e Configure a Slicer to filter by Month

In this exercise, we will analyze transformer loading characteristics. The goal is to assess the
number of service hours spent in various high load conditions to better understand which
transformers are at risk of failing and also assess whether a given transformer should be
replaced with one that has a higher capacity.

Approach:
Start a new Page by clicking the New Page icon at the bottom of the existing report:

I Metwork Load Profile =+

Rename the Page to Transformer Loading.

Service Hours

The first thing to do is configure a Measure to calculate service hours. Each row in the data set
represents 1 hour, so we can simply count the number of rows that have been filtered through
user selection. This should make a bit more sense when it all comes together.

Right click any of the fields from the Fields list and select New measure:

./.--
/
\
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54

Add filter

New hierarchy

Add to Hierarchy

MNew measure

Mew column
MNew guick measurs
Rename

Delete

[RERPN

Id

Loading
Maximum KVA
Month

Month Mame
Phase
PlintShapelD
PlintT5Ticks
Rated KVA
Secondary Tra...

Service Hours
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Enter the below formula into the configuration box:

al | H = | PIWorld Lab Development - Power Bl Desktop

“ Home View Modeling Help
ﬂ J _— Data type Home Table: Transforme
L B 2

Format: Whole number = Data Category: Uncatec

Manage Mew Mew  MNew Mew Sort by - " o
Felationzhips  Measure Column Table Parameter Column $ % * a0 - | Default Summarization
Relationships Calculations What If Sort Formatting Proper

Service Hours = CALCULATE(COUNT('Transformer Loading'[Loading]))

The raw text is given below for convenience.
Service Hours = CALCULATE(COUNT('Transformer Loading'[Loading]))

A Note on Measures vs Calculated Columns

From a configuration perspective, Measures and Calculated Columns are configured similarly
so the distinction may not be obvious. Measures and calculated columns both use DAX
expressions. The difference is the context of evaluation. A measure is evaluated on the fly using
a subset of data, whereas a calculated column is pre-calculated at the row level within the table
it belongs to. A simple way to put it is that Measures take into account the filtering that has been
set by the end user of the report (the stuff they’ve clicked on), while calculated columns are
computed row by row and are not influenced by the report filtering.

Loading Groups

Different ranges for Loading will be grouped into bins representing different Load Ranges. It is
normal for transformers to be operating at Loads higher than 100% of their rating, but loads in
the range of 125% and higher are potentially cause for concern. In order to calculate service
hours in the different Load Ranges, a group must be configured in the data set for filtering and
counting by the Service Hours Measure.

n'/--
/
.
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Right click on Loading and select New group.

Add filter

Mew hierarchy

Add to Hierarchy
Mew measure

Mew column

Mew guick measure
Rename

Delete

Hide

View hidden

Unhide all

Collapse all

Expand all

Mew Group

Properties

Lquing
Maximum KVa
Maonth

Month Mame
Phase
PlintShapelD
PlintT5Ticks
Rated KVA
Secondary Tra...

® Sernvice Hours

Single Transfo...
Substation
TimeStamp
Transformer T...
Violtage Avera...
Violtage Maxi...
Violtage Mini...
Voltage Quality
Week of the Y...
Wh Delivered ...

Change the name to Loading (25%) and set the bin size to 25, then click OK.

Groups

Name [ Losding (25%)

Group type | Bin ¥
Bin Type Size of bins ¥

Binsize |25

Reset to default

56

Min value

Max value

Loading

0

2093

Binning splits numeric or date/time data into equally sized groups. The default bin size is calculated based on your data.
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Loading by Circuit — Stacked Bar Chart

Now we can begin to configure the report. Click some empty space and add a Stacked Bar
Chart:

VISUALIZATIONS

With the Stacked Bar Chart selected, drag and drop Fields from the data set into the field
configuration boxes. Use Circuit for the Axis, Loading (25%) for the Legend, and Service
Hours for the Value:

r - 7 ..
o +« B Transformer Loading
Loading (25%) @0 @25 50 @75 100 125 @150 @175 200 @225 @250 275 i = Cireuit
M & Day
Angels Basilic W 2 Day Name
A M  Headquarters
Cem ~ M " : Headquarters ...
By —————— .
~ Circuit
Escuslz Platznare - Loading
Iﬂ,u ] | e
werees oisic: | S | B 5 Maximum KVA
Loading (25%;
e | achiq 2] B = Month
Juzea de los Ninas I 1 3lue M  Month Name
o - Phas
M = PlintShapelD
santa cuz ] - B = PlnTSTicks
= PlIntTSTicl
Toucan Ranch -
) W = Rated KVA
W Secondary Tra..
& Service Hours
0.0M 0.1M 0.2M 0.3M 04M 0.5M 0.6M R
L - o - d M  Single Transfo...

Next we will apply some formatting and filters to make the data set more manageable. We'll
change the color scheme and only show Loadings greater than 125%, since loads in the normal
range are not of interest to us.
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In the Visualizations Pane, with Fields Selected, scroll down to the Visual Level Filters and filter
for Loading greater than 125%. Be sure to click Apply Filter:

Next go to the Visualization Options and sort by Service Hours:

r

Loading (25%) @150 @175 200 225

58

FILTERS

Visual level filters

Circuit (Al

Loading (25%) (All)

Filter Type

Advanced filtering

Show tems when the
value:

is greater than

12

®and Oor

=

:El Export data
IEI"p Show Data
X Remove
=l Spotlight

Sort By Circuit

Sort By Service Hours
Circuit
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Next change the color scheme. With the Visualization selected, click the Format Icon in the
Visualization Pane and adjust the colors to better convey the severity of the loading levels.

VISUALIZATIONS

. Data colors

150,00

175.00

200.00

22500

250,00

27500
I —

The stacked bar chart should now look something like this:

Loading (25%]) 150 175 200 @225 @250 @7
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Service Hours and Average Load by Transformer — Table

The next visual we will add is a basic table showing the Transformer Name, Phase, Service
Hours, and Average Load. We will then filter the table to show only the top 20 transformers by
average load. This will give us a quick indicator of which Transformers are consistently
overloaded.

Click some blank space on the canvas to deselect any visuals, otherwise you will
accidentally convert the Stacked Bar Chart to a Table.

Create a Table:

VISUALIZATIONS

oAl T

9 o

Drag and drop the Secondary Transformer, Phase, Service Hours, and Loading Fields into
the Values section:

VISUALIZATIONS > FIELDS

=
o
= |H

m

e <« B Transformer Loading
B W  Circuit

N i Day

W i Day Name

M Headquarters

HOCERMN

o ll

" : Headquarters ...

Secondary Transformer

|
|
L]
v

Phase

Service Hours

Loading 5 Month
Month Mame

FILTERS
level filters

Loading (All)
Phasze (All)
& Service Hours

Secondary Transformer (... .
Single Transfo...
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Change the Loading Value to summarize by Average:

Remove field

Rename

Conditional formatting b
Remove conditional formatting
Don't summarize

Sum

+/ Average

Minimum

Maximum

Crnmt Michime+

Change the Visual Level Filters to Show the Top 20 Transformers by Average Loading. Be
sure to drag and drop Loading to the by value field, and be sure to click Apply filter.

FE=ERE WIE Dzy
. W ¥ Day Name
W  Headquarters
= » M " : Headguarters ...
alues N = Hour
W= d
Loading
Loading (25%)
W = Maximum KVA
Loading W = Month
W Month Name
FILTERS Phase
W = PlintShapelD
W = PlIntTSTicks
Loading (All) W > Rated KVA

(=1} o
Ty

Secondary Transformer
Phase

Service Hours

Visual leve] filters

Phase (All) Secondary Tra...
[ Service Hours

Secondary Transfo rmer -

top 20 by Loading W  Single Transfo...

Filter Type W  Substation

TopN H TimeStamp
W Transformer T...
W = Voltage Avera...
Top ¥ |20 W = Voltage Maxi...
W = Voltage Mini...

Show items:

By value

W = Voltage Quality
e

W = Wh Delivered ...
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Under By value, change the loading summary to Average, and don'’t forget to click Apply Filter
again:

Visual level filters

Loading (All) Surm

Phase (All) Average

Secondary Transformsg Minimum
top 20 by Loading
Filter Type

Maximum
Count (Distinct)
Top N -

Count
Show tems:

Standard deviation
Top
Wariance

By value Median

Average of Lo...

Filtering by Month — Slicer
We’'ll now add a basic Slicer to filter by Month. Click some blank space and then add a Slicer:

VISUALIZATIONS

Drag Month Name to the field list.
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Go into the formatting options and change the orientation to horizontal to change the look of the

Slicer:

# General

Outline color

Outline weight

Drienbﬁ-..

on —@

Responsi...

The report should now look something like this:

F
-

Secondary Transformer Phase  Service Hours  Average of Loading
Loading (25%} 150 75 @200 @225 @250 @75 PT_XYZ0083 ¥ Dhase 2208
PT_XYZ0D6S ¥ Phase 2208
PT_XYZ0OT1 ¥ Phase 2208
PT_XYZ0D36 ¥ Phase 2208
PT_XYZ0109 ¥ Phase 2208
- PT_XYZ0126 ¥ Phase 2208
R PT_XYZ0195 ¥ Phase 2208
rres e I PT_xYZ0210 % Phase 2208
PT_XYZ0254 ¥ Phase 2208
2208
. PT_XYZO410 2208
) PT_XYZ0425 2208
Unive PT_XYZ0S66 2208
PT_XYZ0537 2208
scuels Joaqui PT_XYZ0582 2208
PT_XYZ0508 2208
o PT_XYZD644 2208
PT_XYZ0834 2208
Cementerio PT_XYZ0211 2208
PT_XYZ1470 2208
azen Colo Total 44160
20 300 400 0 60 7 200
Month Name
June July August
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Sort the table by Average Loading:

— A

L. Export dat
Pole Transformers - xport data
Secondary Transformer  Phazs Service Hours  Average of %0 Show Data
Loading X Remave
PT_XYZ0109 X Phase 2208 130.5€ Automatically find clusters
PT_XYZ0911 X Phase 2208 122.20
R = Spotlight

PT XYZO377 7 Phase 2208 117.11
PT_XYZ0096 X Phase 2208 116.99 Sart By Secondary Transformer
PT_XYZ0884 Z Phase 2208 103.06 Sort By Phase
PT_XYZ0566 ¥ Phase 2208 96.66 Sort By Service Hours
PT_XYZ0OT1 Y Phase 2208 95,5 s T -
PT XYZ0410  Z Phase 2208 gp.9d L SoTt By Average of Loading
PT XYZ0b44 X Phase 2208 B7.80
PT_XYZ1470 X Phase 2208 B3.37
PT_XYZ0126 X Phase 2208 82.92

Phase (All
PT_XYZ0589 X Phase 2208 B1.63
PT XYZ0428 7 Phase 2208 81.24 Seconda
PT_XYZ0254 X Phase 2208 81.08 g 20 by
PT_XYZ(195 ¥ Phase 2208 80.18 Senvice He
PT XYZ0210 X Phase 2208 79.63
PT_XYZ0587 X Phase 2208 79.53 Page level
PT_XYZ0063 X Phase 2208 78.23 .

rag data
PT_XYZO065 ¥ Phase 2208 78.01
PT_XYZ0608 X Phase 2208 76.36

Click the bars on the Loading by Circuit chart and the Month slicer buttons and note how
the service hours and transformers for that load range update on the table.

We will save formatting until the end in case we need to save time, but feel free to adjust the
formatting and add a title.

Linking to PI Vision

We have a PI Vision display for Transformers that we can link to from this report. We will utilize
PI1 Vision URL Parameters to set the same Transformer in the PI Vision display that the user
clicks on in the Power BI report. The URL parameters reference guide can be found in the PI

Live Library.

From within the client virtual machine, Navigate to:
https://pisrv0l.pischool.int/PlVision/#/Displays/3/TransformerTrends

Take the above URL and append the following string to it in a text editor, then paste the URL
into Chrome:

?Asset=\\PISRVO01\Distribution Network\Secondary Transformers\PT_XYZ0046
Transformer PT_XYZ0046 should be the selected Asset in the TransformerTrends display.
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Note that the ?Asset parameter denotes the path to the Asset in the Pl AF hierarchy.

Once that is working, configure a Calculated Column to concatenate the URL with the

Transformer asset path.

Go to the Data Tab:

Cut
ER Copy

(&

ol | H = | PI'World Lab Development - Power Bl Desktop
Maodeling Help
G [ E B
Get Recent  Enter Edit

Paste

Format Fainter

Clipboard

Data~ Sources = Data Queries ~

External data

Refresh

Mew  New
Page Visual

Insert

m 815497

815498
815498
815500
815501
815502
815503
815504
815505
815506
815507

osccno

Heredia
Heredia
Heredia
Heredia
Heredia
Heredia
Heredia
Heredia
Heredia
Heredia
Heredia

[P,

7/2/2017 12:00:00 AM
7/2/2017 1:00:00 AM
7/2/2017 2:00:00 AM
7/2/2017 3:00:00 AM
7/2/2017 4:00:00 AM
7/2/2017 5:00:00 AM
7/2/2017 6:00:00 AM
7/2/2017 7:00:00 AM
7/2/2017 8:00:00 AM
7/2/2017 9:00:00 AM

7/2/2017 10:00:00 AM

F41M01 T 14-A0-AA AL

R T T R R R ]

Month Name

July
July
July
July
Juty
July
July
July
July
July
July

Right click on the header of any column and select New column:

R O A =1

o o~ ;e

11
12
13
14

16
17
18

Sar

scending

San Sort Descending
Sar C
Sar
ca Copy
Sar Copy Table
=5 New Measure
Sar
Sar
Sar Refresh Data
53 Edit Query
Sar
ca Rename
Sar Delete
i Hide in Report View
Sar
Unhide All
Sar e
Sar New Group
San Pablo Transformer 1
San Pabin Transformer 1

Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal
Escuelal

Faruelal

We
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For the DAX formula, enter the following and hit enter or click the checkmark:

P1 Vision = "https://pisrv0l1.pischool.int/PIVision/#/Displays/3/TransformerTrends" &
"?Asset=\\PISRVO01\Distribution Network\Secondary Transformers\" & 'Transformer
Loading'[Secondary Transformer]

lpooarg EXTEFMAEl Q4ata INSEIT L LIATOm WIsUals K

[Zecondary Transformer]

-~ T - - - o B

Next scroll all the way to the right and find the PI Vision column, then select it.

Go to the Modeling Ribbon, and change the Data Category to Web URL.

a5 = | PIWorld Lab Development - Power Bl Desktop
Home Modeling Help
Data type: Text ~ Home Table:
g 2 & &) _
Format: Text = IData Category: Uncategorized 'l

Manage New New  New New Sort by y . A . )
Relationships  Measure Column Table Parameter Column~ J /o % .6o|Auto O +  Uncategorized mmariz
Relationships Calculations What If Sort Formatting Address

—

PI vision = "https://pisrvel.pischool.int/PIVision/#/Displa" City "2AS K
Transformer] Caontinent

PlintShapelD Loading (25%) Country/Region I

0 Sunday 1 0 https;//psrvDl.pischool. County nerTre

0 Sunday 1 0 https;f/pErv0l. pischool. Latitude nerTre

0 Sunday 1 0 https://psrvDl.pischool. Longitude nerTre

0 Sunday 1 0 https;//psrvDl.pischool. Place nerTre

0 Sunday 1 0 https;//pervD].pischool. Postal Code nerTre

0 Sunday 1 0 https://pErv0l.pischool. State or Pravince nerTre

0 Sund 1 0 httpsy//pEnvDl.pischool. nerfre
= psi/lp 2 Web URL

0 Sunday 1 0 https;//pervD].pischool. nerTre
Image URL

0 Sunday 1 0 https;//pErvD].pischool. nerTre
Barcode

0 Sunday 1 0 https:;//pErv0l.pischool. - nerTre

A Coimd = , I L i JE e e L e B

Now go back to the Report Tab and select the Table, then drag and drop the PI Vision field as
one of the table values

W i Day Name
Headquarters
" : Headquarters ...
Hour
d
Loading

Secondary Transformer

Phase

W Loading (25%)
W = Maamum KVA
Loading N = Month

Service Hours

Pl Vision B Month Name

\ Phase

PlintShapel D
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The links are now displayed, and they work, but they are not pretty to look at. Luckily Power Bl
has a feature that addresses this.

Go into the Formatting Options, scroll down to the Values section, and turn on the URL icon:

Now the links look much cleaner:

v General

“ Table style

' Grid

% Column headers

Font color

Background color

Alternate font col...

Alternate backgr...

Qutline

URL icon

Word wr..

Font fam.

Secondzary Transformer  Phazs

BT_XYZO37T

PT_XYZ0096

FT_XYZ0584
PT_XYZ0566
PT_XYZ0OT1
PT_XYZO410
FT_AYZD844
PT_XYZ1470
FT_XYZ0126
FT_XYZ0589
FT_XYZ0428
PT_XYZ0254
PT_XYZ0195
PT_XYZ0210
FT_XYZ0587
PT_XYZ00G3
PT_XYZ00GS
PT_XYZ0608
Total

X Phase
X Phase
Z Phasze
X Phase
Z Phase
¥ Phase
¥ Phaze
Z Phase
X Phase
X Phase
X Phase
% Phase
Z Phase
¥ Phase
¥ Phase
X Phase
¥ Phase
X Phase
Y Phasz

% Phase

None

Service Hours
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208
2208

44160

Segoe Ul

Average of Loading  PIW

2

E]

@& IINEDIADD PO

Test the links to confirm that the PI Vision display is launched and the correct transformer is set.

@ OSlsoft.
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(Optional) Formatting

Take some time to apply formatting to make the report more visually appealing and easier to
read.

1. Add a Title text box for the report (Home Ribbon -> Insert Text Box)

Add titles for the Stacked Bar Chart and Table, change the font color to black and bump
up the font size

Adjust the sizes of the header text

Resize the columns

Move the Legend on the Stacked Bar Chart to the bottom

Remove the totals from the Table

Remove the header from the Slicer

N

No o sw

The end result should look something like this:

Transformer High Loading

High Circuit Loading Pole Transformers

sec ry Transformer  Phasz  Service Hours  Average of Loading
2208
2208
2208
2208
2208
2208

Loading (25%) 150 175 200 @225 @250 @275

Finally test the links and experiment with filtering the report.
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5.2.3 Directed Activity — Circuit Voltage Quality

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objectives:

e Configure a Hierarchy Slicer
e Configure Clustered Column Charts to represent voltage quality distributions
e Configure Multi-row Cards to show some basic statistics

Utilities are required by the Public Utilities Commission to deliver power to customers at a
certain voltage quality. We want to check to see if the various circuits in the network are within
this range.

Voltage Quality is essentially the ratio of the delivered voltage to the nominal voltage. Our
fictitious distribution company aspires to operate at an average quality slightly above 100%.
Recall that we are using Asset Analytics to aggregate the average voltage quality from the child
meters.

We will configure a report to determine whether this is true across all transformers by
plotting the voltage distributions on a per-phase basis. We will use a Hierarchy Slicer
for filtering and display some basic statistics using Multi-row Cards.

Approach:

Start a new sheet and name it Circuit Voltage Quality:

MNetwork Load Profile Transformer Loading Circuit Voltage Quality +

Downloading the Hierarchy Slicer

For this part, there is no need to visit the web site, sign up, or download the file. We have
downloaded the file for use in class so that students do not need to sign up!

The Hierarchy Slicer is a custom visual that can be used to filter reports and mimic the Pl AF
hierarchy. This is similar to the PI TreeView from Pl WebParts.

Most custom visuals can be found on Microsoft AppSource. We will briefly go through the
procedure of how one would normally obtain a custom visual.
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Search for a custom visual on Google or within AppSource and you'll arrive at a page like this:

https://appsource.microsoft.com/en-us/product/power-bi-visuals/WA104380820?tab=0verview

At which point you would click Get It Now, sign in using your work or school account, and
download the .pbiviz file.

B® Microsoft Cloud Mobility Productivity
AppSource Apps Consulting services List on AppSource Blog

Apps > HierarchySlicer

HierarchySlicer

Overview Review

| GET IT NOW

%k kK (26)

Pricing

 Total visible items are imited to +- 4000 items for optimal performance

 There is no limit to the number of levels

Importing and Configuring the Hierarchy Slicer

Now it's time to import the custom visual. Open Power B, click the ellipses within the
Visualization Pane, and select Import from file:

VISUALIZATIONS 2> FIELDS

< BB Uility Transformer ...
W Circuit
W Headquariers

Import frem file

Import from marketplace

Delete a custom visual

> Maxmum KVA

Navigate to C:\Class\Part 1 - Pl Integrator for BA\Power Bl Custom Visuals and select the
HierarchySlicer file.

il Open
TH 0 CaClasshPart 1 - Pl Integrator for BAPower Bl Custom ‘ufisuals| V‘ v |
Organize *  New folder
v Faworites Marne - Date modified Type Siz
B Desktop i) HierarchySlicer HierarchySlicer 45883677, |8/272018 820 PrA Fdicrosoft Power B,

& Dowenloads

T -
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We should now see the Hierarchy Slicer in the list of available visuals:

VISUALIZATIONS

[

-—
-,

L5t

Mimic Pl AF Hierarchy — Hierarchy Slicer
This exercise requires the Hierarchy Slicer custom visual be imported and assumes the
Hierarchy has been configured.

We will use a Hierarchy Slicer to leverage the existing Pl AF hierarchy for filtering. Add a
Hierarchy Slicer:

VISUALIZATIONS

[

-—
w,

L5
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Drag and drop the Hierarchy to the visual fields:

M| Day
W iiZ Day Name
W  Headquarters

Headquarters Hierarchy
Headquarters
Substation
Single Transformer
Circuit
Phase

Secondary Transformer

W Month Name
W  Phase
W i Pl Vision

Experiment with the Hierarchy Slicer for a bit by drilling down through the levels. Note that
checking a box for a parent will also include the children. This is a great way to visualize how
filtering works in Power BI.

Optionally change the Title of the Hierarchy Slicer to Network in the formatting options and
increase the text size.

Voltage Quality Profiles — Clustered Column Chart

In this part we’ll use a trick to represent a statistical distribution using a combination of a Group
and a Clustered Column Chart.

First configure the Group for voltage qualities, using .1 as the bin size. These bins will form the
x-axis of the chart. Click the ellipses next to Voltage Quality and select New Group:

Add filter

Mew hierarchy

Add to Hierarchy »
Mew measure

MNew column

Mew guick measure
Rename

Delete

Hide

View hidden
Unhide all

Collapse all

Expand all

MNew Group

Properties
Il = Voltage Quality e
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Change the name to Voltage Quality (0.1) and the bin size to 0.1 the click OK:

hd
Groups
Mame I Voltage Quality (0.1) I Field Voltage Quality
Group type | Bin ¥ | Minvalue 0
Bin Type Size of bins ¥ | Maxvalue | 213125
Binning splits numeric or date/time data into equally sized groups. The default bin size is calculated based on your data.

Bin size I 0.1

Reset to default

]

Now add a Clustered Column Chart:

VISUALIZATIONS

i
¥ EH
FEERS

Use the Voltage Quality (0.1) Group as the Axis, Phase as the Legend, and Count of Voltage
Quality (summarize Voltage Quality by Count) as the Value.

The chart is of course not usable in its current form. We will need to apply filtering to show only
the X Phase and remove the outliers from the chart.
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Under Filters in the Visualization Pane, filter to only include the X Phase:

FILTERS

Visual level filters

Count of Voltage Quality ...

Phase [
is X Phase
Filter Type

Basic filtering

Select All

¥ Phase
Z Phase

=]
v
||
||

Filter the Voltage Quality (0.1) bins to only include the range of 95 to 105. Be sure to click
Apply Filter:

Visual level filters
Count of Voltage Quality ...

Phase
is X Phase

Voltage Quality (0.1) (... »~

Filter Type
Advanced filtering

Show tems when the
value:

i= less than
105
®and Oor

is greater than

Apply filter
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Now apply some formatting:

¢ Change the visual title to “X Phase Distribution”, make the text black, and increase the
text size

e Turn off the legend

e Turn off the Y-axis

e Turn on the X-axis title and increase the text size (expand X-Axis in the formatting
options)

e Change the Data colors to blue

The resulting chart should now look like this:

* Phase Distribution

wn

III‘“||‘|IIIIIHI|-.._
100 105

Now creating the distributions for the Y Phase and Z Phase is easy. Simply copy and paste the
X Phase Distribution Line Chart and change the Filters and Titles:

FILTERS

Visual level filters

Count of Voltage Quality ...

is ¥ Phase
Filter Type
Basic filtering

O Select All

W X Phase 1268192
"

|

Now select them all and align left then distribute vertically:
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W He =1 Visual tools Transformer Loading Scratch - Power Bl Des

Home View Modeling Help I Format I Data / Drill
o Drilling filters other visuals |% D‘D’D
g—ﬂ o O e

Edit Bring Send Align gDistribute
interactions forward ~ backward |~ i
Interactions Arranf{ = Align left I

&, Align center
S| Align right
it Align top
ot Align middle
iy Align bottom

r = =1
Headguarters =l
*O Alajuela X Phase Distribution
* O Cartago
'O Heredia
* O San Jeronimo 1 1
* O san Jose ‘I I
B |
a5 100 105
Voltage Quality (0.1)
[ - - |
o = & -1

Y Phase Distribution

| ...
S ..........‘,...mllllIl I IIlIlI.Im.... -
0

95 10 105
Voltage Quality (0.1)
L - <
r = & -1

Z Phase Distribution

95 100

Voltage Quality (0.1)
L - <

I=
o

Voltage Quality Statistics — Multi-row Card

We will now configure multi-row cards showing some voltage quality statistics for the different
phases.

Click some white space and add a Multi-row Card:

VISUALIZATIONS

& Il i m

44 s Im
v = ®

~ gg
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Add Voltage Quality as the first field, summarize as Average and rename the field to
“Average”:

W Circuit

Average of Voltage Qua o, M Phase

Remaove fizld

FILTERS Rename

. - Don't summarize
Vizual level filters

Sum
Average of Voltage Qua

Average

Page level filters Minimum
Drag data fields here Maximum
: : Count (Distinct)

Dnllthrough filters

Count
Drag drillthrough fields |

Standard deviation
Report level filters )

Variance

Drag data fields here Median

{ ol EEREE Y =

Add Voltage Quality again, this time summarize as Median, and rename the field to “Median”.

Repeat for the Standard Deviation and Variance:

Average

Median

Standard Deviation

Varianc
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Filter the card to only include X Phase data, similar to the distribution charts. Drag and drop
the Phase to the filters list and select X Phase:

Substation
Single Transf...
Circuit
Phase
Secondary Tr...
Hour
Id
Variance i
Loading (25%)
FILTERS Maximurm KVA
Month
Month Mame
Average (Al
Median (All) ‘ W i Pl Vision
W = PlintShapelD
Phase
< % Phase W = PlintTSTicks
Filter Type W = Rated KVA
W Secondary Tra...

W B Service Hours

Average
Median

Standard Deviation

Visual level filters

Basic filtering

O Select All

B W Single Transfo...
|

|

¥ Phase 218816 W Substation
Z Phase 1302720 B TimeStamp

W Transformer T...

W = Voltage Avera...
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Apply some formatting changes to the Multi-row Card:

¢ Add the title “X Phase Voltage Statistics” to the card using the formatting options.
Change the text color to black and increase the text size.

e Turn on the border

e Turn off Show bar under Card

o Change the category labels to black text

Once you're happy with the formatting, copy and paste the X Phase Voltage Statistics card and
change the filtering to create cards for the Y Phase and Z Phase, then align them with the
distribution charts. The resulting report should look something like this:

Circuit Voltage Quality

Network

X Phase Distribution X Phase Voltage Statistics

101.23 101.25
Average Median

|I||‘|‘|‘|‘I| o -
Standard Deviation Variance
............................... llllll'llll I|I|I|I|I|I|u.-.....
0.1)

Y Phase Distribution Y Phase Voltage Statistics

101.22 101.31
Average Median

Standard Deviation Variance
......... lllllllll |I|I|I|II-.-.._.
(

Z Phase Distribution Z Phase Voltage Statistics

101.47 101.56
Average Median

2.87 8.2z

VI“"' Standard Deviation Variance
I ”“II::. —_—
105

...,!.,.uuiFIli:lll‘ .

Finally experiment with filtering the report using the hierarchy.
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5.2.4 Directed Activity — Substations on a Map

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:
e Configure a Map visual

We want to display the different substations from the Network Load Profile on a map to lend
geographical context to the report. This will help assess which substations may be impacted by
extreme weather patterns and the relative importance of various substations in terms of
delivered power and geographical region.

Approach:

Substations on a Map — Map

We will modify the Report from Exercise 5.2.1 to include a Map of the substations instead of the
transformer matrix.

You may want to start with a copy of the solution file C:\Class\Part 1 - PI Integrator for
BA\Solutions\Network Load Profile.pbix or copy the 5.2.1 report to a new sheet. This is just
to back up your work since we will be deleting the Matrix to free up screen real estate.

You may have noticed that the data set we’'ve been working with doesn't really include
geocoding information, which is the information required to place each substation on a map. We
could potentially use the Substation names and hope for the best, but there will be some
ambiguity because several cities in Latin America and even Europe share these names. To
keep things explicit we will import the Latitudes and Longitudes of all the substations.

80



Analyzing Pl System Data

Use Get Data and import data from a Text/CSV file:

ol | H = | Exercise 1- Network Load Profile - Power Bl Desktop

Home View Modeling Help

s o E B [ &k

Copy
Paste . Get Recent  Enter Edit Refresh Mew  New
Format Painter | pata~ fsources~ Data | Queries = Page~ Visual
Clipboard Most Common ta Ins

Excel
Power Bl service

Montl D Analysis Services g

Headc July August
I:Tj Text/CSV i
Cartag
Estac D Web
Trar -

U! [‘% OData feed
3 ooy

hﬂore.” I--

pT wvzonas | I SRS

D SQL Server NetWOf

A

Select the C:\Class\ Part 1 - Pl Integrator for BA\Substation_Locations.csv file:

LA A L Part 1 - Pl Integrator for BA
Home Share e
— Cut i [ Mew item =
] 4 s X = = 2
W] Copy path - | — —,‘j Easy access = =
Copy  Paste haove Copy | Delete Rename Rt Propetties
2| Paste shortcut to ta - folder -
Cliphoard drganize [ ey (o]
© v 1~| | » ThisPC » Local Disk(C) » Class » Part1-PlIntegratorfor BA » |
Y
0 Favorites s
B Desktop , Power Bl Custorn Wisuals
& Downloads ) Solutions
i._"- Recent places | Starter File - Part 1 Distribution Network.phix
Il_, Substation_Locations.csv I
1M This PC

Power BI will automatically detect the headers, leave everything as-is and click Load.

@ ose:
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Next, we need to define a relationship between the Transformer Loading data set and the new
Substation_Locations data set. Head to the Relationships View:

- = | Exercise 1- Network Load Profile - Power BI D

Home Modeling Help
Cut D 1
| Q) #

Copy
Paste ) Get  Recent Enter Edit
Format Painter  pata~ Sources» Data | Queries ~

Clipboard External data

I Transformer Loading

3 id
Headquarters
TimeStamp

2. Month
Month Name

In the relationships view you can configure relationships between different tables. In this case
we want to link the two tables using the Substation column from Transformer Loading to lookup
the corresponding Latitude and Longitude from Substation_Locations. If you're familiar with SQL
gueries, configuring relationships between tables in Power Bl is similar to choosing an INNER
JOIN column. More information about relationships can be found in the Microsoft Power Bl
documentation.
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Expand and reposition the tables so that all fields are visible, then drag and drop Substation
from the Transformer Loading table to the Area field on the Substation_Locations table, then
click the relationship line between them to highlight the related columns:

E Transformer Loading

-

Id

Headquarters
TimeStamp
Month

Month Name
Week of the Year

Hour

Substation

e
>
>

1R A4 4 4 4 4 14

Single Transformer
Circuit

Phase

Secondary Transformer
Loading

Maximum KVA
Rated KA
Transformer Type
Voltage Average
Voltage Maximum
Voltage Minimum
Voltage Quality
Wh Delivered Load
PlintTSTicks
PlintShapelD

Day Mame

Day

E Substation Locations

Area

Latitude
Longitude

7 ostot
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Now that we have the Latitudes and Longitudes, Delete the Monthly Average Loading Matrix
and resize the other visuals to make way for a Map, then create a Map:

VISUALIZATIONS

"
| s

(']

3

'y

Use Substation from the Transformer Loading table as the Legend, and Latitude and
Longitude from the Substation_Locations table:

VISUALIZATIONS b FIELDS

D 4 B Substation Locations
B4 W  Area

TS
4 B Transformer Loading
W Circuit
M i Day
N 2 Day Name
W Headquarters
* M " : Headquarters ...
Substation Bl = Hour
=i
M = Loading
W = Maxdmum KVA
W = Month
W Month Name
W Phase
W = PlintShapelD
M = PlintTSTicks
W = Rated KVA
W Secondary Tra...
W Single Transfo...

W TimeStamp

Latitude
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Configure Latitude and Longitude as Don’t summarize as per the warning on the Map visual:

»

Remavw

Renam

N iE Day
W ii# Day Name

WM Headquarters

M " : Headquarters ...

W = Hour

H:
M = Loading

e field

[

»/ Don't summarize

Sum

Averag

=

Resize the Map to fill the left side of the report, and add Average of Wh Delivered as the Size

field:

Substation

Latitude

Longitude

Average of Wh Deliver = -8

FILTERS
vel filters
Average of Wh Delivered ...

Latitude (All)

Latitude

Remove field

Rename

Sum

Minimum

Maximum

Count (D
Count

Standard
Variance

Median

istinct)

deviation

Show value as

MNew quick measure

EEEEEEESENN

Rated KVA
Secondary Tra...
Single Transfo...
Substation
TimeStamp
Transformer T...
Voltage Avera...
Voltage Maxi...
Voltage Mini...
Voltage Quality
Week of the Y...

1 = Wh Delivered ...
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Apply some formatting:

¢ Change the Title of the Map to “Average of Wh Delivered by Substation”, change the text
to black, and increase the text size
o Move the Legend to the bottom

Replace the Legend field in the Clustered Column Chart with Substation:

F = Z .1 = B A
Average of Wh Delivered by Headquarters N Latitude
M Longitude
4 B Transf
156 W Circuit
. W Day

lonth Name Zd ame
e 1 Month N M 2 Day N
B Headguarters
. Legend + M " : Headquarters ...
B
Substati M 5 Hour
W d
0K - . . alie
June Juty August

M 5 Loading
Average of Wh Delivkre M > Maximum KVA

®Avenida .. ®BarrioCu.. ®CocaCola ®EstacionL.. ®Moravia »
- - 4 N 5 Month

Month Name
Wh Delivered by Weekday 2 == M Phase
1 o M 5 PlinShapelD
M 5 PlntTSTicks

- = = W = Rated KVA

A . FILTERS M Secondary Tra..

o / ; ) M Single Transfo...
e Visual level filters

Average of Wh Delivered ... B TimeStamp
Apply some more formatting:

o Change the Title of “Average of Wh Delivered by Headquarters” to “Average of Wh
Delivered by Substation”

e Reposition and resize the visuals so that everything looks clean

e Change the text size of the Legends so that all Substations and Weekdays are visible

The end result should look something like this:

Network Load Profile

Average of Wh Delivered Load by Substation Average of Wh Delivered by Substation
o
{32)
ity ) H H H
o San Rafael & [} =
! une Ju
25 San Juan San Vicente ea Rancho @ Auenics Centrsl @ Bario Cubs @ Cocs Cols @ Estacion Los Angeles @Moravis 53
Bras Pavas District uadalupe o o P~ g

2% Wh Delivered by Weekday

DayName @Sunday @Monday @Tuesday ®Wednesdey @Thursday ®Friday ® Saturday

Notice that you can now use the Map to filter for different substations.
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6 Part 2 - Power Bl Reports using Pl OLEDB
Enterprise

An alternative to PI Integrator for BA, which is available with the Pl System Access
license, is PI OLEDB Enterprise. PI| OLEDB Enterprise has better future data support
and is generally more flexible than PI Integrator for BA. The main drawbacks are the
difficulty of writing SQL queries and reduced throughput. For example, Pl OLEDB
Enterprise will have a hard time reliably importing the 3.8 million rows during a report
refresh as was necessary in Part 1.

In Part 2, we will explore the process of preparing the Asset Framework model to
add additional dimensions of information to our AF database. The next step is
extracting desired information (process data, metadata, and event frame data) from
the PI System through Pl OLEDB Enterprise. This data will be incorporated into a B
cube and used to develop interactive reports that allow us to “slice and dice” our data
and bring meaning to our multidimensional data cube.

fg) OSlsoft.
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6.1 Directed Activity — Pl AF Hierarchy and Data Set

In this part of the class you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:
e Better understand the data set used in the following chapters

Approach:

We will take a few minutes to review the Fleet Generation Pl AF Database. We wish
to analyze a number of KPIs for several generating units. Open PI System Explorer
and navigate to the Fleet Generation database.

Select Database

Mewr Database | 2 Delete Database 750 Database Properties (5 Edit Securi
p ty

Asset server: |@PISR'¢'D1

Databases:
f =
Mame Descripkion
@Cunfiguratian & store For configuration data,
= P World

Training Class Example

@NuGreen PI EI Project Asset Model
@0SIDemcn_ETD_FULL_FeederUDItageMDnitDring Asset Based PI Example Kit FULL database For Ta

Browse the hierarchy, which is organized into Region, Station, and Unit.

e JElernents
= (J CENTRAL

_ Albertsville
© i (9 GAoOl
L b [ GAODZ
_ {F Eeryl Ridge
R . @ BCUl

N S F BCU0Z
= (G Carbondale
...... ﬁ TCEOL
...... ﬁ TCEOZ
...... ﬁ TCEOS
...... ﬁ TCEO4
...... ﬁ TCEOS
...... ﬁ TCEOR
+- (3 MORTH

- () SOUTHEAST
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Most of the child elements are based on the generic Unit template.

Library

UNIT

@ Fleet Generation Starter
= Templates

(# Gas Turbine
(& Steam Turbine

- Event Frame Templates
- Model Templates
+-- i Transfer Templates

+- By Enumeration Sets

+- '#, Reference Types

Tables

EJ Table Connections

D Categories

[ (] Analysis Categories
attribute Categories

- (@] Element Categories

(=] Motification Rule Categories
Reference Type Categories
Table Categories

General | Attribute Templates |P0rts | analysis Templates | Matification Rule Templates |

|Er)9‘er

|i i@ B Name | Description

Default Yalue

= Cateqgory: <MNone:

=g Carbon Emissions

g Generation Rate
= Cateqgoty: Dermand
& Demand
= Cakegory: Hourly Generation
CE (Gross taeneration
CE Met Generation
= Cakegory: Identity
=g Hourly Capacity
=g Operator
& shift
=g Shift Hours Mumber of Hours in £,
=g Technology
= Category: Status

& Uniit Status

Those in the CENTRAL region are based on the Gas Turbine template, which is
derived from the UNIT template and has additional attributes.

0 gfkiwh

0 $ikiwh

0 1w

0 1w

0 M

oh

Libirary Gas Turkine
@ Flest Generation Starter General | Attribute Templates |P0rts I Analysis Templates I Motification Rule Templates
= Templates
(@ Element Templates
| Fiter
Gas Turbine |f i% & Hame | Description Default Value

(& Steam Turbine
(@ REGION

(F STATION

Event Frame Termplates
% Maodel Templates

+1-- i Transfer Templates
+- [ Enumeration Sets

‘#, Reference Types

Tables

) Table Connections

D Categories

(@] analysis Categaories
Attribute Categories

= Cateqgory: <MNone:

E CE Exhaust Gas Temperakure - #1 Probe EExhaust zas Temper...
CE Exhaust Gas Temperakure - #Z Probe Exhaust Gas Temper...
G Gas Fuel Flow Gas Fusl Flow
& Gas Fuel Pressure Gas Fuel Pressure
Gas Turbine Speed Gas Turbine Speed

o=
0=C
0 U5 galfrin
0 bar

O rpm
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Gas Turbines have all the attributes from the Gas Turbine template, but also inherit
those from the UNIT Template:

Elernents

5 Elements
- [ CEMTRAL
LB G alkbe

+ (& Beryl Ridge
; - (J Carbondale
- (F MORTH
- [ SOUTHEAST
(3, Element Searches

GA001

| General | Child Elements | Attributes |Pnrts | &nalyses | Mokification Rules | Wersion |

Gas Turbine | =T @ | ¢ Gas Fuel Flow

—______-—' o} ¢F Gross Generation
UNIT

= ¥ Gas Fuel Pressure 35,126 bar

= ¥ Gas Turbine Speed 36,031 rpm

= =] Generation Rate 0,078 $/kwh
El Category: Demand

B «F Demand 76,162 My
El Category: Hourly Generation

351,26 MW

G &F Met Generation 3466 M
El Category: Identity

= =] Hourly Capacity 550

= =] Operator B3

m «F shift 3

= =1 shift Hours gh

= =] Technology Matural Gas
Bl Cateqgory: Status

H &F Unit: Status Active

| Fiter
|# t @& £ Name & Walue
= Category: =hone =
m =] Carbon Emissions 405 gfkh
m ¥ Exhaust Gas Temperature - #1 Probe g.136859 =C
m ¥ Exhaust Gas Temperature - #2 Probe 3.7854 = C

41,255 U5 galimin

In the following chapters we will augment the AF templates with additional attributes

and KPIs.
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7 Pl Analysis Service

Pl Asset Framework is a powerful tool to help model the infrastructure of a company,
region, or division. Through PI Asset Framework Formula Data References, you can
create simple, on-the-fly calculations. Pl Asset Framework also comes packaged
with the Pl Analysis Service, for more advanced analyses. The analytic capabilities
include three analyses types, Expressions, Rollups, and Event Frame Generation,
which allow for calculations to be applied at the template level as well as the ability to
persist the results back to the Pl Data Archive.

7.1 Capabilities of the Pl Analysis Service

The Pl Analysis Service, runs as a service that monitors all analyses and attributes associated
with these analyses.

. PI Alarm Subsystem Started Automatic Local System
‘ﬁ PI Analysis Service Started Automatic Metwork 5...
. PI Archive Subsystem Started Automatic Local System

Expressions:

Expressions allow for multi-lined calculations that utilize mathematical operators and functions,
if-conditions, and PI time-based functions to perform advanced analyses. Expressions, created
for a given asset type (element template), are automatically applied to all elements of that type.
Rollups:

Rollups allow for the calculation of summary statistics (averages, maximums, minimums) of
values from a set of AF attributes. Current statistical values can be written directly to the Pl Data
Archive.

Event Frame Generation:

Pl Analysis Service allows for the automatic detection of events that occur. These events are
bookmarked and information for any event type can be retrieved for further analysis.

Scheduling:

Expressions and Rollups can be scheduled to run whenever a new event arrives into the Pl
Data Archive or calculated on a periodic basis.

Backfilling:

Results from all three types of analyses can be backfilled into the PI System.
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7.2 Expressions

With Expressions, you can implement calculations through a set of built-in functions that take
values of attributes in Pl Asset Framework as inputs, and outputs results to other Pl AF
attributes. Expressions can be scheduled to run periodically or scheduled to run whenever the

input parameters of the expressions receive a new value.

MName Expressicn Value  Qutput Attribute

Energy |TagTot('Power Generation', "*-1h', "*") Energy @

Revenue |Energy * 'Price’ Fevenus ®
Add a new exprassion

Multi-line calculation dependency allows for each expression to be written to different output

attributes as well as re-using calculated results in subsequent expressions.

Scheduling: % Event-Triggered ( Periodic

Trigger on  Any Input v

Each set of expressions allows for periodic or event-triggered scheduling.

Function Category

Example

Functions
Archive Value Statistics

TagAvg, PctGood

Insert functions into the expression

I - (C:i°d Time Pod, Hou
. And, If
Ab= i’ Logical
Aros Math Abs, Sqr
> <> *
Ej,— Operators T
_ =l | p) pata Archive Digital States | D195tate: DigText
Abs{number x) : : TagSpan, TagType
Return the absclute value of an integer or real number. Point Attributes T Eo NexEvert
Example: Abs(1) Search and Retrieval ImekEq, Nexteven
Statistical Rand, Total
Status NoOutput, TagBad

Attribute Templates

String

Len, Text

A set of built-in performance equation-like syntax allows for access to a range of
functions. The available options include mathematical and logical operators and
functions, date and time functions, Pl-specific performance equation functions, and
string manipulation functions.
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It is recommended to configure analyses at the template level.

The following procedure can be used to configure an Expression analysis using a template:

1)
2)
3)
4)
5)
6)
7
8)
9)

In the AF Database Library, create a new analysis template of type Expression.
Define expressions for the calculations in the analysis template.

Define the scheduling for the analysis template.

Define output attribute templates to store results.

Create the PI tags used to store the results.

Evaluate and preview the data to validate calculations.

Backfill the calculation if required.

Confirm the backfilled data

Backfill the data for other elements sharing the same template.
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7.2.1 Directed Activity — Calculate Utilization for Assets

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

The Utilization is a percentage that represents the amount of electrical power that a
unit produced against its theoretical capacity. Configure, test, run, and validate
analyses to calculate the percent utilization of all generating units.

Approach:

¢ In Pl System Explorer, navigate to the Library in the Fleet Generation
database.
Under Element Templates, select the UNIT element template.

e Select the Analysis Templates tab to configure the multi-lined expression for
Utilization:
Utilization = Total Hourly Gross Generation / Hourly Capacity

e Specify and configure an attribute template to store the results.

e Schedule the calculation to run periodically every hour.

e Backfill unit GAOOL1 for the past seven days.
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Approach

From the Unit Template, found in the Library plug-in of the Fleet Generation database,
select the Analysis Templates tab.

LIMIT

| General | attribute Templates | Parts | Analysis Templates |
[

Configure a new analysis. Name the analysis Utilization and set the analysis type to
Expression.

MName: Utilization

Description:

Categories: . v

Analysis Type: @ Expression () Rollup () Event Frame Generation
Configure the expressions for the hourly total of Gross Generation and Utilization.

HourlyTotal = TagTot('Gross Generation',”*-1h',"*") * 24
Utilization = HourlyTotal / 'Hourly Capacity' * 100

Marme Expression Value

HourlyTotal |TagTot('Gross Generation','*-1h",'*"}*24

Utilization |HourlyTotal / 'Hourly Capacity® * 108

Note: The HourlyTotal must be multiplied by 24, as the Performance Equation function TagTot
assumes the units of the input attributes are per day. Conversion factors should not be used
elsewhere with Pl Asset Framework, as UOM conversions occur automatically.

Define two new output attribute templates by clicking Map -> New Attribute Template.

Example Element: SOUTHEAST\Wolverine Station\ALX01

Add a new variable
MName Expression alue at Evaluatio  Value at Last Trige  Output Atfribute

HourlyTotal TagTot('Gross Generation', "*-1h", "*') * 24
N

ew Attribute Template

Utilization HourlyTotal / 'Hourly Capacity' * 1lee

=4 Carbon Emissions

A M

s
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Name them Total Hourly Gross Generation and Utilization, respectively.

e | Attribute Template Properties - @y Attribute Template Properties -
Save Qutput History: (@ Yes No Save Qutput History: (® Yes No
Marne: Total Hourly Gross Generation MName: Utilization
Description: Description:
Data Server: | FeServerts |'| Data Server: | SeServerda |‘|
Value Type: | Double |'| Value Type: | Double |'|
A Pl Point data reference attribute template will be created. A Pl Point data reference attribute template will be created.

| 0K | | Cancel | | 0K | | Cancel |

The UOMs can be set to MWh and % in the Attribute Templates tab:

UMIT
‘ General I Attribute Templates IPnrts I Analysis Templates | Matification Rule Templates |

|Fd?‘er pel " W Mame: Utilization
|’ i@ R Name | Description Diefault Yalue {8 ‘ Description:
= Category: <hone> Propetties: <None =

=g Carbon Emissions 0 gfkwh Categories;
: ki
=4 Generation Rate 0 §fkwh Default UOM ¢l I
Yalue Type: Double
€ | ¢ Total Hourly Gross Generation 0 Mwh s

T T Default Yalue: 0%
# | < Utlization i 0%
: Data Refersnce: [P Paint
= Category: Demand
Display Digits: -5

< Demand 0w

Settings...

=] Categary: Hourly Generation

W Serverds| WElement %, %eAttribute s, % ID%:  pointl
& Gross Generation 0w

7 Met Generation 0w

=] Categary: Identiy

= Houtly Capadity i)

Create the Pl Tags

After the new attribute template has been configured, switch over to the Element
Hierarchy. The attribute values for the new tags should be “Pt Created.” If not, right-
click on the root Elements object. Select Create or Update Data Reference to
automatically create the Pl tags to store the calculated results.

i Mew 3
|

Convert 3

| ¢ Create or Update Data Reference mn
Iﬁ, Categorize... B

Find 3
Make Root Mode
,ﬁ] Refresh

rl

Fl
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Switch back to the Unit Template Analysis Templates tab to schedule the Analysis
Template to run periodically at the top of each hour.

Set a Periodic Schedule

% Hours, minutes, and seconds

" Sub-seconds
' Daily

Period

Specify the amount of time between evaluations.

||31 h|nn mID[I' s

[ Specify Offset

Example evaluation times
5/20/2014 1:00:00 AM
5/20/2014 2:00:00 AM
5/20/2014 3:00:00 AM

Set GAOOL1 as the Example Element and click on the Evaluate button to validate the

expressions.

| General I Attribute Templakes I Parts | Analysis Templates |N-:-I:iFicati-:-n Rule Templates |

E:

® @ Name

fea Utilization

Example Element: |CENTRAL\Albertsville\GAOOT |

Marne: Utilization

Description:

Categories:

Analysis Type: (@) Expression ) Rol

Enable analyses when created from ter

Add a new variable ‘ I Evaluate
Mame Expression Value at Evaluatio Value at Last Trige  Output Attribute

HourlyTotal TagTet( "Gross Generation', "*-1h", **° 42544 425,84 Total Hourly Gross Generation ®
Utilization HourlyTotal / "Hourly Capacity' * 108 77.353 77423 Utilization ®

Page 97



Analyzing Pl System Data

Prior to backfilling data into the Pl Data Archive, it is usually a good idea to preview
the results. Right-click Utilization and select Preview Results. Look at the results for

the past 7 days:

Genetal I Attribute Templates I Ports | Analysis Templates | e

8 B MName
fey  Utilization

MNew
Delete

X [

Preview Results I

Backfill/Recalculate t: CENTRAL\Albertsvills\GAOO1

Backfill/Recalculate Status

Go tn Temnlate Im

Start Time: | =-7d

End Time: |* E Generate Results

Trigger Time HourlyTotal (MWh)  Utilization (%) Gross Generation (MW)  Hourly Cap
8/13/2018 11:00:00 PM 428.71 78129 42887 550 |~
81472018 12:00:00 Al 428.03 77823 42718 550
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7.2.2 Directed Activity — Backfill Utilization

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

At this point, all the analyses for event frame generation have been set up for all the
units of Fleet Generation. In order to calculate past Utilization values and generate
history for analysis, the calculations must be backfilled.

Approach:
From Pl System Explorer, select the Management plugin

(7 Elements

j== Event Frames
{2 Library

m Unit of Measure

44 Contacts
& Management

Right now, the only Analyses that exist are those we just created, so one can simply select All
or Enabled to view the Utilization Analyses that we want to backfill.

@ WPISRY01\Fleet Generation Sandt

File  View Go  Tools  Help
@Database [5 Query Date ~ (© W () Back H, checkIn %2« [2] Refresh

fanagerment Analyses
Choose a type 0 total analyses selected (0 on this page)
(@) Analyses

Status @ E  Element
(") Notification Rules U

ft9  MORTH\Greenlawn\PTCO2
ft9  MORTH\Greenlawn\PTCO1

O & f9 | SOUTHEAST\Carter\BAJD2
Analysis Searches O & féa  SOUTHEAST\Brick Camyon\PLT02
+ O ® fid  SOUTHEAST\Brick Canyon'\PLT01
IAII @I O ® fea  MORTH\Mew Bedford\POEDL
Enablad = |[E @ fé9  MORTH\Madison|CECD1

O & f6d  NORTH\Greenlawn\PTCO3
Disablad o

0 &

0 &
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Normally there would be several types of calculations, so we’'d want to filter them by setting up a
search. Create a new search:

&

File  Wiew Go  Tools  Help
@Datahase I Query Date - (0 @ eBack ¥ | H,: Check In

Managerment Analyses
Choose a type 0 total analyses selected (0 on
@) Analyses
I\: .? ) [] status & B Elemen
1 Motification Rules
- L] @ feo  CENTR:2
Analysis Searches O @ féd | SOUTHE
O @& feo  SOUTHE
Al < ||| @ fd  SOUTHE
Enabled . [ & Ji | NORTH
_ L] @ fisd  MORTH'
Disabled . [] '&' o NORTH'
] @ f | NORTH'

Name the search Utilization, then do Add Criteria -> Name and enter the name of the
Analyses and click OK.

Search Name:

MName: Utilization| <

* Analysas that match all of these criteria will be displayed.
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Click the checkbox to select all Utilization Analyses. Then Select the Backfill/Recalculate
operation and set the start time to “*-7d” and the end time to “*”, select “Permanently delete
existing data and recalculate”, then click Queue:

@

File  Miew  Go

Taols  Help

YWPISRYO1YFleet Generation Sandbox - Pl System Explorer (Administratar)

aDatabase P Query Date ~ (© @ Q Back H, CheckIn 3

¢ [#] Refresh

_I:I-

Management

Chaoose a type
® Analyses
Notification Rules

Analysis Searches

+ X

All -
Enabled o
>

Disabled

Analyses

30 total analyses selected (30 on this page)

o N

Status @ E
fia
fiea
fiea
fea
fy
fy
fiy
fiy
fia
fia
fia
fio
fea
fea
fea

(IO U T

3

fea

Element
SOUTHEAST\Carter\BAJOZ

SOUTHEAST\Brick Canyon'PLT02
SOUTHEAST\Brick Canyon'PLT01

MORTH'\New Bedford\POE0L
NORTH'\Madison\CECD1
NORTH\Greenlawn'\PTCO3
MNORTH\Greenlawn'FTCO2
MNORTH\Greenlawn'FTCO1
MNORTH\Ebbitt\PQED4
MNORTH\Ebbitt\PQED3
MNORTH\Ebbitt\PQED2

CENTRAL\Carbondale\TCBO&
CENTRAL\Carbondale\TCBOS
CENTRAL\Carbondale\TCBO4
CENTRAL\Carbondale\TCBO3
CENTRAL\Carbondale\TCBOZ

Name

Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization

Template
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization
Utilization

Enable | Disable selected analyses
Enable | Disable automatic recalculation for selected analyses

Backfill/Recalculatd selected analyses

Start | *-7d

End |*

FE

What should we do with existing data?
) Leave existing data and fill in gaps

ermanently e exisung a and recalcu
[[] Recalculate dependent analyses

| Queue |

Recalculztion will permanently delete all the
data within the time range. For event
frames this will result in loss of annotations
and acknowledgements.

Page 101



Analyzing Pl System Data

7.2.3 Exercise — Calculate Generating Efficiency

This solo or group activity is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you
need assistance during the activity.

Objective:

Not all of the electricity produced by our generators will make it out to the grid. Some
will be consumed by the internal circuity in the generator itself. The net generation is
defined as the amount of gross generation, or the amount of electricity that a
generator produces, less the electricity required to operate the unit. Calculate the
generating efficiency, or the ratio between the net generation to the gross
generation, expressed as a percentage.

Which unit is performing with the greatest efficiency?

Approach:

¢ In the PI System Explorer, navigate to the Library in the Fleet Generation
database.

e Under Element Templates, select the UNIT element template.

e Select the Analysis Templates tab to configure the expression for generating
efficiency, named Generating Efficiency.

e Specify and configure an attribute named Generating Efficiency to store the
results with units of %.

e Schedule the calculation to run periodically every hour.

e Evaluate the calculation using example element GAOO1 and preview the
results.

o Backfill all Efficiency analyses for the past seven days.
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7.3 Rollups

The second analysis capability of the Pl Analysis Service Analytics is known as
rollups. Rollups allow for the calculation of summary statistics for a set of attribute
values.

The types of summary statistics that are allowed are:

e Sum

e Average
e  Minimum
e Maximum
e Count

e Median

Examples of rollup calculations include:
e Total mass of all contents in a tank farm
e Total production from all generating units for a particular site
e Maximum temperature of boilers within a building
e Average engine temperature of mining trucks

e Average temperatures for each asset with varying temperature
Sensors.

Selecting attributes to rollup

Attributes used in rollup calculations can come from 1) attributes from child elements
relative to the element of interest or 2) the element of interest. One can set search
criteria to specify the specific attributes to rollup. Depending on the source of the
attributes (child elements or current element), the search criteria includes a masking
pattern for the 1) Attribute Name, 2) Attribute Category, 3) Element Category, and 4)
Element Template.

Rollup attributes from
&+ Child elements of Templatel
" This element - Templatel
To select attributes set criteria below

Attribute Name: I

Attribute Categony: I j
Element Categony: I j
Element Template: I j
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What is an element Example?

During the configuration of a rollup template analysis, when the source of the
attributes to roll up are from the child elements, Pl System Explorer is not aware of
which parent element to retrieve child elements from. As such, when configuring a
roll-up analysis template, you will need to specify an example element. Note that
when configuring a roll-up at the element level, one will not need to select an
example element as the child elements are from the specific, selected element.

Example Element: Select an example element

Scheduling and backfilling

Similar to Expressions, the rollup analyses can be scheduled to run as new events
come into the Pl Data Archive or scheduled to run periodically. The Pl Analysis
Service also allow the results from Rollup calculations to be written back to the Pl
Data Archive.

The general process to properly configure and backfill an analysis template is:

1) Create a new analysis of type Rollup.

2) Define the source of the attributes to rollup (child element or current element).
3) Select the type(s) of summary statistics to calculate.

4) Define output attributes to store results.

5) Define the scheduling for the analysis.

6) Create the PI tags used to store the results.

7) Evaluate and preview the data to validate calculations.

8) Backfill the calculation.
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7.3.1 Directed Activity — Calculate Average Utilization for Substations

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective: Management would like to have visibility over the average percent
utilization of all generating units for each substation. Roll up the average utilization to
the substation level.

Approach:

e Open up the Station Element Template from the Fleet Generation Database
Library.

Add a new analysis called Average Utilization with analysis type of Rollup.
Select Central\Albertsville as the example element.

Specify the criteria to select the attributes used for the rollup calculation.
Select the summary statistic function for the average.

Specify the output attributes (be sure to create the tags).

Schedule the calculation to be event-triggered.

Verify data.

Backfill for the past 7 days.

Step-by-Step Approach

From Pl System Explorer, go to the Library. Then select the Station Element
Template. From the Analysis Templates tab, create a new Analysis called Average
Utilization with Analysis Type Rollup.

e | WWPISRY014Fleet Generation Sandbox - Pl System Explorer (Administrator) == -
File  View Go  Tools  Help

@ Database [ QueryDate » O G5 |3 Back E, CheckIn %) « [£]Refresh | @@ New Template Search Element Templates O v|

Library STATION

e Templates ‘ General | Attribute Templates I Parts | Analysis Templates | natification Rule Templates
R Element: Templates =

% — P | o Name: Average Utilization I

b (7 REGION |

m| >

& @ Name Description:
s Turbing @ Average Utilization Categories: w
fo [ Steam Turbine v Analysis Type: () Expression () Event Frame Generation () SQC
& El t: Enable analyses when created from template
lements
= Event Frames
Example Element: CENTRAL\Albertsville

i~ | Library

~
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Specify the rollup attributes from child elements and set the example element to be
Central\Albertsville.

Example Element: CENTRAD\Albertsville

Rollup attributes from
i) Child elements of Albertsville (7 This element - Albertsville

Set the attribute name field to Utilization. This mask will automatically select all
Utilization attributes from the child elements of the Albertsville station. However in
the preview only the Utilization from the Sample Child Element will be shown:

Example Element: CENTRAD\Albertsville

Rollup attributes from | S2mple Child Element: | GACD1 [~ Group By:
() Child elements of Albertsville () This element - Albertsville

To select attributes set criteria bel Mame Parent Elernent ~
O e ec e S v Utilization GACOT =
Attribute Name: Utilization Carbon Emissions GACOT
Attribute Level: Root Level [=]|l Demand GACOT Demar
Attribute Categary: | | - | Exhaust Gas Temperature - #.. GACQO1

Exhaust Gas Temperature - #..  GACO1

Element Category: | | hd | Pt e T Ao e
Element Template: | | - | < = 4

Set the scheduling to be event-triggered. Each time the Utilization analysis finishes
calculating each hour, the rollup analysis will run.

Scheduling: (@) Event-Triggered ) Periodic

Trigger on | Any Input v
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Select Average as the rollup function and create a new Output Attribute called

Average Utilization.

Function Cutput(s)
[] 5um
Average Map

Mo atiribute templates are defined on the element template

II"-.Iex-..' Attribute Template I

[ | Lount
[ ] Median
[ Population standard deviation
e | Attribute Template Properties -
Save Qutput History: () Yes Mo
MName: Average Utilizatic:-n|
Description:
Data Server: | FServeria | = |
Value Type: | Double | = |

A Pl Point data reference attribute template will be created.
| oK | | Cancel |

Value At Bva Value At Lasi

Set the default UOM of this new attribute to % in the Attribute Templates tab:

STATION

| Generall Attribute Templates '| Ports | Analysis Templates | Motification Fule Templates |

| Hiter o - | Mame: |.ﬁ.verage Itilization
|i’ i@ £ Name 2| Description {,@}| Description: |
= Category: <Mones Properties: IE
% | < sverage Utilization ... Cateqories:
Default LOM: 2|
Walue Tvpe; |D-:uu|:u|e

—
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Ml E Attribute Template Properties o =] 4]

General I i

Mame: I.ﬁ.verage Ltilization
Description: I
Configuration Item: r Indexed: [
Categories: I

. Defaultuom:  [% =
Value Type: IDDLJb|E j F

I Default value: ID

Data Reference: IPI Point

Le

Settings...

\&eServer 3t % eElement s, YeAtiribute %6, %610 %:; pointtype =Floata4

K I Cancel Apply

4

In the Analysis Templates tab, Click on the Evaluate button to verify the result of the rollup
function.

Select the function(s) to write to an attribute Evaluate

Function Output(s) ‘Value At Bva Value At Lasi

[] Sum

Average Average Utilizati 41867 % 41.867 %
[] Minimum

Check-in your changes.

From the element hierarchy, verify that the Pl tag exists for the attribute.

From the Management pane, backfill your Average Utilization rollup analyses for the past 7
days and verify the data has been backfilled by trending the Average Utilization attributes.

@ NWPISRV01\Fleet Generation Sandbox - Pl System Explorer (Administrator) == -
File View Go Tools Help
@ Database [ QueryDate - (@ @ @D Back () [H, Checkln <) v [#] Refresh

Management Analyses
Choose a type 13 total analyses selected (13 on this page) 1-130F13 <[>
@ Analyses
 Notification Rules Status € E  Element Name Template Backfil  Enable | Disable selected analyses
/] @) | SOUTHEAST\Odtavia Average Utiization  Average Utilization 0% Enable | Disable automatic recalculation for selected analyses
Analysis Searches o @ SOUTHEAST\Carter Average Utilization  Average Utilization (1]
Backfill/Recalculate
+ X o @ SOUTHEAST\Brick Canyon Average Utilization  Average Utilization g EoddilRecaldate selected analyses
al s ) @ NORTH\New Bedford Average Utlization  Average Utilization 0 start [*74 =
Enabled - o @} NORTH\Madison Average Utilization  Average Utilization (] N
) @} NORTH\Greenlawn Average Utilization  Average Utilization 0 4‘3"
Disabled > ) @ NORTH\EbbItt Average Utilization  Average Utilization i} What should we do with existing data?
Generating Efficiency ra ] @ CENTRAL\Carbondale Average Utilization  Average Utilization [l () Leave existing data and fill in gaps
Utilization ’ ) @) CENTRAL\Benyl Ridge Average Utilization  Average Utilization 0 (@) Permanently delete existing data and recalculate
I T > I [ @ CENTRAL\Abertsville Average Utlization  Average Utilization 0 [] Recalculate dependent analyses
z [v] @ SOUTHEAST\Wolverine Station Average Utilization  Average Utilization 0
) @] SOUTHEAST!Vicksberg Average Utlization  Average Utilization 0
) @} SOUTHEAST\Stampton Average Utlization  Average Utilization 0 Recalculation will permanently delete all the
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7.3.2 Exercise — Calculate Total Hourly Gross Generation for Each Station

This solo or group exercise is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you
need assistance during the exercise.

Objective:

Management would like to gain more insight into the Total Hourly Gross Generation
at each station. Create a rollup analysis to totalize the Total Hourly Gross
Generation at the station level.

Which station produces the most power?

Approach:
e Open up the Station Element Template from the Fleet Generation Database
Library.
o Add a new analysis called Total Hourly Gross Generation with analysis type
of Rollup.

Select Central\Albertsville as the example element.

Specify the criteria to select the attributes used for the rollup calculation.
Use the Sum function and output Attribute Total Hourly Gross Generation.
Specify the output attributes (ensure tags are created).

Set the UOM to MWh.

Schedule the calculation to be event-triggered.

Verify data using Evaluate and Preview Results.

Backfill for the past 7 days and verify.

:'/--
/
.

| &
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8 Event Frame Generation

Events are important process or business time periods that represent something
happening that affects your operations. In the Pl System, events are known as event
frames. Thanks to Pl Event Frames, you can analyze your Pl data in the context of
these events rather than by continuous time periods. Instead of searching by time, Pl
Event Frames enables users to easily search the Pl System for the events they are
trying to analyze or report on.

With Pl Event Frames, the PI System helps you capture, store, find, compare and
analyze the important events and their related data.

Pl Event frames represent occurrences in your process that you want to know about,
for example:

e Downtime tracking e Environmental monitoring
excursions
e Process excursions e Product tracking batches
¢ Equipment startups and e Operator shifts
shut downs

The following table presents some of the features and advantages of Pl Event
Frames:

v" Reference multiple elements within the
same event.

v Support multiple overlapping events on a
Pl AF element.

v' Capture any event; a "batch" is just one
type of capturable event.

Flexibility

v' Search by time range, type of event or
event frame attribute.

Powerful search v Most common search attributes can be
configures as indexed attributes to speed
up end-user searches

Scalability v Pl Event Frames are extremely scalable.

A Pl Event Frame is defined by three characteristics:
1. Name.
2. Start time and end time: defines the event’s time range.

3. Context: event attributes and related assets.
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8.1 What are Event Frames?

8.1.1 Creating Event Frames

The Fleet Generation database contains a series of Elements representing the
regions and units associated with each generation plant. In order to keep up with the
power demands, it is important that the plant is up and running. We need to keep
track of the uptime associated with the generation plant.

A ‘Unit Status’ attribute is associated with each generating plant in our hierarchy.
This attribute will be used to monitor the uptime associated with each plant.

8.1.2 Time Range Retrieval Methods

There are three time range retrieval methods, the use of which depends on what data is to be
captured, and how it is to be displayed.

Time Range

This method allows a time range to be supplied by the end user. When any single value query is
made, this period of time is used for calculations. If, however a period of time is supplied from
an application, such as a generated Event Frame or Vision display, then the user specified time
range is discarded and the application time period is used.

Time Range Override

The Time Range Override behaves in the same way as the Time Range method during all
single value queries, as uses the user specified time period. When a period of time is supplied
from an application, the application time range is discarded and the user specified period is
used.

Not Supported

Not Supported does not allow for a time range to be supplied by the end user. As such, an error
is returned by any request for a single value. If a period of time is supplied however, then this
range is adopted by the method for the calculation. The result is then the same from the Time
Range method.
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There are different use cases for the methods, so care must be taken to ensure the correct
method is used.

METHOD SINGLE VALUE APPLICATION SUPPLIED
TIME RANGE User Specified range result Application Specified range
result
TIME RANGE User Specified range result User Specified range result
OVERRIDE
NOT SUPPORTED Error: This attribute requires a Application Specified range
Time Range to calculate a value result
in...

Single timestamp query results (sample element with 1h specifications)

B <7 Not Supported This attribute requires a Time Range to calculate a valuein '...
¢F Time Range 110.93823012085359

{7 Time Range Override | 110.93823012085859

Application supplied time range query results (sample 3h event frame)

«F Mot Supported 259,00273501602905
J Time Range 110.93323012085859
65' Time Range Override 259,00273501602903
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8.1.3 Directed Activity — Create a Temperature Anomaly Event Frame Template

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

The gas turbines in the Fleet Generation database each have two temperature
sensors. Create an Event Frame template with appropriate attributes to help monitor
and analyze potential issues with gas turbines. The event frame should capture the
real-time data specific to gas turbines and the current status and duration of the gas
turbine.

Approach:
e Create an Event Frame template.

Event Frame Templatas S PhaseSten

Model Templates m) Mew Template

Create a template called “Gas Turbine Temperature Anomaly”. Set the Naming
Pattern to %.\ELEMENT% %ELEMENT% %TEMPLATE% %STARTTIME:yyyy-
MM-dd HH:mm:ss%

Gas Turbine Temperature SAnormaly

General | Attribute Templates

Mame: |Gas Turbine Temperature Anomaly

Description: ||

Base Template: | <Mone =

Categories: |

Maming Pattern: |9, \ELEMEMT % SLELEMEMNT % % TEMPLATEY: %S TARTTIME vy -PIM-dd HH:mm:s5%:

[ ] Allow Extensions [ ] can Be Acknowledged

Select the Attribute Templates tab. Right click in the white space to create an
attribute.

Name the Attribute Unit Status. Select Enumeration Sets => Status as the
value type.

7
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Name: |Unit Status. | — | |

Description: || |
Properties: | <Mone = W |
Cakegories: | " |
Default LOM: | <Nones vl
Yalue Type: |Status W |
Defaulk Yalue: <None = W |
Data Reference: | PI Paink W |
Display Digits: |-5 |

Select the Pl Point Data Reference, then select Settings...

Click the radio button next to Attribute, and enter .\Elements[.]|%Attribute%.
The Event Frame references a Pl AF Element. The [.] syntax points to this Pl EF
Template’s primary referenced Pl AF element within the Elements collection. Set
the By Time Range dropdown option to “Start Time.”
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Pl Point Data Reference

Data server: Seoervert

%aElernent %, % Akkribut e

(_) Tag name:

D1 [2]

(®) akkribute: JElements[, ]| Saaktribok e

W

Unit of Measure

Source Uniks:

Yalue retrieval methods

By Time: |.ﬁ.ut|:|mati|: W |
Relative time: | |

By Time Range: |Start Time W |
Calculation basis: Tirme Weighted
Min percent good: a0

Prewigw

Example inskance: Select example instance

Configuration; |

Walue; |

Read onky

Lo ]

Cancel

Note: Substitution parameters cannot be used to make a reference to an attribute from the

Element Template that is not a Pl Tag.

o
If
]
{

OSlsoft.

%

Page 115



Analyzing Pl System Data

Upon completing the definition, click OK. The Settings will be completed as seen
below:

Settings. ..

AElements], ]| % Aktribukets; TimeR angeMethad=5kart Tirme

Create a second attribute to store the Duration of event frame. The Duration
attribute will be populated by the new EventFrame() function in a later
exercise. It’s just a placeholder for now.

Name: |Duratic-n |
Description: | |
Properties: | <Maone> W |
Categories: | " |
Default UOM: |sec0nd v |
Yalue Type: |D0uble W |
Default Yalue: 0s |
Data Reference: <Mone = W |
Display Digits: |—5 |

| Sektings... |

Create a third attribute to store the Technology. For the Value Type, select String
and for the Data Reference, select String Builder.

Marne: |Te-:hnn:n|n:ng':.-' |
Description: | |
Propetties: | =<Mone = W |
Cakegories: | " |
Default UOM:  |<Nore> vl
Yalue Type: |Statu5 W |
Defaulk Yalue: ZMone= ¥ |
Daka Reference: [ String Builder W |

Note: When the event frame attribute’s data reference is set to Pl Point, the syntax
\Elements[.]|Attribute only allows for the reference to Pl Point Data Reference attributes.
Element attributes configured as formulas and table lookups cannot be passed to event frames
using a PIPoint Data Reference. Instead, for attributes configured as formulas or table lookups,
select String Builder as the data reference.
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Set the settings for the attribute as .\Elements][.]|%Attribute%:

String Builder Data Reference -
Specify the strings and attribute values to concatenate to produce the string output value:
C\Elemenitsy. % AttHbitess
Yalue:
| J\Elements[.]| Technalogy| |
Ok | | Cancel |

Continue to create the following additional attributes. Make sure units are
properly set. The fastest way to accomplish this is to copy and paste these
attributes templates from the Gas Turbine element template.

Exhaust Gas Temperature - #1 Probe
Exhaust Gas Temperature - #2 Probe
Gas Fuel Flow

Gas Fuel Pressure

Gas Turbine Speed

|

——
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@ WPISRYOTNFleet Generation Sandbox - Pl Systerr
File  %iew Go  Tools  Help
@Database [ Query Date ~ © @ @ Back H, CheckIn ¥} « [#] Refresh | @ New Template ~ =1

Library Gas Turbine

it Generation Sandbo ||| General | Attribube Templates |Ports | Analysis Templates I Motification Rule
Templates

- (@ Element Templates

(@ REGION |ter

£ STATION |’ i/ R Name 4 Description
G L
B Cateqgory: <Mone:>

"E Event Fam:j’:m;llrat:: CE Exhaust Gas Temperature - #1 ... Exhaust Gas Temper.,

- =g Gas Turbine Temperature Anomaly ¢ Exhaust Gas Temperature - #2 ... [Exhaust Gas Temper.,
- IEI Madel Templates
. —% Transfer Templates CE Gas Fuel Flow 5as Fuel Flow

Enumeration Sets

& Gas Fuel Pressure ¥5as Fuel Pressure
Reference Types
Tables CE Gas Turbin - urhine Speed
. P Il G
| Table Connections
Cateqaries ) ) 3 Copy
E @ Analysis Categories
Attribute Cateqories hd Copy Cell |
- m ~

Once these 5 attribute have been pasted into the Gas Turbine Temperature
Anomaly Event Frame Template, select them all and enter
AElements[.]|%Attribute%; TimeRangeMethod=StartTime as the configuration
string to set the data references and retrieval method in bulk:

Library Gas Turbine Temperature Anomaly
Fleet Generation Sandbox General | Attributs Templtes |
Templates Group by: [v] Category [ Template
= (G4 Element Templates i - ‘ I |E et Cas T " #1 Probe, Exh
- (G REGION Gl L Name: whaust Gas Temperature tobe, Exhau
- (G STATION |I i & Mame 2 Description Default Yalue ) ‘ Description: |
- G UNIT -
- [ Gas Turbine =) Category: <Mone> Properties: |<None> -
: b (g Steam Turbine CE Duration as Categories: | "@
= .
H i H Default LUOM;
i g Gas Turbine Temperature Anomaly EGE Exhaust Gas Temperature - #1 ... {Exhaust Gas Temper... |0°C ik
+ Model Templates Yalue Type: Daouble ~
+ % Transfer Templates GE Exhaust Gas Temperature - #2 ... | Exhaust Gas Temper... |0°C |
[ Fiom Sets Default Yalue: |D
riumera| <& Gas Fusl Flow Gas Fuel Flow {115 galfmin
‘#, Reference Types Data Reference: |PI Foint A
Tables < Gas Fus! Pressure Gas Fuel Pressure 0bar |
=) Table Connections Display Digts: |5
E . CE Gas Turbine Speed Gas Turbine Speed arpm
(] categories B
for (@] Analysis Categories = Technology
b Attribute Categories e JAElerments[ ]| S&attribute; TimeRangeMethod=5tart Time I
Le. (@0 Flament Catannriee & Unit Status

Check in your changes

Note: %attribute% will substitute in the name of the event frame attribute template. This will then
point to the corresponding attribute in the referenced element. You can also select multiple
attributes when making modifications to the attribute configuration.

118



Analyzing Pl System Data

8.1.4 Exercise - Create Inactivity Event Frame Template

need assistance during the activity.

Objective:

Generating units sometimes trip or go down. Management would like to understand
these downtimes, and determine how much demand was not serviced. Event frames
can help capture and bookmark these events for future analysis. Develop an Event
Frame template, called Inactivity using the same Naming Pattern as the previous
exercise, with fields required to track the desired plant information to create reports
for management. Specifically, management would like to know the following:

Unit Status — Real-time (copy/paste from previous exercise)
Duration — in seconds (copy/paste from previous exercise)
Technology — Metadata (copy/paste from previous exercise)

Hours Down — in hours (simple formula to convert seconds to hours)
Demand — Real-time (Pl Point data reference)

Operator — Metadata (string builder)

Carbon Emissions in g/kWh — Metadata (string builder)

© N o o~ w DR

Total Demand in MWh — Real-time, Aggregation of Demand

Hints:
o For metadata, use String Builder as the Data Reference.

e For Total Demand, configure the attribute’s source units as MJ / s By Time
as “Time Range”, Relative time as “-1s” and By Time Range as “Total”

o Verify correct event frame template configuration through the creation of a
test event frame.

This solo or group activity is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you

1‘(: ) OSlsoft.
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8.2 Event Frame Generation

The Event Frames Generation analysis allows for the automated detection and
generation of event frames in the Pl AF database based on values from trigger
attributes. The type of events and the types of data captured inside each event are
defined with event frame templates in Pl AF.

Some notable features of Event Frame Generation in the Pl Analysis Service include the
following:

Generate events: Easily configure event generation and automatically generate your events
from the trigger tags that are already collecting data in the Pl Data Archive.

Handle multiple event types: Generate all your different event types, such as downtime,
excursions, batches, and other events, on the same asset with no restrictions on overlapping
events.

Standardize using event frame templates and populate event attributes: Different event
types have different attributes and information that are important for analysis. Standardize your
events using event frame templates, and use the Pl Analysis Service to automatically populate
event’s attributes with data from the Pl Data Archive and Pl Asset Framework.

Backfill events: Pl Analysis Service enables you to define your history backfill time window,
then it backfills the events from previous time periods automatically.

Using Pl AF element attributes as event triggers or event attribute values: Trigger
conditions for event frames can be linked to element attributes.

Configure using Pl AF element templates: Apply the configuration of event frame detection
and generation to Pl AF element templates. The same event detection automatically applies to
newly created assets of the same asset type. There is no need to configure the event frame
generation again.

Root Cause: Event frames are great for capturing events that have occurred.
However, often times, the time period prior to the event provides more information on
the cause of the event. Pl Analysis Service allows for root cause analysis and will
capture a fixed time period (default five minutes) before the event start time for
further analysis. This will be recorded as a Child Event Frame.

Time True: The trigger condition for event frames could potentially be noisy. PI
Analysis Service allows for the specification of a minimum time true period before an
event frame will generate.
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8.2.1 Directed Activity — Gas Temperature Anomalies

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

Each gas turbine has multiple temperature sensors. If any temperature reading
deviates more than 20% from the average, then servicing is required. Use the Gas

Turbine Temperature Anomaly Event Frame Temperature to help define these types
of events.

Approach:

From the Fleet Generation Library, select the Gas Turbine Element Template and
select the Analysis Templates tab. Create a new analysis template called Gas
Turbine Temperature Anomaly, Set the example element to GAOO1, and set the
Event Frame Template to Gas Turbine Temperature Anomaly.

e | M\PISRY01\Fleet Generation Sandbox - Pl System Explorer (Administrator) = || -
File  View Go Tools Help

@ 0atabase FHQueryDate - © & | Back H, CheckIn <) « [2] Refresh | @ New Terplate ~ [search etement Tempiates £ =

Library Gas Turbine

@ Fleet Generation Sandbox General | attribute Templates | Ports | Analysis Templates | niotiication Rule Templates

= @ Templates
| & G Element Templates ‘,,E] Name: IGasTurmeTemperaturEAnuma\y|
‘%EEE;?O"JN © @ MNeme Description:
i N i Generating Efficiency Categories: v
foa  Utilization Analysis Type: () Expression () Rellup | @) Event Frame Generatien | () SOC
(% Seeam Turbine i Gas Turbine Tempe...

Enable analyses when created from template
i =g Event Frame Templates Create a new notification rule template for Gas Turbine Temperature Anomal
i~ I3} Gas Turbine Temperature Ang
b g Inactivity Example Element: [ CENTRAL\Albertsuille\GAOO1
Model Templates
Transfer Templates
e B ;%‘mermn sEtsD Generation Made: [ Explicit Trigger - Event Frame Template: | Gas Turbine Temperature Anomaly [ ~| | F—srms

oy

/
]
\

%
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Add two new variables called AvgTemp and DeltaTemp.

Example Element: CENTRAL\AlbertsvillehGACOT

Generation Mode: | Explicit Trigger | - |
Variakle ession
Start Trigger
T € Gt EXpression

Set the expressions to:
Avg('Exhaust Gas Temperature - #1 Probe’,'Exhaust Gas Temperature - #2 Probe")

'‘Exhaust Gas Temperature - #1 Probe' - 'Exhaust Gas Temperature - #2 Probe'

MName Expression 1

E Wariables

AvgTemp Avg( 'Exhaust Gas Temperature - #1 Probe’, 'Exhaust Gas Temperature - #2 Probe')
[

DeltaTemp 'Exhaust Gas Temperature - #'.ll.FﬁProbe' - "Exhaust Gas Temperature - #2 Probe’

B Start triggers

StartTriggerl | Type an expression :

Define the StartTrigger as:

IF (AvgTemp-Abs(DeltaTemp/2))/AvgTemp > 0.2 THEN TRUE ELSE FALSE

MName Expression
AvgTemp Avg('Exhaust Gas Temperature - #1 Probe','Exhaust Gas Temperature - #2 Probe’)
DeltaTemp 'Exhaust Gas Temperature - #1 Probe' - 'Exhaust Gas Temperature - #2 Probe’

StartTrigeer|IF (AvgTemp-Abs(DeltaTemp/2))/AvgTemp > 8.2 THEN TRUE ELSE FALSE

EndTrigger Type an expression (optional)

Add a new expressicn
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Add an Output Expression

Library
€D Fleet Generation General | Attribute Templates | Ports | Analysis Templates | Motification Rule Templates

B Templates

=1 [y Element Templates i
i e (G REGION ® @ MName
B g ZL?IION HH  Gas Turbine Tempe...
i [ Gas Turhine fso  Generating Efficiency
(F Steam Turbine fig  Utilization

M@ Evenk Frame Templates

Name: Gas Turbit
Description:
Categories:

) Expre

Analysis Type: O Ep

() sQC

[ Enable analyses when

Event Frame Template: | Gas Turbine Tel ﬂ

E Model Templates
Generation Mode: | Explicit Trigger n
[#- ', Reference Types

- =g 3as Turbine Temperatu
B Transfer Templates
[ Tables Add... VI

- = Inactivity Example Element:  CENTRAL'\Albertsvill\GAQO1
(- @ Enumeration Sets
— % Table Connections

- ession True for Sewverity
= Cl Zategories Variable

(&1 Analysis Cateqaries Start Trigger
Attribute Categaries ) *Exhaust Gas Temperature - #1 Prob )
Element Categaries End Trigger

[ Motification Rule Categories Output Expression |)2ust Gas Tempersture - #1 Probs’ - )
Reference Type Categories -

Table Categories B Start triggers

StartTriggerl |IF (AvgTemp-Abs(DeltaTemp/2))/AvgTemp | Set (optional) H

Enter the expression
EventFrame("Duration")

Map the output to the Duration attribute

Add... w

MName Expression True for Severity Dutput Attribute

B Variables

AvgTemg Avg('Exhaust Gas Temperat ®
DeltaTemp 'Exhaust Gas Temperature ®

B Start triggers

StartTriggerl |IF (AvgTemp-Abs(DeltaTemp|Set (optional) | None =

Bl Outputs at close

Outputl EventFrame("Duration™)

Map

®

MNew Attribute Termplate

=) Curation

heduling: (@) Event-Triggered (7 Periodic

igger on | Any Input

Chnener:PISCHOO vstudent

Gi Exhaust Gas Temperature - #1 Probe
@ Exhaust Gas Temperature - #2 Probe
G Gas Fuel Flow

& Gas Fuel Pressure

Gl Gas Turbine Speed

e
[

[} Technology
@& Unit Status

@ OSlsoft.
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Set the scheduling to Event-Triggered and triggering to Any Input.
Scheduling: (@) Event-Triggered ) Periodic

Trigger on | Any Input v

Evaluate and preview the results to confirm there are no syntax errors.

From the Analyses plug-in, backfill event frames for the past seven days for all Gas Turbine
Temperature Anomaly analysis templates.

Management Analyses
Choose a type 10 total analyses selected (10 on this page) 1-100f10 | < | = op
(@) Analyses
" Notification Rules Status @ B  Element Name Templd | Enable | Disable selected analyses
- [v] H CENTRAL\Carbondale\TCEDS Gas Turbine Temperature Anomaly Gas Tu! Enable | Disable automatic recalculation for selected

Analysis Searches V] |  CENTRAL\Carbondale\TCBOS Gas Turbine Temperature Anomaly Gas Tuf | analyses
+ X [v] H CENTRAL\Carbondale\TCED4 Gas Turbine Temperature Anomaly Gas Tu! Backfill/Recalculate selected analyses
All - [v] H cENTRAL\Carbondale\TCED3 Gas Turbine Temperature Anomaly Gas Tu!

V| CENTRAL\Carbondale\TCE02 Gas Turbine Temperature Anomaly Gas Tu! Start | =-7d o=
Enabled - i

(] |+ CENTRAL\Carbondale\TCEOL Gas Turbine Temperature Anomaly Gas Tu! End |* lu:ll

i H
Disabled > (] |+ CEMNTRAL\Beryl Ridge\BCUOZ Gas Turbine Temperature Anomaly Gas Tu! )
Average Utilization v ) |+ | CENTRAL\Benyl Ridge\BCUOL Gas Turbine Temperature Anomaly Gas Tu W[‘F’t:ehw'd "}':t_d‘? ;f:c: “:l;iflllg_ data?
i ave existin and fill in gaps
Generating Efficiency P o H CENTRAL\Albertsville\GAOD2 Gas Turbine Temperature Anomaly Gas Tu Y 3 " ielet - dagt > d recalculats
L - (@) Permanently e existing data and recalculate
Total Hourly Gross Generation ; o | CENTRAL\Albertsville\GAOO1 Gas Turbine Temperature Anomaly Gas Tu [] Recalculate dependent analyses
Utilization ra | Frere
Gas Turbine Temperature Anomaly ra
Recalculation will permanently delste all the
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8.2.2 Exercise - Detect Inactive Units

need assistance during the activity.

Objective:

Engineering would like to perform a deeper analysis into events over the past week
in which the generating units are inactive. Configure the event frame generation to
automatically capture new events and detect historical events.

How many inactive events have been occurring?

Approach:
o Open up the UNIT Element Template from the Fleet Generation Database
Library.
¢ Add a new analysis called Inactive Units with analysis type of Event Frame
Generation.

Specify the event frame template: Inactivity.

Define the trigger condition to automatically detect inactive events.
Add an Output Expression using the EventFrame(“Duration”) function.
Verify data.

Backfill for the past seven days.

This solo or group activity is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you

n'/--
/
.
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8.3 Discussion

This is a discussion designed to maximize learning in a specific topic area.
Your instructor will have questions, and will prompt for communication within
the class. This is an open-ended section and the result depends on your
needs.

Objective: Brainstorm some real world uses for event frames at your own company.
Event frames can be used to capture duration and summary information for events
such as process excursions or downtime, but how would this be implemented in your
workplace?

Approach

¢ What kinds of events are of interest in your own process?
e Can you think of reliable trigger conditions?
o Do you have all the required data to identify these events?

Estimated Completion time 10 minutes.
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9 Analyzing Events

9.1 Objectives

Pl Event Frames are stored in Pl AF databases. These event frames can be viewed,
filtered, analyzed using PI tools such as Pl System Explorer, Pl Vision, and PI
DataLink.

9.2 PI Event Frames in Pl System Explorer

The easiest way to view PI Event Frames is through PI System Explorer. From the
Event Frames Pane, you can perform searches against all the event frames within
an AF database. You can filter based on specific referenced elements, specific time
ranges, and much more.

(7 Elements

|== Event Frames
i Library

rm Unit of Measure

44 Contacts
% Management

From the properties of an Event Frame Search, you can specify the following search
parameters for the time of the event frame, and the properties of the event frame:

Search type: Specify how to perform an event frame search. Find all event frames
that are entirely between a start and end time? Starting or ending between a start

and end time?
Search start: Specify the start time for event frame search.
Search end: Specify the end time for event frame search.

Include descendants: Search for all child event frames in addition to parent event

frames.

f‘() OSlsoft.
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Search: |.ﬁ.ctive Between v| |:| In Progress

Search start: |*-3|:||:| "EHZI all Descendants
Search end: |*+1':| "EHII |Cu5tnm V|

Event Frame Name: Filter based on the name of an event frame. Can use

wildcards.

Element Name: Filter based on the name of the referenced element. Can use

wildcards.
Template: Filter based on the event frame type.

Additional Criteria: Ability to filter based on duration, attribute value, event frame

search root, and specify how many results to return.

Mame: [*Gas Turbine Temperature Anomsly™ | % analysis Name: | | x
Element Name: | | % Catagory: [<ai> V] x
Template: | <all> v] %
Duration: [ 5= |[oo:ooon [=] =

s Add Criteria ™

The resulting search query is combined into a string within the search field. This
allows for direct manipulation of the data fields without using the menu options.

Event Frame Search -

‘Durat\on:>=tl Marne:"*Gas Turbine Temperature Anomaly™" SENERAL v || Search |

Criteria £
search: [ nProgress
Search start: |Z| All Descendants
Search end: |*+1d ||E|| » | ‘Custnm v|
hlame: [Gas Turbine Temperature Anomaly* | % analysis ame: | | %
Element Name:  [G4* | % category: [an ] *
Template: [<an= v] x
Duration: | = HUD:DU:UD |U X
Fa Ao Criteria v

Results S

aroup by: [ ] Category [] Template

&5 3] & Name 8 [1,08:10:02] . |Duration Skart Time < End Time {S5e ™
o % = Albertsvile GAGO1 Gas Turbine Temperature Anomaly ... H 44000 82002018 3:23:03 PM glzofzoig &,

o & == Albertsvile GAGOZ Gas Turbine Temperature Anomaly ... H 9:30:00 8/20/2018 3:23:03 PM 8212016 12:...

o = Albertsvile GAOD1 Gas Turbine Temperature Anamaly ... H 4:45:00 8/20/2018 2:08:03 PM gi21f2018 121,

o = Albertsvile GAGOZ Gas Turbine Temperature Anomaly ... H 44500 8/21/2018 12:58:03 AM 8f21J2018 5:4... =
o & == Albertsvile GAGO1 Gas Turbine Temperature Anomaly ... H 440:00 8/21/2018 1:03:03 AM 8f21/2016 5:4... :
= & = albertsvile GAOD1 Gas Turbine Temperature Anomaly ... H 4:45:00 8/21/2015 5:46:03 AM 8f21f2018 10,

m b= Albertsvile GACDZ Gas Turbine Temperature Anomaly ... H 4:45:00 8/21/2018 5:48:03 AW 8[21/2015 10:...

o = Albertsvile GAODZ Gas Turbine Temperature Anamaly ... H 4:45:00 8/21/2015 10:33:03 AM gi21f2018 3:2...

o = Albertsvile GAGO1 Gas Turbine Temperature Anomaly ... H 44000 8/21/2018 10:43:03 &AM glz1jz01e 32,

m f= Albertsvile GACD1 Gas Turbine Temperature Anomaly ... H 4:45:00 8/21/2018 3:28:03 PM 8l21/2018 &:1...

o = Albertsvile GAODZ Gas Turbine Temperature Anamaly ... H 450000 8/21/2018 2:33:03 PM giz1fz01e 2., o
< m ' >

The search Found &6 Event: Frames matching the attribute criteria with 14 attributes matching the value criteria.

Ok ‘ | Cancel ‘ | Reset
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The default search results bring back fields detailing the duration, start time, end

time, description, category, template, and a Gantt chart. Any of these fields can be

hidden by using the settings cog on the top right corner of the search results.

Additionally, values from the event frame attributes can be pulled back into the
search results through this same option list.

Seorch Event Frames oo
Select Attributes -

Group by: [] Category [ ] Template

® add Attributes From Template: ‘ g Gas Turbine Temperature Anomaly ] ‘
" = —
Category Severity Templets Primary Element & | () Add Attributes from Event Frame: ‘Albertsville GAODZ Gas Turbine Temperature Anomaly 2018-05-20 15:23:03 " pel H |
Hane Ges Tu[[ 1s Template
Mone sasTul s Locked Cthers: ‘ Enter 8 semicon separated 5t of names fo ure aF atéribube cokmnz: ‘ EH Add ‘
" Gas T Is Annotated
one o] . Attribute Templates: Attributes:
Nene cas Ty s Mot Acknowledged
Hone Gas m. Marne Gas Turbing Temperature Anomaly Group by: [_] Category =1 Duration
Mone Gas Tu. Gantt e o - whaust Gas Temperature - #1 Pr... ’
None GasTu . Duration whaust Gas Temperature - #2 Pr..,
Mone Gas Tu. Start Tirme Name | Description o | as Fuel Flow ;
None sas Tyl End Time < Duration ; Gas Fuel Pressure o~
Hone Gas Tu. Cescription Exhaust Gas Temperature - #1 Probe Exhaust Gas T... i GashTu:blne Speed
Cat; =1 Technology
Hane 25 Tu. sy 6§ Exhaust Gas Temperature - #2 Probe Exhaust Gas T... =1 Uni
Mone: Gas m. Sewerity Z1 Unit Status
Mo cosTull] Templats & Gas Fuel Flow Gas Fuel Flow
Mone GasTu . Prirmary Elernent. CE Gas Fuel Pressure Gas Fuel Press...
Creation Date & Gas Turbine Speed Gas Turbine 5...
Wadify Dat:
oy Date =@ Technology
Select Attributes...
e

y
If
]
{

| &
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9.2.1 Directed Activity — Search for Inactive Events for GAOO1

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

Find all Inactive events for the unit GAOO1 and GAOOQO2 over the past 24 hours.
Examine the technologies that are involved in these inactive events.

Approach:
Click on the event frame plug-in. Right-click on Event Frame Search 1 and select Properties.

3

File  Search  View Go  Tools  Help
@Datahase [ Query Date - (0 @ OEack H,r Checkln %3}

Ewvent Frarmes Ewent Frame Search 1
= I-Ld Event Frame Searches
= e Search L
: ErLsvi _
S —. Mewe Attribute Search |
o f] 1Bt sl f=| Mew Event Frame ho
o o] 1 bepE sl
o p={ Albertsyilll .+ Create or Update Data Reference PO
: F\:I;ertsvi:: #  Capture or Recapture Values,., po
albertswi
oo [ 1l biartsvill (R, Categorize... i
e =] bt vill Arrange B 3 o
o = Albertswil = Ao
o b Albertsvill ]  Refresh a0
e e 1= g | Past
o f] it sl e po
<o b=t bertsill L nart from File.. po
It_d Recent Event Fram .
= =7 Transfer Searches IE SEOR D {2 ro
- =9 TransFer Seard
< “a Copy e
& Sawe po
7 Delete... po
Renarne o
X Delete Al
g Securiby..
Hﬁ Properties
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From the Event Frame Search screen, specify the search start to “*-1d”, end to “*”, and uncheck
the “All Descendants” checkbox. For the Element Name textbox, specify GAOO? and set the
Template to Inactivity.

Event Frame Search -

Duration: =01 Elementhame:GA0N? AlDescendsnts:False TR GERITE] % = Search |

Criteria B
Search start: [] Al Descendaris
Searchend: [* [E=[*] [past oy v]
Hame: [ | % analysis ame: | | =
Element Mame: [GAGO? | % category: [<at v] x
Template: [Inactiity ] x
Duration: [ 5= ][o0:00u00 [=] =
%, ndd riteria ¥

Restilts B

Group by: [ | Category [ | Templake

‘E (8] & Mame Gantt Duration Start Time 4/ End Time DescSiti
|

The search will return several inactive event frames. Select all of them and click on OK.

Click on the gear icon to the right of the fields, and remove the description and category
fields. Then click on “Select Attributes.”

Select the Technology attribute from the Select Attributes wizard.

Select Attributes -

® Acid Attributes from Template: | FgInactivity v

) Add Attributes from Event Frame: |A\henswue GAOD! Inactivity 2018-08-20 21:00:00 H Fel H ‘
Others: |Ent&f 5 semiolon separated st of names to use as atinbute colmns: |m ‘ Add |

Attrbute Templates: Attributes:

Inactivity aroup by: [ Catenory | 1 Technology

Ater IR

Name | Description G ‘

B

= Carbon Emissions

& Demand

&7 Duration

= Hours Dowin

= Operatar

=3 Technology i |
7 Tokal Demand

7 Unit Status

EIEIS

Examine the Technology that is leading to the downtime for these Inactive Units.

o
If
]
{
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Ewent Frame Search 1

Group by: [ | Category [ | Template

Fittar 2
8..[23:50:00] ... |Duration Start Time End Time Severity Template Primary Element | | Technology @ | -~

018-08-20 21:00:00 ! 0:10:00 8/20/2018 9:00:00 PM 8/20/2018 9:1... |None Inackivity GACDL Matural Gas

-D-i-ﬂ:a-s-:éﬂn2-1“0-ﬂ-0“0 --------- I 0:10:00 8/20{2018 9:00:00 PM 8/20{2018 9:1... |Mone Inackivity GAOOL Matural Gas

013-08-20 21:50:00 0:10:00 8/20/2018 9:50:00 PM 8/20/2018 10:... |Mone Inackivity GACOL Matural Gas £

0138-08-20 21:50:00 0:10:00 §/20/2016 9:50:00 PM §/20/2013 10:.., |Mone Inackivity GACOL Matural Gas

018-08-21 00:10:00 0:10:00 8f21/2018 12:10:00 AM g/21/2018 12:... |Mone Inactivity GEACOL Matural Gas

OER-N R Ty PR N ety M mnn TR L R - IE Ee TR R TYa e I 1 ) allanio 19, Pl T —rkivibi lat:talat] LY v

9.2.2 Exercise — Search for Recent Temperature Anomalies

Objective:

In this part of the class, you will perform a learning activity to explore the

different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.

You may play a game or hold a quiz. Your instructor will have directions.

Find all temperature anomaly events for the gas turbines over the past 48 hours that
last for more than one hour. Add columns for Fuel Gas Pressure and for each of the

two gas temperature sensors.

Which unit has the highest starting Gas Fuel Pressure during a temperature anomaly,

and when was it?

Approach:

Perform an event frame search and format results for the desired attributes.
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9.3 Pl Event Frames in Pl DataLink

PI DataLink allows you to retrieve current, historical, and calculated data back into
Microsoft Excel. In addition to these capabilities, Pl DataLink also allows for the
retrieval of event frames back into Excel for further analysis.

FILE HOME IMEERT PAGE LAYOUT FORMULAS DaTa REWIE Y WIE ADD-IME Load Test PIDATALIMNE

- = < @ 2 st
Be % OEE %~ QB 5 @ 2

= = L) About
Current Archive  Compressed Sampled Timed  Calculated  Time Explore Compare  Search Asset Properties  Update

Walue  Walue = Data ~ Data~  Data Data~  Filtered ~ - - - Filter &) Help

Single Walue Multiple YWalue Calculation Events Search Properties  Update Resources

There are two retrieval methods for Event Frames inside of Pl DataLink:

Explore: Find Event Frames that meet the specified criteria and display them in a
hierarchical format, which is useful to analyze events sharing the same EF template.

Event name Start time End time Primary element ReasonCode ShutDownType
BoilerShutDown.5.20130403.1  03-Apr-13 18:00:00 03-Apr-13 19:00:00 Boilers P Planned
BoilerShutDown.5.20130404.1  04-Apr-13 18:00:00 04-Apr-13 19:00:00 Boilers P Planned
BoilerShutDown.5.20130404.2  04-Apr-13 22:04:00 04-Apr-13 23:31:00 Boiler3 E Emergency
BoilerShutDown.5.20130405.1 05-Apr-13 18:00:00 05-Apr-13 19:00:00 Boiler3 P Planned

Compare: Find Event Frames that meet the specified criteria and compare their
attributes in a flat format. This allows a flat list of events with attributes relating to
child events all within a single row.

Turbine Startup Child
Events

Parent Events ‘4\

\Phasel| .\Phase2| .\Phase3| .|Primary

.| Event-pame .|Event template .|Starttime .|End time .|Duration Duration Duration Duration element
urbineStartUp.3.3 TwrbineStartUp 03-Mar-14 18:16:00 03-Mar-1419:29:00 01:13:00 00:30:00 00:27:00 00:28:00 Turbine3
JurbineStartUp.5.3 JdrbineStartUp 05-Mar-14 06:01:00 05-Mar-1408:33:00 02:32:00 00:58:00 00:40:00 00:53:00 Turbine5

For either the Compare or Explore Events, you can specify parameters to search for
specific event frames. You can specify the following:
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Database: AF Database to search against.

Event Name: Search pattern to search for specifically named event frames.
Search Start: Search for all event frames that occurred after this time.

Search End: Search for all event frames that occurred before this time.

Event Template: Search for specific types of events.

Element Template: Search based off of the type of referenced element.
Element Name: Search pattern for the name of the event frame.

More search options: Search based on attribute values, duration, and category.

Number of child event levels: Only for “Explore Events” and allows for the

hierarchical display of events.

Explare Events v

Database Ewvent name
W ALMUTAFleet Generation

Search start Ewent template
: B[
Search end Elemert name

Element template

Lirnit to database level " —
SE]
More search options
Preview
l'j Ewents (1000 found - maimum reached) -

4 b={ Gas Temperature Anomaly 20140813 06:46:51
+ [=={ Gas Temperature Anomaly 20740873 06:46:51
+ [=={ Gas Temperature Anomaly 20740873 06:46:51
1 ] Gas Temperature Anomaly 20140813 06:46:51
- ={ Gas Temperature Anomaly 20740873 06:46:51
- ={ Gas Temperature Anomaly 20740873 06:46:51
- p={ Gas Temperature Anomaly 20140813 06:56:51

b o Towhin T b 101 ANDH 3 0N

O N e Y e W

Columns to dizplay

Select al

| Event name T
| Start time:
V| End time

| Duration

Vv

v

‘X|1—-b

Event template
Frimary element
Frimary element path
Element template

1
®

Mumber of child event levels Output cell
1 - ‘Sheet!1$431

0K, | [ Apply
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Searching for event frames can be based off multiple attributes.

Attribute value filters

Attrbute Operator  Walue
[Teu:hnu:ulu:ug_l,l - [= * | Matural Gas
[Gas Fuel Preszsure - [>= - | &0l

When searching with Explore Events, the results can be displayed hierarchically
based on the relationships between child and parent event frames.

Event name Child 1 Start time End time Duration
Gas Temperature Anomaly 20140813 11:16:51 8/13/1411:16 &0 8713714 11:51 &AM 0,024306

Gas Temperature Anomaly 20140813 11:16:51  Root Cause 8/13/1410:46 &AM 8/13/1411:16 &0 0.020833

To return more than 1000 event frames in the search preview, go to Settings in the
ribbon. Change the setting to 10,000 Event Frames.

Pl Datalink

at you want to do..,

(===
Y H oy q E% % About
: o . . Help
Time Explore Cormpare  Search Asset  Properties  Update  [Settings
ltered = - - - Filter Feedback
a1y} Ewents Search Praperties | Update Resources
Settings

[] Diisplay #M /4 instead of blanks
[] Locale independent
[] Dizable automatic task pane display on click
[] Dizable "Resize to show all values" message
Time stamps in
®) Clignt time zone
) Pl Data &rchive time zone

() UTC time zone

Copy tems to sheet

[ Copy Pl Data Archive name [Legacy add-in only)

Murnber format

|Genera|

Tirne formnat

|dd-mmm-_l..ly b 5

M aximun event count

[ 10000

b awimum filter search count

[10000

Automatic update
®) Calculate F9)
() Full calculate [Chil+Alt+Shift+Fd)

Interval [secondsz] - Enter O for automatic

[0

Connection Manager... 0k | | Cancel |
74
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9.3.1 Directed Activity — How many temperature deviations occurred?

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

Temperature deviations could potentially mean damaged machinery. Engineering is
interested in analyzing the Natural Gas units. Find out how many instances of
temperature deviations occurred for gas turbines that lasted for more than 30 minutes.

Approach:
From the PI DataLink tab in of Excel, select cell A1 and click Compare in the ribbon.

Home Insert Page Layout Faormulas Iats Wiy Pl Datalink

— — 'i:-x:___:’"

BnE & @ 7 o || QB E

= B
Current Archive  Compressed 3ampled Timed  Calculated  Time Explore Compare  Search  Asset  Propertie
Walue ‘Walue - Data - Data = Data Data = Filtered - - - - Filter

Single Walue Multiple Walue Calculation Events Search Propertie

Specify the Database as \\PISRV1\Fleet Generation, Event name as “*”, Search start
as “*-1d”, and Event template as “Gas Turbine Temperature Anomaly.”

Compare Events M
¥
Databaze Ewent namne

|\WPISRVOT\Fleet Gereration | : |

Search start Ewent template
*1d | | Gaz Tuhing Termperature Anoma |
Search end Element name

) |

[ ] Limit to databage lavel

Element template

: v|E]
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From More Search Options, set the minimum duration to 30 minutes.

IZI Mare zearch optiohs

Ewent category Search mode

" V| |a|:tive in range V|
kinimum duration Sort order
|3Elm | |start time azcending Vl

Select the columns that you would like to display:

Columns to digplay

[m] Select all

ADwration I |I|

|E=hauzst Gas Temperature - #1 Probe

|Eshauzt Gas Temperature - #2 Probe

AGaz Fuel Flove |X|

IGas Fuel Pressure
AGaz Tubine Speed

AT echnology

| & K] &) & ] &] &][&]
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9.3.2 Exercise — Analyzing Inactivity

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

Inactivity events can be costly as the generating units are not generating any power.
Analyze with Pl DataLink the total number of Inactivity events as well as the total
amount of time the units were in an Inactive state for the 24 hours.

Which generating unit had the most downtime events? Which generating unit had the
largest total downtime?

Approach:

Use PI DataLink to search for Pl Event Frames and specify which attributes to return. Use Excel
to aggregate the events.

y
vf
]
{
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9.4 Pl Event Frames in Pl Vision

PI1 Vision enables you to view and analyze your Pl data during the time range of a
particular event. For example, you may want to examine the performance of an asset
during an operator shift or compare the data for several assets during a downtime
period.

M E B o= 0 & B

'8

I:‘ Automatically refresh the list

Downtime-Storage Tank2_2018-01-31 21:49:5_ .
1/31/2018 9:49:50 PM - 1/31/2018 10:01:55 PM

I Downtime-Storage Tank2_2018-01-31 20:46:3. .
| Downtime-Storage Tank2_2018-01-31 19:44:1_ .

[ Create Events Table O Edit Search Criteria

To view events, open the Events tab on the left side. Here you will find events related to your
process, the color to the left of each event indicates its severity. By default, the time range of the
display and the context of the symbols in the display determine what events are shown in the
Events list in PI Vision. To discover additional events, modify the time range or choose Edit
Search Criteria. When you edit the search criteria, there are a number of filtering options to find
the Event Frames you are looking for.

Edit Search Criteria

» Database 05lsoft Plant
» Time Range Timebar Duration
» Event Severity

» Event Name

» Event Type and Attribute Value

» Asset Name Assets on Display
» Asset Type

» Event State

» Event Category

» Event Acknowledgment

» Event Comments

» Event Duration

» Number of Results

» Search Mode Events Active in Time Range

[ |Retum All Descendants

Apply | | Reset | | Cancel
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You can select an event to find its Data Items (event attributes) and its start and end time.

Downtime-Storage Tank2_2018-01-31 19:44:10.000
1/31/2018 7:44:10 PM - 1/31/2018 8:02:03 PM

[ Create Events Table O Edit Search Criteria

Attributes

Downtime-Storage Tank2_2018-01-31 19:44:10.000
Event Duration (minutes): 17.883 min

I
4

Lost Production (gal): 2,474.9 US gal
Maximum External Temperature: 237.32 °F
Maximum Internal Temperature: 13055 °F
Reason Code: Mechanical

Temperature Difference: 90.794 delta °F

) Storage Tank2 b3

By right clicking on an event, you can choose Apply Time Range apply the event’'s
time range to the display.

Downtime-Storage Tank2 2018-01-31 20:46:31.000
1/31/2018 8:46:31 Apply. Time Range

I Downtime-Storag Eveni%etails

ER Create Events Tall Compare Similar Events by Name
m Compare Similar Evenis by Type

Attribute
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9.4.1 Directed Activity — Inactivity Events in PI Vision

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:
Visualize Inactivity Events using Pl Vision.

Approach:
Create a new PI Vision display. Drill down to asset GAOOL1 in the Fleet Generation database

Trend the Exhaust Gas Temperature Probes for the past 24 hours.

O piVision
Assels

EEEBE =0 k&

Attributes

Carbon Emissions
B Exhaust Gas Temperature - #1 Probe
[E Bxhaust Gas Temperature - #2 Probe

Click on Events in the top left and check “Automatically refresh the list”. By default, this will load
Event Frames for Assets on the display (in this case Turbine GAOO1).

O Pl vision
@ Events

H@Bﬁﬂ‘mm
=

Al

I | Automatically refresh the list I

Albertsville GACOT Inactivity 2018-08-21... > I
8/21/2018 10:30:00 PM - 8/21/2015 10:40:00 PM
Albertsville GADDT Inactivity 2018-08-21... >
Albertsville GACOT Inactivity 2018-08-21... 3
Alhertsville GACO1 Gas Turbine Temperatur...
Albertsville GACO1 Gas Turhine Temperatur...
Albertsville GACOT Inactivity 2018-08-21... 3

Albertsville GACOT Inactivity 2018-08-21... 3
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Right-click on one of the Inactivity Events and select Apply Time Range. The time range will
be applied to the temperature trends.

Right-click on one of the Events and select Compare Similar Events by Type. Trends of the
Event Frame trigger attributes for the selected Event Frame and 10 recent event frames will be

shown.

O I;I‘H\;ision
@ Events

Automatically refresh the list

® Albertsville GAOD1 Inactivity 2018-08- ..
8/22/2018 1:40:00 PM - 8/22/2018 1:50:00 PM

* Albertsville GAQD1 Inactivity 2018-08-..
¥ Albertsville GAQD1 Inactivity 2018-08- ..
A Albertsville GAQD1 Inactivity 2018-08-...
¥ Albertsville GAOO1 Inactivity 2018-08- ...
O Albertsville GAQD1 Inactivity 2018-08-..
© Albertsville GAQD1 Inactivity 2018-08-..
0 Albertsville GAQD1 Inactivity 2018-08-..
A Albertsville GAOO1 Inactivity 2018-08- .
V Albertsville GAQD1 Inactivity 2018-08-...
* Albertsville GAQD1 Inactivity 2018-08-...

O Edit Search Criteria

Aftributes

Albertsville GAQD1 Inactivity 2018-08-22 13:40:00

Carbon Emissions: 405 g/kWh
= Dernand: 172.81 MW
Duration: 600 s

Hours Down: 0.16667 h

F=l A mimbmi DO

v ¥V ¥V VvV vV vV Vv Vv Vv

>

Display: Click Save icon™

- Exhaust Gas Temperature - #1 Probe {°C) X

10m

+ & Albertsville GAOO1 Inactivig 2018-08-22 13:40:00
+ © Albertsville GAOO1 Inactivig 2018-08-2212:10:00
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Edit Search Criteria to compare 100 Inactivity Events for All Turbines:

Edit ria
» Database Fleet Generation
* Time Range Custom Time Range

» Bvent Severity

» Event Name

» Event Type and Attribute Value Selected

¥ Asset Hame Any

Ay

| Specify Name

» Asset Type

» Event State

» Event Category

Event Acknowledgment
» Event Comments
» Event Duration

¥ Number of Results Humber of Most Recent Events 100

| All Events

o Mumber of Most Recent
_FEvents

100

Murber of Earliest Events 10

Search Mode Events Starting in Time Range

| |Return All Descendants

Apply | | Reset ‘ ‘ Cancel

144




Analyzing Pl System Data

Other attributes from the Event Frames can be trended, but instead we will trend attributes that
are not included in the Event Frame but are included in the Asset. In the Attributes Pane, drill
into the turbine:

Albertsville GACDT Inactivity 2018-08-22 13:40:00
Carbon Emissions: 405 g/kih

(=] Dermand: 172.81 MY
Duration: BOO s

Hours Down: 016667 h
Operator: BSK

= Technology: Matural Gas
[=] Total Demand: 27.847 Myh

Lnit Status: Inactive

) GAOD >

Then drag/drop the Fuel Gas Flow onto the trend area to add new trends

,OEditSearch Criteria

Attributes

Carbon Emissions: 405 /...

Exhaust Gas Temperatur...

Exhaust Gas Temperatur...

Gas Fuel Flow: 91.078 L.

Gas Fuel Pressure: 30.76...

Sas Fuel Flow

1

arm

+ & albertsville GAOO1 Inactiviﬁ

+ Stampton MMDO2 Inactivity

+ 0 Vickaberg MAMO1 InactiviEE

Tl
If
]
\

OSlsoft.
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Use the scroll wheel on the right to scroll down and see the new trends

O Fé'lvbi;ision

@ Events Display
}’EVU' _—
Automatically refresh the list

@ Albertsville GAOO1 In...
8/22/2018 1:40:00 PM - 8/2...

# Stampton MNDO2 Ina...

¥ vicksberg MAMO1 Ina...

A Vicksberg MAMOZ Ina...

¥ Beryl Ridge BCUO1 In... S i —
] 10m

O Carbondale TCBO2 In...

Gas Fuel Flow (US galimin) X

100 H

O Edit Search Criteria

Attributes

Carbon Emissions: 405 gf...

Exhaust Gas Temperatur...

[
Exhaust Gas Temperatur... + & Albertsville GAOD1 Inactivity 2018-08-22 13:40:00
Gas Fuel Flow: 91.079 U... + © Stampton MNDO2 Inactivity 2018-08-22 13:40:00
Gas Fuel Pressure: 30.76... I + © vicksherg MAMO1 Inactivity 2018-08-22 13:40:00
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9.5 Discussion

This is a discussion designed to maximize learning in a specific topic area.
Your instructor will have questions, and will prompt for communication within
the class. This is an open ended section and the result depends on your
needs.

Objective: Event frames can be difficult to grasp at first. Let’s repeat the discussion
from the previous chapter now that you’ve seen some examples. Brainstorm some
real world uses for event frames at your own company. Event frames can be used to
capture duration and summary information for events such as process excursions or
downtime, but how would this be implemented in your workplace?

Approach

o What kinds of events are of interest in your own process?
e Can you think of reliable trigger conditions?
¢ Do you have all the required data to identify these events?

Estimated Completion time 10 minutes.

y
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10 PI OLEDB Enterprise SQL Queries

SQL stands for Structured Query Language. SQL is an American National Standards
Institute (ANSI) definition for the language used to communicate with relational
database systems. It is used by virtually all relational databases in the world today.
(Even the PI Data Archive has a SQL Subsystem that can act as a translator to make
it “look” like a relational database). SQL Commands are often called “SQL
Statements.” They can be executed interactively or as stored procedures.

The good part is that it is a standard and that every relational database you
encounter will understand it. There is no need to learn many languages. However,
there is a down side. Most databases have unique extensions and/or syntaxes that
are unigue to those systems.

To give a simple example, when passing dates into Access you use pound signs (#)
for surrounding dates. On the other hand, in SQL Server you need to use
apostrophes ().

Access: [...] WHERE dtColumn >= #2001-11-05#
SQL Server: [...] WHERE dtColumn >='20011105'

A SQL result set is a set of rows from a database, as well as meta-information about
the query such as the column names, the data types and sizes of each column.
Depending on the database system, the number of rows in the result set may or may
not be known. Usually, this number is not known up front because the result set is
built on-the-fly.

This flexibility allows for complex queries to be constructed and saved to return a
very specific subset of information from the AF Database that would be either too
cumbersome or impossible through the likes of PI System Explorer or PI Datalink.

Trivia: The result is stored in a result table, called the result-set. This table is held in memory.

This is often referred to in code as rs.

10.1Dissecting the Syntax

A common SQL syntax starting command is SELECT which is used to query the database. The
data retrieved from the statement is based on the criteria specified in the SELECT statement.

Following the SELECT command identifies the columns to be selected from the tables(s).
SELECT * - retrieves all the columns from the table being referenced.

SELECT columnl, column2, column3 — retrieves 3 columns of the table being
referenced.
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The FROM command identifies the first (or perhaps only) table being queried.
SELECT * FROM tablename - retrieves all the columns from tablename.

SELECT columnl, column2, column3 FROM tablename — retrieves all data for the 3
columns of tablename.

The WHERE command contains criteria to filter the data being retrieved.
The conditional operators include:

equal (=)

greater than (>)

less than (<)

greater than or equal (>=)

less than or equal (<=)

not equal to (<>)

LIKE (which is a pattern matching operator)

Note: If the conditional clause is set to compare to text, the text value is encased in single
quotes (‘text’).

SELECT * from tablename WHERE columnl =5

Retrieves only rows where columnl has a value equal to the number 5.

AND and OR statements

¢ AND indicates both statements must be TRUE for the row to be returned
when the query is executed.

o SELECT columnl, column2, column3 from tablename WHERE
columnl =5 and column2 = ‘junk’

o Retrieve only rows where columnl has a value equal to the number 5
and column2 value equals junk.

e OR returns data rows if either condition is met

o SELECT columnl, column2, column3 from tablename WHERE
columnl =5 or column2 = ‘junk’

o Retrieve only rows where columnl has a value equal to the number 5
or column2 value equals junk.
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The LIKE operator is used to search for a specific pattern in a column. In conjunction with the
LIKE operator a wildcard of % is used for comparison. The % can represent a single character
or multiple characters. Another wildcard is the underscore (_) which can be used to represent a
single character.

SELECT * from tablename WHERE column2 LIKE ‘Y%unk’

Retrieves rows from tablename where column2 values end with the letters ‘unk’
SELECT * from tablename WHERE column2 LIKE ‘%un%’

Retrieves rows from tablename where column2 values contain the letters ‘un’

SELECT * from tablename where column2 like * un__

Retrieves rows from the tablename where column 2 values only contains 4
characters and the middle two characters are un.

SELECT * from tablename WHERE column2 LIKE ‘j%’

Retrieves rows from tablename where column2 values start with the letter j’

To work with column/table names which have special characters, such as a space, use square
brackets:

If you wish to SELECT a column called Product Orders, enclose it in square brackets: [Product
Orders]

If you're referring to a table whose full path is Fleet Generation, Region, Station, Unit, that must
be written as [Fleet Generation].[SouthEast].[Brick Canyon].[PLT02]

Any name may be wrapped in square brackets, so when in doubt as to what constitutes a
special character, wrap the name in square brackets.

10.2P1 OLEDB Provider or Enterprise? What’s the difference?

P1 OLEDB Provider is an OLEDB data provider that provides access to the PI
System. Given the correct security, the PI OLEDB Provider allows read/write access
to the PI System Archive.

P1 OLEDB Enterprise is an OLEDB data provider which provides access to the PI
System in a relational view, accessible through SQL queries. The Pl OLEDB
Enterprise provider supports read-only access to asset and event data stored in the
Pl Asset Framework (AF), such as AF Elements, AF Attributes and Pl Event Frames.

Both data providers can be called by using the PI ODBC via a SQL DAS server to
allow remote query execution, minimizing the required software to be installed and
configured on endpoint machines.
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10.2.1 PI SQL Commander

The PI OLEDB Enterprise installation includes a test environment which handles the
OLE connection process and allows the user to execute queries and perform other
tasks. This test environment is PI SQL Commander.

Pl SQL Commander is the user interface to assist with creating queries, transpose
functions, and views against Pl AF using Pl OLEDB Enterprise. This user interface
also provides access to the classic Pl OLEDB Provider which builds queries against
the PI Data Archive components without knowledge of PI AF.

PI SQL Commander Lite is an application to navigate a relational view of the PI
System using SQL Queries that are exposed by Pl ODBC. This can be used to
create, edit, test and save SQL queries of Pl System data. It does not support the
more advanced functions found within Pl SQL Commander however, like transpose
value function creation, or view creation. Previously created transpose value
functions or views may be used however.
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10.2.2 Directed Activity — Review Predefined Queries

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

Review predefined queries associated with the tables defined in PI SQL Commander.

Approach:

e Open Pl SQL Commander
¢ Navigate to the Fleet Generation Database/Catalog
o Execute a Predefined Query associated with the Element Hierarchy table.

Launch PI SQL Commander -
Click Start > All Programs > PI System > PlI SQL Commander.

In PI SQL Commander, verify that your Pl SQL Object Explorer is visible. If it is not, click
View > PI SQL Object Explorer.

Through PI SQL Commander, either a Pl AF Server or a Pl Data Archive can be
accessed through SQL statements based on the item selected for connection.

From within the PI SQL Commander Object Explorer, connect to your AF Server, in
this example, PISRV1, by right-clicking Select Connect then select Windows
Integrated Security.

@ Pl SQL Commander Lite -[ax]
File Edit View Tools Help

2 Mew Query | ¥ EBxecute @ |53 53 &7 | @ Query Compendium

Object Explorer - X

El®e =N

4 | JJOLEDE Data Sources
4 (3P OLEDE Enterprise
| | PISRVT
| &7 | Connect | Provider
1

urces

3¢ | Disconnect

% Remove Server
g reegrenof for Business Analytics

J Fl Integrator for BA
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An arrow next to the server icon indicates that the connection is successful:

After connecting to the PI AF server, you will see a catalog list in the PI SQL Object
Explorer. The catalogs listed correspond to each of the Pl AF databases you have
configured for this Pl AF server. We will be using the Fleet Generation database
throughout this course.

@ Pl SQL Commander Lite
File Edit View Tools Help

= NewQuery | ¥ Execute @ |53 47 41| @ Query Compendium

= e Tl

Object Explorer * X
4 ,_1_| OLEDE Data Sources A
4 [P OLEDB Enterprise
4 | gHPISRVDT
4 | _JCatalogs
_J Configuration
_J Chstnbution Metworl
i | ) Flest Generstion
_J Flest Generation Sim

| _J MuGreen

Right-click an object in the catalog that represents a table, view or function, and then
select Execute Predefined Query.
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Pl OLEDB Enterprise includes one sample SQL query for each table in the catalogs for
Pl AF server.
= | PIsryt
= [dCatalogs

L:_l ACME Enterprises

l:J onfiguration

= l:J Fleet Generation

= [Assset
= [dTables

-ECategl:nry
=Element
ZdElementattribute
-EElement.ﬁ.ttrihute(:ategu:ur';.-'
-EEIementCateg-:ury
-EElementExtendedPererty
-EEIementHierarn:h';.f
EdElemertreference ¥ Execute Predefined Query. ..
-EEIementTemplate E Refresh

| _E FlemarntTermnlalan

HEFBMNEEHBMEBERK

This is the environment for building and testing PI OLEDB Enterprise queries.
Queries, written in the editor, can be executed with their results shown in the grid.

Upon selecting Execute Predefined Query, a query window will appear with a Select
statement for the ElementHierarchy will be developed.

-- Asset.ElementHierarchy table represents the current element hierarchy.
-- The table is part of the current time view of the asset hierarchy
-- (ElementHierarchy, Element, ElementAttribute, ElementExtendedProperty, and Elem¢
SELECT *
FROM [Fleet Generation].[Asset].[ElementHierarchy]
WHERE

Path = N'\' -- root elements

-- other hierarchy search criteria:

-- a) specific folder: Path = N'\abc\def\’

-- b) subtree: Path LIKE N'\abc\def\%'

-- ¢) level range: Level >= 5

‘| n 1

[ Results | 1y Messages

Path Name Level ElementiD ParentElement|D ReferenceTypelD
T\ SOUTHEAST | 0 574b614-54f6-4c28-b439-c68c4elbebe7 c3a4678bfb66-40f0-
20\ NORTH 0 fOccccad-8841-4335-9aal-7eeaf45aeedf c3a4678bfb66-40f0-
3|\ CENTRAL 0 440e2878-99¢7-44a4-afb 8-61cdOcef29d6 c3a4678bfb66-40f0-

SELECT *
FROM [Fleet Generation].[Asset].[ElementHierarchy]
WHERE

Path = N'\' -- root elements
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The above query does not yield all elements, just the elements at the Region level.

(Note: the “N” declares the path string to be Unicode, which permits lots of different characters.
It will be omitted throughout this document since normally we are only dealing with standard
ASCII characters.)

Modify the query to retrieve all the elements and hit Execute.

SELECT *
FROM [Fleet Generation].[Asset].[ElementHierarchy]

WHERE

Path like N'\%'

OR

SELECT *
FROM [Fleet Generation].[Asset].[ElementHierarchy]
Returns the same results.

[ Results | [ Messages

L I =0 T 5 B S R R X R

— = o Da
-

Path

\CENTRAL\
\CENTRAL'
\CENTRAL\
\NORTH?
\NORTH\
\NORTH\
\NORTH:
\SOUTHEAST:

MName
CENTRAL
NORTH
SOUTHEAST
Carbondale
Ben Ridge
Albertsville
MNew Bedford
Madison
Greenlawn
Ebbitt

Wolverine Station

Level EementlD

0
0
0
1
1
1
1
1
1
1
1

7805ed21-263d-45b-albb-d55eadc 2570
a43abdbd-df40-4005bc #-22958=73034d
edba7143-3d32-454b-8002-2 52441453551
8a152c08-c440-4255-9¢ 8=-baTafd445abb
c8572d05-16f0-45d0-a4aa-6235e 7lcdd
7 7d3cf83-3dbd-4b353-35ef -55cbfbcb010c
549ddf 1f-c857-4a98-89b0-254c 1b 20167
067c7347-9301-4629-8dec- 11053432603
cB6703c-6odf-4f94-h K 58258245614
35d3cal11-9a51-4c7a-beds-127d6cbdae e
1147332e-8872-45c(-84ba-3d34376426ea

ParentElement|D

7805ed21-263d-45fb-a0bb-d55eadc 2570
7805ed21-263d-45b-albb-d55eadc2970
7805ed21-263d-45b-albb-d55eadc 2570
a4Jabdbd-df40-4005-bc 223582 730344
a43abd6d-df40-4005-bc F-229582 73034
a43abd6d-df40-4005-bc F-22 558273034
a43abd6d-df40-4005-bc #-2a358e 73034d
edba/143-8d32-454b-8b (2252441458551

~

%

OSlsoft.
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10.3Table Aliases

Sometime table name or columns are lengthy or lack clarity. Using an ALIAS can simplify typing
and clarify table field names that are otherwise unclear. The “AS” command defines an ALIAS
for the item prior to the AS with the abbreviation following the command.

| SELECT eh.* FROM [Fleet Generation].[Asset].[ElementHierarchy] as eh

In the above statement, eh can be used to identify the table instead of the full [Fleet
Generation].[Asset].[ElementHierarchy] table name. Aliases become more significant when
creating joins.

10.4JOIN Statements

Rarely does data exist in one place or in one table. Sometimes the results of a query have to
come from a correlation of two or more distinct tables. To JOIN tables, a relationship is required
between the tables and must be identified in the SQL statement.

Within the joining operations, we want a result set than contains assets with useful information
from both tables, like performing a logical AND operation. There should be no gaps where a
match could not be found. This is called an INNER JOIN, and is the default joining operation
used by PI SQL Commander. Therefore, INNER JOIN and JOIN may be used interchangeably.
If we want to include these empty values, then an OUTER JOIN can be used, the equivalent to
the logical OR.

Two key words are used when creating joins between tables. The words JOIN and ON can be
used in the statement to identify the relationship between the tables being used. The key
word ON sets up the relationship of columns in the selected tables so the desired rows are
returned.

SELECT *

FROM [Fleet Generation].[Asset].[ElementHierarchy] as EH JOIN [Fleet
Generation].[Asset].[ElementAttribute] as EA

ON eh.name = ea.name

Returns no records. Below is a result of the next query, but shows the names in the tables are
not the same.

[ Results | [y Messages

Path Name Level Hem Pai Re Se« Ct Che Ct ID Path Name Level
1 \CENTRAL\Carbondale'. | TCBD6 | 2 631 8a|c3 |0 iR Total Net Generation D
2 “CENTRAL‘Cabondale | TCBOE 2 63 8s c3 O fif | Total Gross Generation 0
3 “CENTRAL\Carbondale’. = TCBOE 2 631 8 c3|0 LY Technology 0
4 \CENTRAL\Carbondale'. | TCBD& | 2 631 8a|c3 |0 iR Operator D
5 \CENTRAL\Carbondale\ | TCBDE 2 63t 83 1| 0 fif | Net Generation 0
6 ‘CENTRAL\Carbondale\ | TCBDE 2 631 8 3|0 LA Gross Generation 0
7  \CENTRAL\Cabondale’. | TCBD& | 2 631  8a|c3 |0 [ Generating Efficiency 0
8 “CENTRAL\Carbondale\ | TCBD& 2 63N 8 cd |0 | Effective Generating Capacity 0
9 “CENTRAL\Carbondale’. = TCBOE 2 631 8 c3|0 LY Daity Average Gross Generation 0
10 “\CENTRAL\Carbondale'. | TCBDG | 2 631  8a|c3 |0 [ Hourly Average Gross Generation |
11 \CENTRAL\Carbondale'. | TCBDG | 2 631 Bs|c3 |0 LR Demand D
12 N\CENTRAL‘Carbondale™ | TCBODE | 2 631 8 |c3|O [ Capacity 0
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Even though both tables have columns called names, they do not identify identical fields.

Note: Columns named the same are not necessarily referring to the same item. For example,
‘id” is a column that is frequently found in tables representing a unique identifier for the row, but
rarely do they refer to the same item from table to table.

However, the columns named ElementID in both tables are actually the same and return a
listing of all attributes for all elements defined.

SELECT *

FROM [Fleet Generation].[Asset].[ElementHierarchy] AS EH join [Fleet
Generation].[Asset].[ElementAttribute] AS EA

on eh.elementid = ea.elementid

SELECT
FROM [Fleet Generation].[Asset].[ElementHierarchy] as EH, [Fleet Generation].[Asset].[ElementAttribute] as EA
WHERE eh.elementid = ea.elementid

Path like N'\¥' -- root elements|

-- other hierarchy search criteria:

-- a) specific folder: Path = N'\abc\def\’
-- b) subtree: Path LIKE N'\abchdef\¥’
-- ¢) level range: Level »>= 5

[ Resuts ’—M — /\ _ /\

Path Name { Lev EementlD Pa Re Sec Ch Ch Level D¢ Ist Ve B Er Blement|D

1 \CENTRAL‘Carbondale. | TCBOS £31f13ch-1bec-413d-b183chcees: %a 3| O _ 1] F. D 2z £31f13cb-Thec-41

2 \CENTRAL\Carbondale’ | TCBOG | 2 e52c10c8 | 8a 3 | O i Total Gross Generation 1] F. D 2z -Tbec-419d-b 183-choceb52c10c8
3 \CENTRAL‘\Carbondale', | TCBO6 = 2 | 631f13ch-lbec-419d-b183cbcceb2c1lc8  Ba c3 O: il Technology 0 F § a s 7 | 831f13chb-Tbec-419d-b183cbcceb2c10c8
4 \CENTRAL\Carbondale’. | TCBOE | 2 | 63113ch-1bec-419db183cbcceb2c10c8 | 8a | c3 | O: il Qperator 0 F 5 a s di | 631f13cb-Tbec-419dH183cbceeb2c10c8
5 \CENTRAL\Carbondale'. | TCBO6 | 2 | 631f13ch-lbec-419d-b183cbcceb2c10c8 | 8a c3 O: il Net Generation 0 F D 2|V a c 631f13cb-Tbec-419db183cbcoeb2c10c8
& “\CENTRAL\Carbondale' | TCBOE | 2 | 631f13ch-lbec-419d-b183cbcceb2c1lc8 | 8a c3 O: il Gross Generation 0 F D 2z a | d | 631f13cb-Tbec-419d-b183-checebZc1lcd
7  \CENTRAL‘Carbondale’, | TCBO6 | 2 | 631f13ch-lbec-419db183cbcce52c10c8 | Ba c3 O: il Generating Efficiency 0 F D d | A & 1 631f13cb-Tbec-419db183cbcce52c10c8
2 \CENTRAL\Carbondale'. TCBO& 2 | £3113ch-1bec-419db183cbcce52c10c8 | 8a | c3 O i} Effective Generating Capacity 0 F D a 5 2 & 631f13cb-1bec-419d+b183cbcce52c10c8
§  \CENTRAL\Carbondale’.  TCBO& 2 | £3113ch-1bec-419db183cbcce52c10c8 | 8a | c3 O i} Daily Average Gross Generation 0 F D 2 IC a e 631f13cb-1bec-419d+b183cbcce52c10c8
10 “\CENTRAL‘Carbondale'. | TCBOE | 2 | 631f13ch-lbec-419d-b183chcce52cilc8 | 8a o3 | O: il Hourly Average Gross Generation | 0 F. D 2| a  fe 631f13cb-Tbec-419db183choce52e10c8
11 M\CENTRAL‘Carbondale'. | TCBOE | 2 | 631f13ch-lbec-419d-b183chcce5Zcilc8 | 8a o3 | O: il Demand 1] F. D 2|V a d 631f13cb-Tbec-419db183choce52e10c8
12 “\CENTRAL‘Carbondale'. | TCBOE | 2 | 631f13ch-lbec-419d-b183chcce5Zcilc8 | 8a o3 | O: il Capacity 1] F. D a8 £31f13cb-Tbec-419d-b183choce52c10c8
13 \CENTRAL‘\Carbondale’. | TCBO5 | 2 | 97866c30-040c-4b76-a158-2318bHelae  Ba c3 O: il Total Net Generation 0 F D Z|IM 2 d | 57866c30-040c-4b76-2158-23b18bFe lae
14 “CENTRAL\Carbondale’, | TCBO5 | 2 | 97866c30-040c-4b76-a158-23b18b¥elae  8a c3 O: il Total Gross Generation 0 F D 2|2 9 97866c30-040c-4b762158-23b18bFelae
15 \CENTRAL‘\Carbondale’, | TCBO5 | 2 | 97866c30-040c-4b76-a158-2318bHelae  Ba c3 O: il Technology 0 F 5 a s 7 | 97866c30-040c-4b 76-158-23b 18bHe 1ae
16 CENTRAL\Carbondale’, | TCBOS | 2 | 97866c30-040c-4b76-a158-23018bXelae  Ba c3 O: il Operator 0 F S a S di | 57866c30-040c-4b76-2158-23b 18b Fe Tae
17 “CENTRAL‘Carbondale’, | TCBOS | 2 | 97866c30-040c-4b76-a158-23b18bXelae  Ba c3 O: il Net Generation 0 F D Z |V a o 97866c30-040c-4b762158-23b18bFelae
18 “CENTRAL‘Carbondale’, | TCBOS | 2 | 97866c30-040c-4b76-a158-23b18bXelae  Ba c3 O: il Gross Generation 0 F D Z |V a d 97866c30-040c-4b762158-23b18bFelae
19 “CENTRAL‘Carbondale’. | TCBOS | 2 | 57866c30-040c-4b76-a158-23018bXelae | Ba c3 O: il Generating Efficiency 0 F D d | A6 1 57866c30HM40c-4b762158-23b18bFe lae
20 “CENTRAL\Carbondale’ | TCBOS | 2 | §7866c30-040c-4h76-a158-23018bFelae | 8a | c3 | O: il Effective Generating Capacity 1] F. D a|§ 3 6 57866c3HI40c-4b76-2158-23b18bFelae
21 “\CENTRAL\Carbondale’ | TCBOS | 2 | §7866c30-040c-4b76-2158-23018bFelae | 8a | c3 | O: il Daily Average Gross Generation | 0 F. D 2 |IC | a e 57866c30HI40c-4b76-2158-23b18bFelae
22 \CENTRAL\Carbondale’ | TCBOS | 2 | §7866c30-040c-4b76-a158-23018bFelae | 8a | c3 | O: il Hourly Average Gross Generation | 0 F. D 2 |C | a  fo 57866c30HI40c-4b76-2158-23b18bFe lae

2
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10.4.1 Field Aliases:

There’s an unsightly problem with the query: multiple columns are named the same (Name) but
are not the same. For anyone reading these query results, this is not helpful.

The solution is to rename the columns. Just as a table can be aliased, so can a column be
aliased. The keyword AS is used anytime an ALIAS is defined, whether the field is a table or
column name.

SELECT eh.Name AS [Element Name], ea.Name [Attribute Name]

The above statement gives meaningful names to the columns in the respective tables.
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10.4.2 Directed Activity — Element descriptions

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

To extract the elements in the Fleet Generation database along with their descriptions.

Approach:

Execute the Predefined Query associated with the Element Hierarchy —
modify to obtain all elements.

Review the fields in the Element table.

Determine potential relationships between the tables to create joins.

Modify the Element Hierarchy query to add the appropriate join information to
extract the description of the elements.

Locate the Element Hierarchy within SQL.

Execute the Predefined Query.

SELECT *
FROM [Fleet Generation].[Asset].[ElementHierarchy]
WHERE

Path = N'V

Modify the query to obtain all elements

SELECT *
FROM [Fleet Generation].[Asset].[ElementHierarchy]

Review the ElementHierarchy table, which gives us the Path and Name (among
other things) of the elements in the hierarchy, but no description:

<AF Database>.Asset.ElementHierarchy

Name Data type Is nullable?
Path String No

Name String No

Level Int16 No
ElementlD Guid No
ParentElementlD Guid Yes

Review the Element table. Is there a link between the Element and Element
Hierarchy table?
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<AF Database>.Asset.Element

Name Data type Is nullable?
1D Guid MNo

Name String No
Description String Yes
Comment String Yes
Revision Int32 No

Each element pointer within the hierarchy (i.e. each row in the ElementHierarchy
table) corresponds to an element object from the overall set of Elements (i.e. a
row in the Element table). Behind the scenes, these objects are linked by GUIDs
(Globally Unique Identifiers). The purpose of a GUID is to give individual objects
an identifier guaranteed to be unique. Meaningless to the human eye, they look

like:

9abd6084-6¢74-4645-a7a0-833f6¢c25de3d

GUIDs (often contained in table columns ending in ID) are how each table relates
each row (element pointer) in ElementHierarchy to each row (element) in

Element:;

<AF Database>.Asset.ElementHierarchy

<AF Database>.Asset.Element

¢ Modify the Element Hierarchy table to include the description from the

Element table.

SELECT eh.path, eh.name, e.description
FROM [Fleet Generation].[Asset].[ElementHierarchy] eh INNER Join [Fleet
Generation].[Asset].[Element] E on eh.elementid = e.id

160

Name Data type Is nullable? Name Data type Is nullable?
Path String No 1D Guid No
Name String No Name String No
Level Int16 No Description String Yes

I ElementlD Guid = Comment String Yes
ParentElementID Guid Yes Revision Int32 No
ReferenceTypelD Guid No HasChildren Boolean No
SecurityDescriptor String No HasMultipleVersions Boolean No
CheckOutTime DateTime Yes ElementTemplatelD Guid Yas
CheckQutUserName String Yes NED~faramanTynall i Ve
CheckOutMachineName String Yes



Analyzing Pl System Data

Note: In the above statement, the tables have ALIASes, but the word “AS” is not in the
statement as it is understood.

The result of the above query yields the name of the element and the description
associated with the element.

Query2.sql - SHAREPTRAINING* X

--¥*¥%x%* Object: Table ElementHierarchy Script Date: 16/31/2013 6:07:12 Al

-- Asset.ElementHierarchy table represents the current element hierarchy.
-- The table is part of the current time view of the asset hierarchy

-- (ElementHierarchy, Element, ElementAttribute, ElementExtendedProperty,
SELECT eh.path, eh.name, e.description
FROM [Fleet Generation].[Asset].[ElementHierarchy] eh INNER Join
[Fleet Generation].[Asset].[Element] E [} [

4 | m

{1 Results W

Path Name Description
25 “\NORTH\New Bedford\ POEOQ1 North > New Bedford —> POEQ1
30 \NORTH\Madison' CECO1 North —> Madison —> CEC01
31 \NORTH\Greenlawn" PTCO3 North —> Greenlawn —> PTC03
32 \NORTH\Greenlawn' PTCO2 North —> Greenlawn —> PTC02
33 \NORTH\Greenlawn' PTCO1 North > Greenlawn —> PTCO1
34 \NORTH\EDbbitt" | PQE04 North —> Ebbitt —> PQED4
35 \NORTH\Ebbitt" PQEQ3 North —> Ebbitt —> PQEQ3
36 \NORTH\Ebbitt" PQEQ2 North > Ebbitt —> PQEQ2
37 \CENTRAL\Carbondale TCBO6 Central —>Carbondale —> TCB06
38 \CENTRAL\Carbondale\ | TCBOS ' Central ~>Carbondale > TCB05
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10.4.3 Exercise - Query for Specific Elements

This solo or group activity is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you
need assistance during the activity.

Objective:

To extract the elements in the Fleet Generation database that are “Units” (Element Template)
and are located in the North Region. The fields that we want in our result set are the Unit Name,
Path, and Description.

Approach:

e Start with the query from the previous Directed Activity

SELECT eh.path, eh.name, e.description
FROM [Fleet Generation].[Asset].[ElementHierarchy] eh INNER Join [Fleet
Generation].[Asset].[Element] E on eh.elementid = e.id

¢ Review the fields in the Element Templates table.
o Determine potential relationships between the tables to create joins.
o Hint: The Element table has a field called ElementTemplatelD
o Append a WHERE clause to filter based on the Path and Element Template.
¢ Determine the fields to return and the tables associated to each field.
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10.5Built-in Functions

Pl SQL Commander has some built-in functions specific to the PI System. If you
are familiar with SQL, you may already be familiar with functions. For example,
aggregation functions such as Max() or Avg() return the maximum or average of
a group of rows.

An entire list of built-in functions is available in the user guide for PI OLEDB
Enterprise.

One of the PI functions that will be used in subsequent exercises is
ParentName(). Instead of returning the complete PATH. The ParentName
function of PI OLEDB Enterprise is used to break up the AF element path name
into separate columns of the table. The strings in double quotes are used to
rename the column name in the table to something perhaps better suited for
reporting. Again, the “eh” ALIAS prefix is required to identify the source of the
field.

SELECT

eh.Name [Unit]

, ParentName(eh.Path,0) [Station]

, ParentName(eh.Path,1) [Region]

FROM [Fleet Generation].[Asset].[ElementHierarchy] eh
Where eh.Level=2

Results | [y Messages

Uik Station Region
1 GaDD2 | Albertsville CEMTRAL
2 GADD | Albertsville CEMTRAL
3 BCUOZ | BerlRidge CENTRAL
4 BCUM | BenlRidge CEMTRAL
5  TCBOE | Carbondale CEMTRAL
E  TCBOS | Carbondale CEMTRAL
¥ TCBO4 | Carbondale CENTRAL
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10.6 Data Tables

In the previous sections, we saw the process to query for elements from the Fleet Generation
database through a series of table joins between Asset Framework object tables within Pl SQL
Commander. The tables within PI SQL Commander are not limited solely to Elements, Element
Hierarchy, and Element Templates.

Within PI SQL Commander, there are several tables under the [AF Database].[Data] path that
will allow the user to extract real-time and archive values from the Pl Data Archive. A query
against these tables will return either Element Attribute data or Event Frame data. In order to
utilize these tables, a query needs to have an INNER JOIN to the ElementAttribute table and a
specific Data table. The ElementAttribute table allows for the mapping between the data and
specific attributes associated with a set of elements.

4 [ JData
4 [ ATables

= archive
EEventFramedrchive
| EventFrarneSnapshot
=ISnapshot
—j‘dft_EventFrameInterpDIateDiscrete
—;‘dft_E\.-'entFra melnterpolateRange
—?ﬂﬁ_EventFramePIDt
—j‘dft_lnte rpolateDiscrete
—j‘dft_lnte rpolateRange
aft_Plat

[ Wiews

[dFunctions

The tables corresponding to Element Attribute data are listed below:

Table Description
Archive Returns archive / compressed data
Snapshot Returns values in the snapshot (current values)

ft_InterpolateDiscrete Returns interpolated value given timestamp

ft_InterpolateRange Returns interpolated values at evenly distributed
timestamps
ft_Plot Returns minimum data required for trending

Note: Similar tables exist for data from Event Frame attributes. Typically, only the Event Frame
Snapshot table is queried against as each Event Frames contain individual start and end times.
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10.6.1 Directed Activity — Snapshot Values

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective: Create a query to extract real-time values for the Gross Generation and
Net Generation attributes of all units. The fields in the result set should contain
Element Name, Station Name, Region Name, Attribute Name, Timestamp, and
Value.

Approach:
The creation of this query requires several steps.
1) Run the predefined query of the Element table to obtain all elements.

2) Remove the WHERE clause.
SELECT *
FROM [Fleet Generation].[Asset].[Element] e

3) Apply an INNER JOIN to the Element table.
SELECT *
FROM [Fleet Generation].[Asset].[Element] e
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID

4) Apply an INNER JOIN to the ElementTemplate table.
SELECT *
FROM [Fleet Generation].[Asset].[Element] e
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID
INNER JOIN [Fleet Generation].[Asset].[ElementTemplate] et
ON e.ElementTemplatelD = et.ID

5) Add a WHERE clause to return only elements that are Units.

SELECT *

FROM [Fleet Generation].[Asset].[Element] e

INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID

|

~

%

OSlsoft. Page 165



Analyzing Pl System Data

INNER JOIN [Fleet Generation].[Asset].[ElementTemplate] et
ON e.ElementTemplatelD = et.ID
WHERE et.Name = 'Unit'

6) Apply an INNER JOIN to the ElementAttribute table and modify the WHERE
clause to return only attributes that are either “Gross Generation” or “Net
Generation.”

SELECT *

FROM [Fleet Generation].[Asset].[Element] e

INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID

INNER JOIN [Fleet Generation].[Asset].[ElementTemplate] et

ON e.ElementTemplatelD = et.ID

INNER JOIN [Fleet Generation].[Asset].[ElementAttribute] ea

ON ea.ElementID = e.ID

WHERE et.Name = 'Unit' and (ea.Name = 'Gross Generation'

OR ea.Name = 'Net Generation’)

7) Apply an INNER JOIN to the Data Snapshot table and specify the fields for
the result set.

SELECT

eh.Name [Unit]

, ParentName(eh.Path,0) [Station]

, ParentName(eh.Path,1) [Region]

, ea.Name [Attribute]

, S.Time

, S.Value

FROM [Fleet Generation].[Asset].[Element] e

INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID

INNER JOIN [Fleet Generation].[Asset].[ElementTemplate] et
ON e.ElementTemplatelD = et.ID

INNER JOIN [Fleet Generation].[Asset].[ElementAttribute] ea
ON ea.ElementID = e.ID

INNER JOIN [Fleet Generation].[Data].[Snapshot] s

ON s.ElementAttributelD = ea.ID

WHERE et.Name = 'Unit' and (ea.Name = 'Gross Generation'
OR ea.Name = 'Net Generation’)
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10.6.2 Exercise — Interpolated data

This solo or group exercise is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you
need assistance during the exercise.

Objective:

Create a query to extract hourly interpolated data for the Demand attribute of all
UNITs over the past four hours. The fields for the result set should include Element
Name, Attribute Name, Timestamp, and Value.

At what time does the demand tend to be high over all units?

Approach:
The creation of this query requires several steps.
1) Run the predefined query of the ft_InterpolateRange table.

2) Remove the portion of the WHERE clause that filters the results to all root
elements.

3) Modify the Start Time, End Time and TimeStep.

4) Apply an INNER JOIN to the Element table, which is required to join to the
ElementTemplate table

5) Apply an INNER JOIN to the ElementTemplate table, which is required to
filter for the UNIT template (et.Name)

6) Add a WHERE clause to return only elements that are Units.
7) Append to WHERE clause to return only the “Demand” attribute.

8) Restrict the SELECT to return the desired fields.

|

~
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10.7Data Transpose Functions & Function Tables

As seen above, the data comes back in tabular form, but does not lend itself to easy
interpretation.

Below is the query from the previous section that illustrates the difficulty in reviewing the
shapshot data for the attributes for the Elements. Notice that the attributes as returned in rows.

SELECT eh.name, ea.name, s.time, s.value

FROM [Fleet Generation].[Asset].[ElementHierarchy] eh
INNER JOIN [Fleet Generation].[Asset].[ElementAttribute] ea
ON ea.ElementID = eh.ElementID

INNER JOIN [Fleet Generation].[Data].[Snapshot] s

ON s.ElementAttributelD = ea.ID

OPTION (FORCE ORDER, EMBED ERRORS)

A portion of the results from the above query is displayed below.

HResults | [1y Messages [

Name Name Time Value
1 ALX01 | Yield 2013-10-31 06:34:42.000 72.82847
2 ALX01 | Unit Status 2013-10-31 06:09:42.000 = Active
3  ALX01 | Technology 1570-01-01 00:00:00.000 ' Cogeneration
4  ALX01 | Shift Hours 1970-01-01 00:00:00.000 | 12
5 ALX01 | Shift 2013-10-31 06:00:11.000 | 1
6 ALX01  Operator 1970-01-01 00:00:00.000 | COG
7  ALX01 | Net Generation 2013-10-31 06:34:42.000 | 140386.2
8 ALX01 | Houry Capacity 1570-01-01 00:00:00.000 | 8500
§ ALX01 @ Gross Generation 2013-10-31 06:34:42.000 | 148570.1
10 ALX01 | Generating Efficiency | 2013-10-31 06:34:42.000 = 94.43155

Data presented in this format is typically difficult to handle for reports and Bl Tools. Instead, we
prefer to rotate or transpose the values as:

BElement B Tc Tc Technology Operator  Net Generation Gross Generation  Generating Effici
“NORTH Ebbitt \PQED3 a 5|7 Geothermal BSX 1018405 80625.76 8017107
“NORTH"Ebhbitt \ PQEDZ & 5|4 Geothemal BSX 670057 6 (724551 58.72289
LSOUTHEAST Wolverine Station®ALX01 | 7| 1| 1. | Cogeneration | COG 1355077 125976.7 55.78031
YWSOUTHEASTVicksberg\MAMD4 811 Coal BSX 1741214 18153.54 92.0494
“SOUTHEAST Vicksberg\MAMD3 a 3|3 Coal BSX 3621755 3740151 5971217
“SOUTHEAST W Vicksberg\MAMOZ f. 1|1 Coal BSX 143047 1 145616.9 58.60997
WSOUTHEAST Vicksberg' MAMD1 e 1|1 Coal BSX 138275 1382946 59.25276

As the same column headers are used for every row in the table, every element
needs to have the same set of attributes in order to populate these cells. This brings
us back to using AF Templates for all our elements, so we can get these common
properties. Transpose functions are only available for templatized elements!

This is similar to that of the final view created by the PI Integrator for Business
Analytics. PI OLEDB Enterprise can also generate transpositions similar to what is
above. A wizard walks you through the process of creating a transpose function for
any Element Template of your choosing.
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10.7.1 Transpose Function Wizard

For many use cases, attribute values need to be returned in a way so that each
column represents an attribute. This is contrary to a typical relational representation,
where each value of each attribute is normally represented in consecutive rows. To
represent multiple attributes in this "one column per attribute" format, one could join
data tables with itself multiple times, but the resulting query string would be rather
large and complex. To help with this, we provide a way to create custom Table-
Valued Functions (TVFs) and derived function tables, to get "transposed" result sets
of the related data tables.

Under each Pl AF database branch, there are four folders, “Assets”, “Data”, “DataT”
and “EventFrame”.

B @Data Sources
=] ﬁ.ﬁ.F SErvers
| PICLIENTL
= [grisryt
= [diatalogs
| ACME Enterprises
| Configuration
=l | ] Fleet Generation

[dData
[ dDataT
[_JEventFrame
| Fleet Generation Sim
1 MutGreen

The “Tables” folder under “Data” shows the tables and columns that provide access
to snapshot and historical data from the Pl System.

4 | | Fleet Generation
[ Asset
4 [ JData
4 [ JTables
E archive
= EventFramefrchive
E EventFrameSnapshot
Edsnapshot
—;'ﬂft_EventFrameInterpulateDiscrete
—;'dft_EventFrameInterpDIatERange
—;'dft_E\rentFramePIc't
—;'dft_lnterpu:ulateDiscrete
—;'dft_lnterpulateﬁange
aft_Plot

f‘() OSlsoft.
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Under both the “Assets” and “Data” folders there are two additional folders called
“Views” and “Functions”. These folders are initially empty and provide places for you
to organize the views and functions you create.

In general, creating and editing queries and views is a restricted activity. The changes are
contained in the Pl AF SQL Database and access will be controlled by the database
administrator.

The “DataT” branch of the hierarchy is for working with transpose functions.

e Transpose functions allow you to obtain tables of Pl AF information based on
AF element templates.

e This folder comes with the same subfolder structure as “Assets” and “Data”,
but they are initially empty until they are manually created.

e Transpose functions can be create using the wizard discussed in the next
section.

4 | | Fleet Generation
[ Asset
[JData

4 [ | DataT
[ dTables
[ A Views
& Functions
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10.7.2 Directed Activity — Create Dynamic Asset Transpose Functions

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective: Create all Dynamic Asset Transpose Functions for the Fleet Generation
database to be used in analyzing plant generation data.

Approach:

There are four transpose functions available. Each transpose function
returns a dataset made up of columns for every attribute of an element
template, where each row returns values based on a different time basis.

Function Snapshot or Rows/element returned
Archive
Transpose Shapshot Snapshot 1 row per element attribute for

element(s) selected

Transpose Archive Archive 1 row per element archived attribute
value for element(s) selected over a
specific time range

Transpose Interpolated 1 row per element returns interpolated
Interpolate Discrete value based on timestamp

Transpose Interpolated 1 row per element returned for each
Interpolate Range interval for each element attribute

based on time range and interval

./.--
/
\
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Access the Transpose Function Wizard by right-clicking on the “DataT” folder under the AF
Database catalog you wish to build a transpose function for, and select “New Transpose
Function -> Dynamic Transpose Function (Asset)...”

o Bt B Y 179 | BCUOZ2 Exhaust Gas Ter
uft_Plot 180 | BCUOZ Exhaust Gas Ter
Tyft_Summarize = 181 | TCBOG Generating Effici

3 Views 182 | TCBOE Utilization
' Fne 183 | TCEOG Total Hourly Gros
L Funchans 184 | TCBOE  Carbon Emission
4 135 | TCEOG Generztion Rate
2] | Refresh 185 | TCBOB Unit Status
4 g i T e T ol
MNew Transpose Function : Dynamic Transpose Function (Asset)...
Export Custom Database Objects... Dynarmic Transpose Function (Event Frame)...
e ———
.__] Flest Generation Sim Custom Transpose Function (Asset).. -
._J MNuGreen Custom Transpose Function (Event Frame)... by
| | OSIDemo_ETD_FULL_FeederVoltageMonitoring | 2 ==s [ aross benerdio

Note: Dynamic Transpose Functions will automatically reflect additions and deletions of
Attributes from the template, whereas Custom Transpose Functions allow you to explicitly select
a set of Attributes which will remain static.

We will create all of them, hold control and multi-select the top four then click Next:

(@ osi

Transpose Function

Transpose Function Wizard .

Select transpose function:

El t T lat:
SIS GRS Transpose Snapshot

Definition Transpose Interpolate Discrete

Options Transpose Interpolate Range
Summary i Transpose Archive
Executicn Wersioned Transpose Snapshot

Versioned Transpose Interpolate Discrete
Versioned Transpose Interpolate Range

Versioned Transpose Archive

Note: Versioned Transpose functions consider Pl AF versioning. We will not be using these.
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Select the Pl AF template(s) you want to create transpose function for. You can select as many
as you want, the wizard can build multiple transpose functions per pass. Here, we will select
“UNIT” and click Next.

Transpose Function Wizard .
I.‘I
(@ osi
eI peEe (R e Select element template:
Element Template Gas Turbi
Gas Turbine

Definitian REGION
Options STATION
Summary Steam Turbine
Execution UNIT I

T

If you want to use non-default Transpose Function names or the element template has sub-
attributes, modifications can be made here. In our case just leave the defaults and click Next.

Transpose Function Wizard .
L‘I
(‘ . OSlI
UErEEeE (e Transpose function name pattern:
e e FTransposeFunction?:_UNIT
et iton Select Attribute Path:
Options \
Summary
Executicn
[ Include subtree
ewe ] ]
f/-. i
: ) OSlsoft. Page 173
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Leave the defaults for the next window. You have the option to return values using the
VARIANT data type, which may be useful with some reporting tools. We want to create the
function table.

@. OSl-ot.

Transpose Function Options:

Element Template [] Values as VARIANT
Definition Create function table

Options

Summary

Execution

Review the summary and click Next.

@. OSl:ot.

Transpose Function 5
ummary:

Element Template --Transpose function: TransposeSnapshot

Definitizn --Element template: UNIT

--Transpose function name: TransposeSnapshot_UNIT
--Values as VARIANT: No

Summary --Create function table: Yes

Opticns

Executi
seution CREATE FUNCTION [Fleet Generation] [DataT] [TransposeSnapshot_UNIT]

AS
[Fleet Generaticn].[TransposeSnapshot] <N'UNIT', N, False /include attribute subtree/, False /“values as VA

CREATE TABLE [Fleet Generation].[DataT].[ft_TransposeSnapshot_UNIT]

Click Execute. Transpose function creation should be successful.
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@. OSl:ot.

Transpose Function P
rogress:

Element Template

Definiticn
Details:

Element Template Function

Options
Summary

Execution

TransposeSnapshot
UNIT

TransposelnterpolateDiscrete
UNIT

TransposelnterpolateRange
UNIT

| < Back |I Execute I

From the Pl SQL Commander hierarchy, the transpose tables and functions created by the wizard
should appear under the “DataT” folder of the “Fleet Generation” Pl AF database.

e
|J U Flest Generation
b [dAsset
[ |_yData
4 [_yDat&T
4 [ _JTables
[ Eﬁﬁ_Tranme.ﬁrﬂli\re_UHIT
[ Elﬁ_Tranmnelnta‘pnlat&Dimete_UNlT
[+ E&ﬁ_Transpmelnta‘polateHange_UNﬂ'
b Cyft_TransposeSnapshat_UNIT
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As for how to use your newly-created Function, examine the shapshot function it

in Object Explorer:

e —?‘J'Ft_TranssteSnapsth_LlNlT
4 [ Colurmns

{2 ElementD {Guid, not null)

=] Unit Status (String (40007, nully
ﬂTechnDngy (String(4000), null)

=] Shift Hours Int32, null)

=] Shift Int32, null)

H| Dperator (3tring (4000, null)

=] Met Generation isingle, nully

=l Hourly Capacity (Single, null)

=] Gross Generation (Single, aull)
ElDemand i(Zingle, null)

=] Rate (Double, nulll

=] Carbon Emissians (Double, null)

=] Total Hourly Gross Generation (Double, null)
=] Utilization (Double, null)

H| Generating Efficiency (Double, null)

Reality check: If we call the TransposeSnapshot_UNIT function, the same
columns exist in the function as in the original template, such as Effective
Generating Capacity, Generating Efficiency, etc.

A Predefined Query is associated with transpose functions. Execute the query.

—?gft Transposetnapshot LNIT I o

_dView ¥  Execute Predefined Query...

T Results

L= I 3 B R

ElernentiD Unit Statuz  Techhology  Shift b Shift Operator Met Generation  Hourly Cz
SCEMTRALAIbertsvillehGa0 02 erbfab20-e806-1 | Active Matural Gaz | 8 2 BSH 0 Ba0
SCEMTRALAIbertzvillehGAD 01 erbfab1d-eB06-1 | Active Matural Gas | 8 2 BSH 3072737 550
SCEMTRALBenl Ridge BCUOZ erbfab23-e806-1 | Active Matural Gas | & 2 BSx 4331268 5A0
SCEMTRALB el Ridge\BCUM erbfab26-e806-1 | Inactive Matural Gaz | 8 2 BSx 2259575 g00
SCEMTRALNCarbondalet TCROE erbfaf3e-eB06-1 | Inactive Matural Gaz | 8 2 BS: 3321286 E00
SCEMTRALCarbondaletTCEOS e7bfab3b-e806-1 | Inactive Matural Gaz | & 2 BSH B00 BA0

Grozs Gene
a0
3380011
h42 4395
2559575
1132129
EEQ
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10.7.3 Exercise — Create Dynamic Event Frame Transpose Functions

need assistance during the activity.

Objective:

Attributes from the generation units and the event frames will be used to analyze
production data from the plants.

Approach:

Use the transpose function wizard to create a Snapshot event frame function
using the Inactivity and Gas Turbine Temperature Anomaly template.

Verify the results of the transpose function through the execution of the pre-defined
query.

Hint: The steps are almost identical to the ones used when creating an Asset
transpose function.

4 [T E Refresh |
|Eas WSS P N T P

This solo or group activity is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you

- New Transpase Function v Dynamic Transpose Function (Asset)... -

" ) =men
Export Custom Database Objects.., I Dynarnic Transpose Function (Event Frame)... I b ddBa70-
1 BddEd1a-
_gjﬂ_TmnspnseSnapshot_UNlT Custom Transpose Function (Asset)... e
[ Views Custom Transpose Function (Eve:nt Frame)... TN
[ Functions | " 5 | YSOUTHEASTWicksberg\MAMOT b8ddE411-

A
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Create Transpose Snapshot only:

(@ osio.

Transpose Function

Select transpose function:

Event Frame

T Transpose Snapshot
emplate
. Transpose Interpolate Discrete
Definition
) Transpose Interpolate Range

EHEE Transpose Archive

Summary

Execution

Create for both Gas Turbine Temperature Anomaly and Inactivity.

@. OSl:-ofl.

Transpose Function Select event frame template:

Event Frame g :
e i urbine Temperature Anomaly

Inactivity

Definitien
Options
Surmmary

Execution

Leave all defaults from this point on. Next, Next, Next, Next, Execute.
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10.8 UNION Statements

You may have noticed that the Asset Transpose functions we created only return
Assets that use the UNIT template and not those that use the Gas Turbine template,
despite the Gas Turbine template being derived from the UNIT template via template
inheritance. Unfortunately, this is a limitation of Pl OLEDB Enterprise. One way to
address this is with UNIONs.

In simple terms, UNIONs take the results of two queries and stack the result sets on
top of each other to form a single result set. One limitation of UNIONSs is that the
input result sets must have identical columns, which may require removing and
aliasing columns to match the data sets. This will be demonstrated in the following
exercise.

The syntax is quite simple, place the keyword UNION in between two queries to
union them together. The OPTION statement must be at the very end:

SELECT * FROM Table1 WHERE Condition="TRUE’

UNION

SELECT * FROM Table2 WHERE Condition="TRUE’

OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS)

10.8.1 Directed Activity — UNITs and Gas Turbines in a single result set

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective: Create a query to display Snapshots for all UNITs, including Gas
Turbines.

Approach:
The creation of this query requires several steps.
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Create Dynamic Asset Transpose Functions for Gas Turbines. This is identical to a
previous exercise except we will select the Gas Turbine Template. Create all non-
versioned Transpose Functions

@ OSl:oft.

Transpose Function

Select transpose function:

Elerment Template Transpose Snapshot

ST Transpose Interpolate Discrete
Opticns Transpose Interpolate Range
Surmmary Transpose Archive i
Execution Wersioned Transpose Snapshot

Wersioned Transpose Interpolate Discrete
Wersioned Transpose Interpelate Range
Wersioned Transpose Archive

Select Gas Turbine, then Next, Next, Next, Next, Execute (leave all defaults after
this point)

@ OSl:-oft.

Transpose Functicn

Select element template:
Element Template

GasTurbine
Definition REGION
Options STATION
Surnmary Steam Turbine
Executicn UNIT
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Execute the predefined query for ft_TransposeSnapshot_UNIT, make note of the
resulting column set.

—Jﬂll_ 11l PspRUss e DG ST AL\ 3ds 10D

_uft TransposeSnapshot UNIT
¥ | Execute Predefined Query...

EI Refresh

Create a new query. The Goal here is to preserve the text of the UNIT query.

P

File Edit Wiew Query Tools Help
2 New Query| # Execute @ |42 "f:tj e !

Object Explorer
=1

Execute the predefined query for ft_TransposeSnapshot_Gas Turbine, note that
there are five additional columns for those attributes unique to Gas Turbines.

_j-'dﬂ_Transpo@elrterpnlateﬂang e_LMNIT
_Lft TransposeSnapshot Gas Turbine
# | Execute Predefined Query...

£| Refresh

Change ts.* to explicitly select only those columns that are common to the UNIT
template for both queries, then UNION them together and remove one of the
OPTION lines (which has to be the last line). Since this is tedious, just copy/paste
the below query.

SELECT eh.Path + eh.Name Element, ts.[Generating Efficiency],
ts.[Utilization],
ts.[Total Hourly Gross Generation], ts.[Carbon Emissions], ts.[Generation
Rate],
ts.[Unit Status], ts.[Technology], ts.[Shift Hours], ts.[Shift], ts.[Operator],
ts.[Net Generation], ts.[Hourly Capacity], ts.[Gross Generation], ts.[Demand]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e

ON et.ID = e.ElementTemplatelD
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh

ON e.ID = eh.ElementID
INNER JOIN [Fleet Generation].[DataT].[ft_TransposeSnapshot_Gas
Turbine] ts

ON eh.ElementID = ts.ElementID
WHERE et.Name = N'Gas Turbine'
UNION

:'/--
/
.
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SELECT eh.Path + eh.Name Element, ts.[Generating Efficiency],
ts.[Utilization],
ts.[Total Hourly Gross Generation], ts.[Carbon Emissions], ts.[Generation
Rate],
ts.[Unit Status], ts.[Technology], ts.[Shift Hours], ts.[Shift], ts.[Operator],
ts.[Net Generation], ts.[Hourly Capacity], ts.[Gross Generation], ts.[Demand]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e
ON et.ID = e.ElementTemplatelD
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID
INNER JOIN [Fleet Generation].[DataT].[ft_TransposeSnapshot_UNIT] ts
ON eh.ElementID = ts.ElementID
WHERE et.Name = N'UNIT'
OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS)
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10.9Saved Views

Often Administrators would prefer to create Views for end-users who are not familiar
with SQL queries. Often Views are queried using a basic SELECT * query to return
all data without any WHERE clause and without selecting individual columns. This
masks the complexity and size of the query (eg. table JOINS and UNIONSs of several
tables) but places the burden of maintaining the query on the administrator. In future
exercises we will be using the queries directly, but it is still useful to know how to
create and query views in Pl SQL Commander.

10.9.1 Creating dataset views

PI SQL Commander supports the creation of views. Views allow you to name a
stored query and it is this name that appears in the table list when importing data into
Bl clients. Views are the easiest way to allow users to select which datasets they
want from Pl AF when creating a report, as they do not need to understand the
complexity of the underlying SQL query.

Views are created using SQL syntax, but OLEDB Enterprise can give you a template
to start with. If you’re trying to create a saved query showing information about
assets, consider creating it in the Asset schema (folder). If you have a saved query
showing data values, for organizational purposes, place it in the Data schema. The
image below shows a right-click menu giving the Create View option:

) | LARILNIL LR ] VLRI e —
4 | || Flest Generation INNER JO
- On e
[ Asset WHERE et
[_JData UNIOM
. SELECT e
4 [Datal +r [Tt
L3 Tables TRresul
[ y\Views
[ | Create View...

[ Eve EI Refresh

Selecting Create View produces the beginning of a query:

CREATE VIEW [Fleet Generation].[DataT].[ <view name> ]
A5

<query:
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At this point, it is a matter of naming the View by replacing <view name> and copy
pasting the query by into <query> placeholder.
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10.9.2 Directed Activity — View Creation for Unit Performance

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:
Create a view, Unit Performance, using previously created asset interpolated range

transpose functions for frequently changing process data (Transpose Interpolate
Range).
Approach:

Run the Unit Interpolated Range transpose function using the Execute

Predefined Query. Note that no INNER JOIN to the ElementTemplate table is
necessary as the transpose function was created against the UNIT template.

.LI' e ———— e ——— -

_uﬂ; TransnnselnternnlateRannoe LIMNTT
—uf't ! Execute Predefined Query...

ft #] Refresh

LR HE

Modify the date range to include data from the past week and a one hour time
slice.

AND tir.StartTime = DATE('t-7d")
AND tir. EndTime = DATE('t)
AND tir. TimeStep = '1h'

Create a view from the transpose function.

b [ Views ]| —

(3 Fu Create View..

Fill in the required information to create the view.

CREATE WIEW [Fleet Generation].[DataT].[ <view name> ]
AS

Lgquery:

Name the View: Unit Performance
Use modified transpose function for the query
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CREATE VIEW [Fleet Generation].[DataT].[Unit Performance]
AS
SELECT eh.Path + eh.Name Element, tir.*
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e
| ON et.ID = e.ElementTemplatelD
| INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
| ON e.ID = eh.ElementID
| INNER JOIN [Fleet Generation].[DataT].[ft_TransposelnterpolateRange UNIT] tir
| ON eh.ElementID = tir.ElementID
| WHERE et.Name = N'UNIT'
AND tir.StartTime = DATE(N't-7d")
AND tir.EndTime = DATE(N't)
AND tir.TimeStep = N'1h'
| OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS)

Execute the function.

If successful, a successful message will display, otherwise, an error will be
displayed in the lower region of the query section.

Refresh the View section and verify the Unit Performance View is present.

4 |_JDataT
[ Tables
4 |yViews
[£3)| Unit Performance

[ Funciions

The definition for the view can be seen by selecting the Alter option in the View
folder.

1 Unit Performance

Bl ¥  Execute Predefined Query...
[dFui

| L

Alter View...
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Execute the predefined query to see how the view is referenced ([Fleet
Generation].[DataT].[Unit Performance]) and confirm the expected data is

returned:

File Edit WView Query Tools

'”_-1 Mew Query | # Execute 4 @{] 1€} Query Compendium

Object Explorer
nN AN

1y Query10.sgl - PISRVOT*

A [_'iOI_EDB Data Sources

4 ([P OLEDB Enterprise
4 [BPISRVOT

4 [_JCatalogs

b [J Configurstion
b [ Distribution Metwork
4 | || Flest Generation

SELECT TOP 1@@ *
Fleet Generation].[DataT].[Unit Performance

FROM

[results Lhr"lessages

| [y QueryS.sgl - PISRVIT X | | Quen

I [ Asset
i | _4Data
4 [_4DataT

[+ [ Tables
4 [JViews
1 [7]] Unit Performance

¥ | Execute Predefined Query...

Alter View...

W oo = h e W

B3

»

Element

ElementiD

\SOUTHEASTWelvenine Station\ALX01
\SOUTHEASTWolvering StationtALX01
\SOUTHEASTWelverine Station\ALX01
\SOUTHEASTWolvering StationtALX01
\SOUTHEASTWelverine Station\ALX01
\SOUTHEASTWolverine Station\ALX01
\SOUTHEASTWelverine Station\ALX01
\SOUTHEASTWolverine Station\ALX01
\SOUTHEASTWelverine Station\ALX01
\SOUTHEASTWelverine Station\AL1X01
\SOUTHEASTWelvering Station\ALX01
\SOUTHEASTWelvering Station\A1X01
SO THEAS T nherine Statinal il ¥

bBddE420-a4b7-1128-80=d-000
b3dd6420-a4b7-118-802d-000
bBddE420-a4b7-1128-80ed-000
b3dd6420-a4b7-118-802d-000
bBddE420-a4b7-1128-80ed-000
b3ddE420-a4b7-118-802d-000
bBddE420-a4b7-1128-802d-000
b3ddE420-a4b7-1128-802d-000
bBddE420-a4b7-1128-802d-000
b2ddE420-a4b7-1128-80=d-000
bBdde420-a4b7-1128-802d-000
bBddE420-a4b7-1128-80=24-000
RRAARA PNmdh 7-1128-2NarA-NN0

@ OSlsoft.
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10.10Importing PI OLEDB Enterprise data to Power Bl

The first thing to do when using a client is to import the data you want to analyze.
Importing data requires connecting to the data source holding the data, specifying
the data you need from the data source (by selecting a database table, view, or
writing a query), and then importing the data into the client tool. The following steps
will describe how to import the complete datasets from the Pl OLEDB Enterprise
views defined in the previous sections.

10.10.1 Directed Activity — Importing Data Using PI OLEDB Enterprise

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:
Import Transpose function query results into Power BI.
Approach:

Open MS Power Bl Desktop

Select “Get Data” and browse to “other.” Select OLE DB and click “Connect”.
al | = |l Unti

Home Wigw Modeling Help
u — et bo
Cut J = [ Text by
e =
copy : i D image

Paste Get  Recent  Enter Edit: Refresh Mews  Mew  Buttons

: Fram Frao
FormatPainter  pata~ Sources~ Data  Queries~ Page ™ ‘Wisual ~  Hshapes T pgarketplace il
Clipboard External data Ihsert Custom wisuals
X
Get Data
Other
Al < Vertica (Beta)
. & w
File e

Database B SharePoint list

Power BI OData Feed

&% Active Directory

Azure

Online Services £3 Microsoft Exchange

@ e

7 Spark (Beta)
<r Rscript
<= ODBC
| ] OLEDB
L Blank Query
Certified Connectors Cancel
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Select Build, then select PI OLE DB Enterpris

=] Data Link Properties

Provider | Connection | Advanced | &1 |

Select the data you wart to connect ta:

OLE DE Provider(z)

Microsoft Office 12.0 Access D atabaze Engine OLE DB Provide
Microzoft Office 16.0 Accessz Databaze Engine OLE DB Provide
Microzoft OLE DB Pravider for Analysis Services 11.0

Microzoft OLE DB Pravider for Analvsis Services 14.0

Microzoft OLE DB Provider for QDBC Drivers

icrozoft OLE DB Provider for SOL Server

Microzoft OLE DB Simple Provider

MSDataShape

OLE DE Provider for Microzoft Directory Services

Pl OLE DB Provider

Pl OLEDE Enterpri
SOL Server Wative Client 11.0

< 1] >

| kK || Cancel || Help

e and click Next

Skip to the All tab, and edit the Integrated Security property to SSPI. This is
required to authenticate the connection using the running user’s credentials.

=i

Data Link Properties

[ x|

| Provider | Connection I Advancedl Al

These are the initialization properties for this type of data, To edit a
walue, select a property, then choase EditValue below.

I Edit Yalue... I

I arne Walue -
Extended Properties X
Function Emors as NULL False
lgnore Errore Falze
Initial Catalog
| Integrated 5ecurity SSPI |
K.eep Default O rderiny =t
Lag File Edit Property Yalue
Log Level
O phimization Lag Limi Property Description
Password |Integrated Security |
Persist Security Info
Server Log Property Yalue
Shorten Primary ey I|ESP| I |
Sheus Hiddan bdatad it
Reset Walue | ak | | Cancel |

ok ||

Cancel ||

Help |

Page 189



Analyzing Pl System Data

Go back to the Connection tab, enter PISRVO01 as the Data Source, check ‘Use
Windows NT Integrated Security’, select Fleet Generation as the Initial
Catalog, and then test the connection.

Use Windows NT Integrated Security basically means connect using the user’s
login (pischool\student01) and password, and hence the user’s level of access.
SSPI must have been added in the previous step to use this option. The
alternative is to hard-code a user and password, which may give more access

than a user is entitled to.

Data Source:

=i Data Link Properties

Provider | Connection |.-’-'-.|:Ivan|:eu:| I All |

[ x|

Specify the following to connect ta this data:

1. Enter the data zource and/or location of the data:

| PISRYDT

2. Enter information to log on to the server:

I ® Use Windows NT Integrated security I

Blank pazzword

() Usze a specific user name and password:

3. Enter the initial catalog to usze;

Fleet Generation

Allow zaving pazsword

W

|] Test Connection ﬂ

| ] | | Cancel |

| Help |

Microsoft Data Link

Test connection succeeded,

8] 4

Skip the Advanced tab and click OK to complete the connection string.
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Expand Advanced options, here you can enter any SQL statement that has
been tested in PI SQL Commander. In this case enter the Interpolate Range
UNION query and click OK:

SELECT eh.Path + eh.Name Element, ts.[Generating Efficiency],
ts.[Utilization],
ts.[Total Hourly Gross Generation], ts.[Carbon Emissions], ts.[Generation
Rate],
ts.[Unit Status], ts.[Technology], ts.[Shift Hours], ts.[Shift], ts.[Operator],
ts.[Net Generation], ts.[Hourly Capacity], ts.[Gross Generation], ts.[Demand]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e
ON et.ID = e.ElementTemplatelD
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID
INNER JOIN [Fleet Generation].[DataT].[ft_TransposeSnapshot_Gas
Turbine] ts
ON eh.ElementID = ts.ElementID
WHERE et.Name = N'Gas Turbine'
UNION
SELECT eh.Path + eh.Name Element, ts.[Generating Efficiency],
ts.[Utilization],
ts.[Total Hourly Gross Generation], ts.[Carbon Emissions], ts.[Generation
Rate],
ts.[Unit Status], ts.[Technology], ts.[Shift Hours], ts.[Shift], ts.[Operator],
ts.[Net Generation], ts.[Hourly Capacity], ts.[Gross Generation], ts.[Demand]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e
ON et.ID = e.ElementTemplatelD
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID
INNER JOIN [Fleet Generation].[DataT].[ft_TransposeSnapshot_UNIT] ts
ON eh.ElementID = ts.ElementID
WHERE et.Name = N'UNIT'
OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS)

K) OSlsoft. Page 191



Analyzing Pl System Data

Click the Windows tab and select ‘Use my current credential’, then click
Connect. This should import the query results.

OLEDE provider

Defautt or Custom = data source=PISRVOT;initial catalog="Fleet Generati...

Use your Windows credentials to access a data source with an OLE DB provider.

Windows

I® Use my current credentials |

Database Use alternate credentials

User name

Credential connection string properties (optional)

Back Connect Cancel

Inspect the preview, then click Load.

o X

OLE DB (provider=PIOLEDBENT.T;initial catalog="Fleet Generation";data source...
Element Generating Efficiency Utilization Total Hourly Gross Generation Carbon Emissions Generation Rate 1]
\CENTRAL\Carbondale\TCBOG 80.90908784 5295745129 317.7447077 405 0.078 A
\CENTRAL\Carbondale\TCBOS 80.90209091  101.5384615 660 405 0.078 A
\CENTRAL\Carbondale\TCBO4 8538880574 4991178506 2954707344 405 0.078 In
\CENTRAL\Albertsville\GAOOL 80.90209342 777670278 427 7186529 405 0.078 In
\CENTRAL\Albertsville\GADO2 0 4.615384615 30 405 0.078 A
\CENTRAL\Beryl Ridge\BCUO1 B8.62565559  39.31727656 2359036593 405 0.078 In
\CENTRAL\Beryl Ridge\BCU02 90.90209091 120 660 405 0.078 A
\CENTRAL\Carbondale\TCBO1 80.90209091  101.5384615 660 405 0.078 A
\CENTRAL\Carbondale\TCBO2 B0.13719929 26 50630985 158.0378591 405 0.078 A
\CENTRAL\Carbondale\TCBO3 50 80909262 1180655771 64583606739 405 0.078 A
\SOUTHEAST\Walverine Station\ALX01 80.90209091  116.1539817 580.7699085 17 0.12 A
\SOUTHEAST\Vicksberg\MAMO4 819129439 4181947542 282 736335 70 0.034 A
\SOUTHEAST\Vicksberg\MAMO3 90.90309466 | 72.59439092 508.1607365 970 0.034 | A
\SOUTHEAST\Vicksberg\MAMO2 90.90209181 8B 23817025 617.6671918 70 0.034 A
\SOUTHEAST\Vicksberg\MAMO1 80.90209038 87.8BB563378 527.3138027 70 0.034 A
\SOUTHEAST\Stampton\MNDO2 7899272842 2694385746 148191766 405 0.078 In
\SOUTHEAST\Stampton\MNDO1 7778172552  22.07126648 1434632321 405 0.078 A
\SOUTHEAST\Octavia\ZMNO2 80.90909225  B5.7664448 4717154464 70 0.034 A
\SOUTHEAST\Octavia\ZMND 1 90.90208907 8580285686 600619998 70 0.034 In
\SOUTHEAST\Carter\BAIOZ 90.90209091  80.35164228 602.6573171 17 0.12 A

6 The data in the preview has been truncated due to size limits.
< >
Edit Cancel
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Change the name of the table from Query1l to Unit Specifications

. e ] - e - -

rator ﬂ Met Generation ﬂ Hou

JE25 SOVFERL0125F
L]

269 07 IOFEAFR45F
TR FLFE 1565604
a

236 000262451172
Gl

2]

134 540155730251
S04 73E7 0G4 e094
SE8.257541501563
IFF eleraarelrs
E TN )
5575816137 69551
AF2FPVTRIEANTH

FIELDS

A Search

Refresh data
Edit query

Copy Tahble

Fename

Delete

Unhide all

Meww measure
Mew calumn

Mew quick rmeasure

Hide it report wiew

a

Sign in [ 7]

f{ \ OSlsoft.
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10.11Discussion

This is a discussion designed to maximize learning in a specific topic area.
Your instructor will have questions, and will prompt for communication within
the class. This is an open ended section and the result depends on your
needs.

Objective:

Discuss differences between Pl Integrator for BA and PI OLEDB Enterprise

Approach

e Which method do you prefer to create views? PI Integrator for Business
Analytics or for Pl OLEDB Enterprise?

Pros and Cons of both systems?

What format would we like the data to be in for processing by BI clients?
What should be added to the SQL queries to improve the format?

Do these queries match what we want in our reports?

If not, what is lacking?

Estimated Completion time 10 minutes.
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11Building the “Fleet Generation” Report

We have now done enough preparation work that we can finally start building the
report.

11.1Preparing and Importing the Tables

In our case, we are going to separate the time-series data from the static data and configure
table relationships to join the data sets together. Ideally, Pl AF can be the glue that ties multiple
data sources together and lends context to the data. Technically, we could put all of our static
data into P1 AF using table lookups and by assigning attribute values, then designing the
gueries such that the result set is a single table. However, in real life not all of the data is always
in Pl and several data sources must be joined together. This can of course be done at the query
level, but also in Power BI.

There are ways to avoid doing many of the following steps, but this will help prepare you for real
world reports where constant modifications and fine-tuning must be performed.

11.1.1 Directed Activity — Select Static Data Only from Snapshot Query

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:
Modify the existing query to only include static data.

Approach:

o Open the Power BI query editor to inspect a pre-existing query
o Modify the SELECT statement to only include static data columns
o Replace the query in the query editor with a new query
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On the Home tab, Edit Queries

* |

Home e Maodeling Help

- DDDEZ[%\Jll

Copy
Paste Get Recent  Enter Edit Refrash Mews  Mew B
Page = “Wisual

Format Painter  Data~ Sources= Data  |[Queries =

Clipboard External d) A Edit Queries In

L Data source settings

Edit Parameters

Edit Wariahles

In the Query Editor window, click the Gear to change the input query
= Untitled - Power Query Editor ==

Home = Transform  Add Column  Wiew  Help ~ @
I D D D P D [if Properties m " & T Data Type: Text =
il =] 4 AN
-t ® s a h =

LT Advanced Editor i [ Use First Rowr a3 Headers
Close &  Wew  Recent Enter  Data source NManage Refresh Manage Reduce Split Group L
Apply™  Source T Sources T Data settings Farameters = Preview = [ Manage - Columns ~ Rows ~ Column~ By 5z Replace Values
Close Mew Query Data Sourc..  Parameters Query Sart Transfarm

0 This preview may be up to 37 days old. Refresh

Queries [1] QUERY SETTINGS

- plll 1.2 Generating Efficiency - 1.2 Urilization
| BB Units = \CENTRAL\Carbondale\TCBOG 8090908784 “ PROPERTIES

\CENTRAL\Carbondale\TCBOS 90.90909091 Name
\CENTRAL\Carbandale\TCB04 89.28880574

\CENTRAL\Albertsville\ GAODL 50.90909342

\CENTRAL\Albertsville\ GAOD2 0

\CENTRAL\Beryl Ridge\BCUO1 88.62555559

\CENTRAL\Beryl Ridge\BCU02 80.90909051 Source
\CENTRAL\Carbondale\TC801 90.90909081

\CENTRAL\Carbandale\TC802 80.13719929

\CENTRAL\Carbondale\TCB03 50.90909262

\SOUTHEAST\Wolverine Station{ALX01 90.90909051

\SOUTHEAST\Vicksberg\MAMO4 81.9129439

\SOUTHEAST\Vicksberg\MAMO3 90.90909456

\SOUTHEAST\Vicksberg\MAMO2 90.90909151

\SOUTHEAST\Vicksberg\MAMO1 90.90909038

\SOUTHEAST\Stamptan\MND02 78.99272842

\SOUTHEAST\Stamptan\MNDOL 77.76172552

<
15 COLUMNS, 30 ROWS. PREVIEW DOWNLOADED ON WEDNESDAY, AUGUST 22, 2018

4 APPLIED STEPS

Select all the query text and Copy it:

X
From OLE DB
Connection string (non-credential properties)
provider=PIOLEDBENT. 1;initial catalog="Fleet Generation®;data source=PISRV(1
Build
4 Advanced options
SQOL statement (optional)
ISELECT eh.Path + eh.Name Element, ts.[Generating Efficiency], ts.[Utilization],
c.[Total Hourly Gross Generation], ts.[Carbon Emissions], ts.[Generation Rate], ~
c.[Unit Status], ts.[Technology], ts.[Shift Hours], ts.[Shift], ts.[Operator],
s.[Net Generation], ts.[Hourly Capacity], ts.[Gross Generation], ts.[Demand]|
U [sset].[ElementTemplate] etj
ndo
Cut
Paste
Delete v
Send to OneMNote
Select all
Ok Cancel
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Paste the query into Pl SQL Commander. Execute it as a sanity check.

File Edit View Query Tools Help

"2, New Query I’ Execute IJ &3 &9 € Query Compendium

Object Explarer
nEHEE

4 [JJOLEDE Data Sources
4 ([BPI OLEDE Enterprise
4 [FISRVDT

[ Query9.sql - PISRVOT® X | [ Quenyisql - PISRVOT | 3 Queny7sgl - PISRVOT™ |

SELECT eh.Path + eh.Mame Element, ts.[Generating Efficiency], ts.[Utilization],
ts.[Total Hourly Gross Generstion], ts.[Carbon Emissions], ts.[Generation Rate],
ts.[Unit Status], ts.[Technology]. ts.[Shift Hours], ts.[Shift]. ts.[Operator].
ts.[Net Generation]. ts.[Hourly Capacity]. ts.[Gross Gemeration], ts.[Demand]
FROM [Fleet Generation].[Asset].[ElementTemplate] et

4 [Catalogs INNER JOIN [Fleet Generation].[Asset].[Element] e
ON et.ID = e.ElementTemplateID
b ] Configuration INNER J0IN [Fleet Generation].[Asset].[ElementHierarchy] eh
b | Distribution Metwork ON e.ID = eh.ElementID
M u Fleet Generation INMER JOIN [Fleet Generation].[DataT].[ft_TransposeSnapshot_Gas Turbine] ts
ON eh.ElementID = ts.ElementID
b [Asset WHERE et.Name = N'Gas Turbine'
4 [abaa UNION
5 [ Tables SELECT eh.Path + eh.Mame Elemerjt, ts.[Generating I.Efffclen:y], ts-[Utll]..ZE'tan],
ts.[Total Hourly Gross Generstion], ts.[Carbon Emissions], ts.[Generstion Rate],
by Views ts.[Unit Status], ts.[Technology]. ts.[Shift Hours]. ts.[Shift]. ts.[Operator].
b [3Functions ts.[Net Generation], ts.[Hourly Capacity]., ts.[Gross Generation], ts.[Demand]

e T o PRSI - S T = DI =S e H
a4 | _4DataT

[Mresults
a4 [ _JTables

%ﬂ_TmnssteArd]we_

. CENTRAL | Carbondale
Eyft TransposeArchive, CENTRAL | Carbondale
[ft_TransposeEventFr CENTRAL | Carboncale
[Jyft_TransposeEventFr CENTRAL | Carbondale
E&ﬂiTmnsstelmerpulz CENTRAL | Carbondale

| CENTRAL | Carbondale
[ ft_Transposelnterpol: CENTRAL | Carbondale
Clyft_Transposelnterpol: CENTRAL | Carboncale
%H_Tmnspuselnterpulz CENTRAL | Carbondale

Region Station Time Generating Efficiency  Utilization Total Hourly Gross Generation
2018-09-20 00:00:00.000 | 89.4993286274451 44 4346579841303 | 266 967947904782
2018-09-20 01:00:00.000 | 89.2700634095682 44 916754968172 | 269 500529809032
2018-09-20 02:00:00.000 | 90.4221487181715 41.8919795813633 | 251.35187748818
2018-09-20 02:00:00.000 | 90.5031758955755 106.860722484256 | 641.164334905502
2018-09-20 04:00:00.000 | 90.159650584514 106.403557819768 | 632.42134691861
2018-09-20 05:00:00.000 | 87.0302448185058 34 6782450613984 | 208 D69434365391
2018-09-20 06:00:00.000 | 85.913184251622 39.6662891197181 | 237.997734718309
2018-09-20 07:00:00.000 | 87.1400328918215 39.4925959722664 | 236 955575833598
2018-09-20 08:00:00.000 | 77.6236796541576 39.525156622148 | 237.150939732888
E‘Lﬂ_TmnspnseSnapsh( CENTRAL | Carbondale 2018-05-20 03:00:00.000 | 90.909088773987 76.2554509890086 = 457 532705934051
CENTRAL | Carbondale 2018-09-20 10:00:00.000 | 90.9090887854222 110 EED
@ﬂiTmnssteSnapsh(
Carbondale 2018-09-20 11:00:00.000 | 91.6497004238853 85.9601694007106 | 515.761016404264
b [AViews Carbondale 2018-09-20 12:00:00.000 | 91.3441458100058 £3.8528279014918 | 382 117567408952
b [ Functions Carbondale 2018-09-20 13:00:00.000 | 50 4075447520604 £7.3538943132683 | 404 15336587961
| [L4EventFrame " (zrhandzla 20120870 14-00:00 I'I': a0 180218720715 £R AATI1 19974524308 ARAATIEATY

&I 1 Fleet Generation Sim
Q Query executed successfully PISRVO1 (AF Server) | 00:00:01.885 | 5070 rows.
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Now the actual modifications. Head over to Pl SQL Commander and edit the select statement to
only include static attributes: Carbon Emissions, Generation Rate, Hourly Capacity, Operator,
Shift Hours, and Technology.

| General I hild Elerments | Attributes |F'|:|rt5 | Analyses | Natification Rules | Yersion |

| Fittar D ~ |
& 4 38 € K Name &/ Yalle @
= Category: <Mone:=

] = | Carbon Emissions 405 gk
] &% Exhaust Gas Temperature - #1 Probe 59,838 °C
= <% Exhaust Gas Temperature - #2 Probe 62,96 °C
= «F Gas Fuel Flow 70,608 US gal/min
@ «F zas Fuel Pressure 52,568 bar
] &¥ Gas Turbine Speed 43,536 rpm

s B % | ¢F Generating Efficiency Q0,909 %%
] =| Generation Rate 0.078 $/kwh

s B | gF Total Hourly Gross Generation 430.5 Mrh

g HE (_’:f Ikilizakion 78,274 %

=] Category: Demand
= «F Demand 23,549 MW

= Cateqary: Hourly Generation

] «¥ Gross Generation 425,02 My
= <% Met Generation 386,38 MW
= Cateqory: Identity

@ = | Hourly Capaciky 550

] =] Qperator B3

= ¥ shift 3

= =1 5hift Hours gh

@ =] Technalogy Matural Gas

= Category: Skatus

= <% Unit Skatus Ackive
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The resulting query is then
SELECT eh.Path + eh.Name Element, ts.[Carbon Emissions], ts.[Generation
Rate],
ts.[Technology], ts.[Shift Hours], ts.[Operator], ts.[Hourly Capacity]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e ON et.ID =
e.ElementTemplatelD
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh ON e.ID =
eh.ElementID
INNER JOIN [Fleet Generation].[DataT].[ft_TransposeSnapshot_Gas Turbine] ts
ON eh.ElementID = ts.ElementID
WHERE et.Name = N'Gas Turbine'
UNION
SELECT eh.Path + eh.Name Element, ts.[Carbon Emissions], ts.[Generation
Rate],
ts.[Technology], ts.[Shift Hours], ts.[Operator], ts.[Hourly Capacity]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e ON et.ID =
e.ElementTemplatelD
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh ON e.ID =
eh.ElementID
INNER JOIN [Fleet Generation].[DataT].[ft_TransposeSnapshot_UNIT] ts ON
eh.ElementID = ts.ElementID
WHERE et.Name = N'UNIT'
OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS)

Paste the above query back into the Power Bl query editor and click OK

From OLE DB

Connection string (non-credential properties) G

provider=PIOLEDBENT. 1;initial catalog="Fleet Generation®;data source=PI3RV01

Build
4 Advanced options

SQL statement (optional)

SELECT eh.Path + eh.Name Element, ts.[Carbon Emissions], ts.[Generation Rate],

ts.[Technology], ts.[5hift Hours], ts.[Operator], ts.[Hourly Capacity] ~
FROM [Fleet Generation].[Asset].[ElementTemplate] et

INNER J0IN [Fleet Generation].[Asset].[Element] e OM et.ID = e.ElementTemplatelD

INNER J0IN [Fleet Generation].[Asset].[ElementHierarchy] eh ON £.ID = eh.ElementID

INNER 10IN [Fleet Generation].[DataT].[ft_TransposeSnapshot_Gas Turbine] ts ON eh.ElementID =
WHERE et.Name = M'Gas Turbine'

UNION

SELECT eh.Path + eh.Name Element, ts.[Carbon Emissions], ts.[Generation Rate],

ts.[Technology], ts.[Shift Hours], ts.[Operator], ts.[Hourly Capacity]

FROM [Fleet Generation].[Asset].[ElementTemplate] et v
IN@ER JOIN TFleet Generationl.lAssetl.lElementl & OM et.ID = 2.ElementTemolatelID >
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Close the query editor

Untitled - Power Queny Editor \;‘E!

I:l L Y s 4 ¥ % Data Type: Text ~ B Merge Queries =
x EHﬂ EEH El I_ —l ] Use First Row as Headers = z.ﬂ\ppend Jueries T
Choose Remowe Keep Remowe Split Group 1 . .
Columns * Columns®  Rows ™ Rows ™ Column~ By = Replaceialues Cambine Files
hManage Calumns Reduce Fows Sort Transform Combine

Click Yes to apply changes

Power Query Editor ;

Do you want to apply your changes now? h

Mot now Cancel 3

It should reload the data (30 rows) successfully.

Carbon Emissionsﬂ Generation Rate ﬂ Technology ﬂ Shift Hours ﬂ Operator ﬂ Hourly [:apacityﬂ Element
405 0.678 Matural Gas & BSK &00 \CEMTR&LYCarbondal e TCROS
408 0.07% Matural Gas 5 BEX &80 WCENTRALWCarbondalehTCROS
405 0.678 Matural Gas & BSK &00 \CEMTR&LYCarbondal e TCRO4
405 0.07F Matural Gas g BEX 550 S CENTRALWAI bertsyil ey GA00L1
405 0.078 Matural Gas & BSH &80 \CEMTRALYAI bertsyi | ehGA002
405 0.07F Matural Gas g BEX G068 WCENTRALWEeryl RidgzelBCUOL
405 0.078 Matural Gas 5 BEM 550 SCEWNTRALWBeryl Ridze\BCLO2
45 0.07F Matural Gas & BSK &50 ACEMTRaLCarbondalelTCROL
405 0.078 Matural Gas 5 BEM 08 WCEMTRALYCarbondalehTCROZ
45 0.07F Matural Gas & BSK £50 SCEMNTRaALCarbondalelTCROS
17 2.LF Wind 12 oG 500 4 S0OUTHEASTYWolverine Stationial-01
S70 2.034 Coal 12 BEX 700 ZSOUTHEASTYYicksberghMARMOS
70 0.034 Coal 12 BSX 70O W SOUTHEASTWWicksbergyWAMOS
470 0.034 Coal 12 BEM 700 \SOUTHEASTYYicksbergyMARO2
70 0.054 Coal 13 BEX G008 WIOUTHEASTYYicksbergyhAMOL
405 0.078 Matural Gas 12 BEM S50 ZSOUTHEASTY StamptonMMNDO2
45 0.07F Matural Gas 18 BSW G50 WSOUTHEAST Starmpront M DOL
78 0.234 Coal 12 BSX 550 4 SOUTHEASTYOctawi 3WZ0AN02
a7 (.254 Coal 18 BSW FOO A SOUTHEAST Octawi a2 0L
17 2.2 Wind 12 PRT FEO WSOUTHEASTA\Carter\ B0z
17 .12 Wind 12 BSK S50 ZSOUTHEASTYBrick Canyon'PLTO2
17 2.LF Wind 12 BSX 500 4 SOUTHEASTWBrick Canwon',PLTOL
17 .12 Wind & oG &00 SMORTHYMew BedfordiPOEOL
17 2.L2 Wind & oG &08 WNORTHWMadison',CECOL
470 0.034 Coal & PEE 750 \MORTHGreenl awn'PTCO3
70 0.054 Coal & NOP 500 WNORTHYGreen! awn'FTOO0Z2
470 0.034 Coal & MOP &00 Z\MORTH W Greenl awnPTCOL
45 0.07F Matural Gas & BSK £50 \NORTH\Ebbitty POEDS
405 0.078 Matural Gas 5 BEM 500 YNORTHAEbbitthPOEDS
45 0.07F Matural Gas & BSK &50 WORTHA\Ebbitt POEDZ
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11.1.2 Directed Activity — Split the Element Column

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

There is still a problem with the data set. We will need to split the Element column
into the Region, Station, and Unit name. This could of course be done in the query,
but instead we’ll use the Power Bl split columns feature.

Approach:

e Open the Power BI query editor and use Split Columns

On the Home tab, Edit Queries

With the Element column selected, select Split Column -> By Delimiter
Wl H=| Untitled - Power Query Editor == -

File Home  Transform Add Column View  Help ~ @
=X |:b. P El E; D [:2 Praperties L Yy e 5] % Data Type: Text = 5 Merge Queries =
O] 5] A
=t =7 [} Advanced Editor x EEﬂ BEE ) [ Use First Rows as Headers » 55 #ppend Queries ~
Close &  Mew Recent Enter Datasource  Manage Refresh Choose  Remove  Keep Remove Group o
Apply - Source~ Sources - Data seftings Parameters~  Preview = [0 Manage = Calumns = Calumns = Rows = Rows~ -] By Replace Values Combine Files
Close M Query Dats Sources  Farameters Query Marage Columns Reduce Rows  Sork By Delimiter Combine

By Number of Characters
12 Carbon Emissions  |Jll 1.2 Generation Rate [l A% Technology » o B 12| QUERY SETTINGS
CENTRAL\Carbondale\TCB06 0.078 Nawral Gas

\CENTRAL\Carbondale\TCBOS 0.078 Natural Gas 4 PROPERTIES

Queries [1]

| FH unit Specifications.
CENTRAL\Carbondale\TCB04 0.078 Natural Gas Name
(CENTRAL\Albertsville\GAOD1 0.078 Natural Gas U

CENTRAL\Albertsville\GAOD2 0,078 Natural Gas
CENTRAL\Beryl Ridge\BCUO1 0.078 Natural Gas

(CENTRAL\Beryl Ridge\BCU02 0.078 Natural Gas < APPLIED STEPS

CENTRAL\Carbondale\TCBOL 0.078 Natural Gas Source
NIRAL\CArbondais\TCE0 0.078 Natural Gas

e © v o v s w e o B
0
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Power Bl automatically detected that \ is probably the desired delimiter. The defaults
should do exactly what we want here. Just in case though, ensure the following
settings are selected and click OK:

Split Column by Delimiter

Specify the delimiter used to split the text column.

Select or enter delimiter

—Custom— M

\

Split at
Left-most delimiter
Right-mast delimiter

I = Each occurrence of the delimiter I

4 Advanced options
Split into

® Columns

Rows

Number of columns to split into
[« |

Quote Character

® Split using special characters

Insert special character -

Power Bl creates a blank column for the first split, Right-click -> remove it:

al | 5= |

Home Transfarm Add Calumn i e Help
R GRE G 5 B
Ty ]
- = =] Advanced Editar

Close & Mewy Recent  Enter Data source Manage Refresh

Apply s Source ™ Sources v Data settings Parameters =  Preview= [ Manage =
Close Mews Cuery Data Sources  Parameters Query
Queries [1] M| A°- Blement.? M B Bement.3
Em  Copy lale
| % Unit Specifications. lale
Rermowe Other Colurmns e
Duplicate Colurnn Bt
FJ Add Column From Examples.., R
ige
Rermowe Duplicates ige
Retronwve Errors lale
Change Type y lale
Transfarrn y lale
L Replace Walues.., e Station
E¥ -

Replace Errors...

Rename Element.2 to Region, Element.3 to Station, and Element.4 to Unit:
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Copry

Rermowve
Rermowe Other Columns
Duplicate Calurmn

Add Colurmn From Exarmples..,

Fermowe Duplicates

Rermowe Errars

Change Type

Transform

Replace Walues..,

Replace Errars..

Split Colurmn

Group By...

Fill

Unpivot Colurmns

Unpivot Other Colurnns
Unpivot Only Selected Colurnns

Rename...

Mloe

Dirill Drovivery

It should now look like the following. Also, note that a number of transformation steps
have been applied. Whenever the report is refreshed, these transformations will be
performed on the raw input:

W 5=l

File Home Transform #dd Column

e 6 [ B 3

Close & Wew  Recent  Enter  Data source
Apply~  Source ™ Sources Data settings

Close New Query Data Sources

Queries [1]
CENTRAL
CENTRAL
CENTRAL
CENTRAL
CENTRAL
CENTRAL
CENTRAL
CENTRAL
CENTRAL
CENTRAL
SOUTHEAST
SOUTHEAST
EN soUTHEAST

| BB Unit Specifications

o w o w s wn ~ W

View  Help

(3

Manage  Refresh
Farameters = Preview + [ Manage ~

Parameters

Bl 48 station
Carbondale
Carbondale
Carbondale
Alpertsville
Albertsville

Beryl Ridge

Beryl Ridge

Carbondale
Carbondale
Carbondale
Wolverine Station
Vicksberg
Vicksberg

Untitled - Power Query Editor

[y Properties L Y
LT advanced Editor X E;H EEH

Choose  Remove  Keep Remowe Split Group
Columns ~ Calumns *  Rows ™ Rows * Column~ By a2 Replace Values
Query Manage Columns  Reduce Rows  Sort

B .2 cabon Emissions [l 12 GenerationRate  [Rll A Technology [l 133 Shift Hours

0.078 Natural Gas
0.078 Natural Gas
0.078 Natural Gas
0.078 Natural Gas
0.078 Natural Gas
0.078 Natural Gas
0.078 Natural Gas
0.078 Natural Gas
0.078 Natural Gas
0.078 Natural Gas
0.12 Wind

0.034 Coal

0.034 Coal

dh =

[T Use First Row as Headers +

5 Merge Queries -
T Append Queries v
Combine Files

Combine

B «%| QUERY SETTINGS
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Close the query editor, Click Yes to apply changes. Now the data is in a suitable
format.

Carbon Emissions - Generation Rate n Technology - Shift Hours ﬂ Operator - Hourly Capacity ﬂ Region - Station ﬂ Unit -
Lt 0078 MWatural Gas § BSK & CEMTRAL Carbondale TCROG
405 0078 Matural Gas § BSK &50 CEMTRAL Carbondale TCROS
405 0078 Matural Gas § BSH S0 CEMTRAL Carbondale TCRO4
L) Q.078 MNatural Gas § BSH 550 CEMTRAL albertsville GAO01
Lt 0078 MWatural Gas § BSK &5l CEMTRAL albertsville GA002
405 0078 Matural Gas § BSK &S00 CEMTRAL Beryl Ridze BCLIOL

11.1.3 Directed Activity — Import the Interpolate Range data

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

Start with predefined queries for Units and Gas Turbines, restrict the result set to
exclude static data, and union the results to form a single table.

Approach:

¢ Execute predefined query for TransposelnterpolateRange
e Modify the SELECT statement to only include static data columns
o Replace the query in the query editor with a new query

Go to PI SQL Commander and execute the predefined query for
ft_TransposelnterpolateRange_Gas Turbine.

[ L ft_TranzposelnterpolateRange Gas Turbine
¥ | Execute Predefined Query.. UNIT

#] | Refresh rhine

Modify the select statement to split the Element column into Region, Station, and
Unit using the ParentPath() function. Recall that we did this in Power Bl in a
previous exercise. Execute the Query to ensure there are no syntax errors.

SELECT ParentName(eh.Path,1) as [Region], ParentName(eh.Path,0) as
[Station], eh.Name as [Unit], tir.*

Also replace the tir.* part to exclude ElementID, StartTime, EndTime, and Timestep
columns so that only the Attributes that change over time are included. We will also
exclude those attributes unique to Gas Turbines. Execute the Query to ensure there
are no syntax errors.
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SELECT ParentName(eh.Path,1) as [Region], ParentName(eh.Path,0) as
[Station], eh.Name as [Unit],

tir. Time, tir.[Generating Efficiency], tir.[Utilization],

tir.J[Total Hourly Gross Generation], tir.[Shift],

tir.[Net Generation], tir.[Gross Generation], tir.[Demand]

Change the StartTime to T, EndTime to T-7d, and Timestep to 1h
AND tir.StartTime = DATE(N'T-7d")
AND tir.EndTime = DATE(N'T")
AND tir.TimeStep = N'1h'

Copy and paste the query before the OPTION statement, then replace Gas Turbine
with UNIT in the reference to ft_TransposelnterpolateRange_Gas Turbine and the
WHERE clause, and insert a UNION:

SELECT ParentName(eh.Path,1) as [Region], ParentName(eh.Path,0) as
[Station], eh.Name as [Unit],
tir. Time, tir.[Generating Efficiency], tir.[Utilization],
tir.[Total Hourly Gross Generation], tir.[Shift],
tir.[Net Generation], tir.[Gross Generation], tir.[Demand]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e
ON et.ID = e.ElementTemplatelD
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID
INNER JOIN [Fleet Generation].[DataT].[ft_TransposelnterpolateRange_Gas
Turbine] tir
ON eh.ElementID = tir.ElementID
WHERE et.Name = N'Gas Turbine'
AND tir.StartTime = DATE(N'T-7d")
AND tir.EndTime = DATE(N'T")
AND tir.TimeStep = N'1h'
UNION
SELECT ParentName(eh.Path,1) as [Region], ParentName(eh.Path,0) as
[Station], eh.Name as [Unit],
tir. Time, tir.[Generating Efficiency], tir.[Utilization],
tir.[Total Hourly Gross Generation], tir.[Shift],
tir.[Net Generation], tir.[Gross Generation], tir.[Demand]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIN [Fleet Generation].[Asset].[Element] e
ON et.ID = e.ElementTemplatelD
INNER JOIN [Fleet Generation].[Asset].[ElementHierarchy] eh
ON e.ID = eh.ElementID
INNER JOIN [Fleet
Generation].[DataT].[ft_TransposelnterpolateRange_UNIT] tir
ON eh.ElementID = tir.ElementID
WHERE et.Name = N'Unit’
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AND tir.StartTime = DATE(N'T-7d")
AND tir.EndTime = DATE(N'T")
AND tir.TimeStep = N'1h'
OPTION (FORCE ORDER, IGNORE ERRORS, EMBED ERRORS)

Execute the query to make sure it still works. Then head back to Power BI.
In Power BI, do Get Data -> OLE DB. Build the connection string, enter the query
where it says Advanced options, and click OK. Inspect the preview and Load the

data.

We've done this before so there isn’t a screenshot for every click this time.

From OLE DB

Connection string (non-credential properties) G

provider=PIOLEDBENT. 1:initial catalog="Fleet Generation”data source=PISRV(1

4 Advanced options -

501 statement (optional)

SELECT ParentName(eh.Path,1l) as [Region], ParentNames(eh.Path,®) as [Station], eh.Mame as [Uni:
tir.Time, tir.[Generating Efficiency], tir.[Utilization], ~
tir.[Total Hourly Gross Generation], tir.[Shift],
tir.[Net Generation], tir.[Gross Generation], tir.[Demand]
FROM [Fleet Generation].[Asset].[ElementTemplate] et
INNER JOIM [Fleet Generation].[Asset].[Element] &
ON et.ID = e.ElementTemplatelD
INNER JOIM [Fleet Generation].[Asset].[ElementHisrarchy] eh
ON e.ID = eh.ElementID
IMNER JOIM [Fleet Generaticn].[DataT].[ft_TransposelnterpolateRangs_Gas Turbine] tir
ON eh.ElementID = tir.ElementID v
WHERE et.Mame = N'Gas Turbine'
< pd

It should import 5070 rows, 30 units x 24 hours x 7 days = 5040, plus 30 rows (1 per
unit) for the start time.

Rename Queryl to Unit Performance

X2 search

Unit Performance -
Meur rmeasure
Mewe colurmn
Mews quick measure
Refresh data
Edit query

Copy Table

Rename
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11.1.4 Directed Activity — Inspect Table Relationship

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

Inspect the automatically created table relationship. Power Bl should have detected
two identically named columns exhibiting a one-to-many relationship.

Approach:

e Open the Power Bl relationships tab and inspect the existing relationship

In Power B, Go to the Relationships tab, then move the Unit Performance table to
the right so that the relationship line is clearly visible and click on the line:

E Unit Specifications
Carben Emissions.
Generation Rate
Technology
shift Hours
Operator
Hourly Capacity
Region

Station

Unit

We can see that Power Bl has already detected the relationship between the two
tables. This can be thought of as a graphical representation of an INNER JOIN
statement. These tables are now joined on the Unit column. For this to work, one of
the tables must only contain unique values in the Unit column (ie. the column can
serve as a key), as is the case here. This is referred to as a one-to-many relationship
in some documentation. Each Unit only appears once in the Unit Specifications
table, whereas each Unit appears many times in the Unit Performance table.

Relationships can be manually defined using a drag and drop interface, or through
Manage Relationships.
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al | = | Untitled - Pawer Bl Die
Harne Madeling Help
(u [ B B L2 o &5
0] (5]
Copy s ,/J Lo Image
Faste i et Recent  Enter Edit Refresh Mew  Mew Buttons Fram From fanage
Format Painter  pata ~ Sources = Data Queries © Page = “isual Shapes Marketplace  File Relationships
Clipboard External data Insert Custom wisuals Relationships

However at this point there is no need.

11.2 Augmenting the Data using DAX

Next we will add a few calculations to the Unit Performance table that will help
assess the total Emissions produced and the total cost of generation. We will also
add columns for the day of the week and sort the Weekday in Sunday -> Saturday
order.

11.2.1 Directed Activity — Calculate the amount of CO2 produced every hour

In this part of the class, you will perform a learning activity to explore the
different concepts presented in this chapter or section. You may be invited to
watch what the instructor is doing or perform the same steps at the same time.
You may play a game or hold a quiz. Your instructor will have directions.

Objective:

Add a DAX formula Calculate the amount of CO2 produced every hour

Approach:

e Add and additional column to the Unit Performance table with the amount of
carbon emissions produced.

In Power BI, navigate to the Data Tab and select the Unit Performance table.
Right-click any column and add a new column. Enter the following formula:

CO2 ="Unit Performance'[Total Hourly Gross Generation]* RELATED('Unit
Specifications'[Carbon Emissions]

x vy (02 = 'Unit Performance'[Total Hourly Gross Generation]®*RELATED( 'Unit Specifications'[Carbon v
Emissions ]

Note that Total Hourly Gross Generation has units of MWh, and Carbon Emissions has units of
g/kWh. Grams/kWh is the same as Kilograms/MWh, and therefore the result will be in KG.
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11.2.2 Exercise — Calculate the Generation Cost

This solo or group exercise is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you
need assistance during the exercise.

Objective: Add the cost calculation column to your Unit Performance table

Do you prefer having the calculations within AF as a formula data reference, or within
the BI client tools? What are some advantages and disadvantages of each?

Approach:

¢ Add and additional column named Cost to the Unit Performance table with
the dollar cost per hour.
e Take note of the input units. Cost should be in dollars.

11.2.3 Exercise — Add Column for Day of the Week and sort

This solo or group exercise is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you
need assistance during the exercise.

Objective: Add the day of the week to your Unit Performance table, also add a
column with the numerical day of the week and sort by this value

Approach:

¢ Add and additional column named Weekday which shows the day of the
week as a string using the FORMAT() function

e Add another column named Numday which gives the numerical day of the
week using the WEEKDAY () function

e Sort Weekday by Numday

File Home Modeling Help
= @ =3 B
Manage I et M et [ ety I et Lot by
Relationships  Measure Calumn Table Parameter LCalymn =
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11.3Configuring the Visualizations

Now we will add visuals to the report to convey useful information about the

generating units.

11.3.1 Exercise — Build the Report

This solo or group exercise is designed to maximize learning in a specific
topic area. Your instructor will have instructions, and will coach you if you

need assistance during the exercise.

Objective: Build an interactive Report comparing KPIs for different generation
technologies and operators.

Unit  Auverageof  Awerageof
Generating  Uhiliz=tion
Efficiancy

N1 69.12 4004

Prco 6431 2874

Rt 6309 64.15

BADIZ 200 4352

ECU02 1.0 3=

MAMD1 S0.02 5338

DANDZ B 64.04

MAMDZ 5503 5132

MAMDE 5570 4911

T 5205 5340

GAO01 504 £7.50

TCBO6 s7.80 5480

RS Er ] 5609

FQED2 57 713

AL 573 6284

Prcoz S50 5345

FOEM SEAG 5971

T2 EEEE] 3557

RO 522 66.44

T3 5170 60.42

TR EES] a1.21

FQEDZ 48,56 8.2

Prcoz 4817 EER

FOED 4812 3308

ECUO1 aTer 4315

MM 4552 47.60

[XLATLTS 4151 2749

MNDOZ Erf=r] 3251

CECO1 ELE" 26,38

GAOD2 1515 7112

Tkl 5298 FET:)
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C02 and Cost by Technology

Operator
Wind
BEX CoG MNOR PEE PRT
Technology Hatural Bas
Coal Matural Gas Wind
Ayverage of Costby Technology and Operator
Operator @ESK @COG @NOP 0 PEE @PRT
L
Wind
Matural Gas k
Com|
oK SK 10K 15K 20K 25K 30K 3EK 40K

Total Hourly Gross Generation by Weekday and Technology

Technology @Ccs| @MatumlGas @Wind
150K

00K
) l l
aK
sun Mon Tue
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Approach:
e Add a Table showing Average Generating Efficiency and Average Utilization
by Unit
Unit Puerage of Puerage of
aenerating Utiliza tion
E’ff iciency

Ik 6312 40,04
PTCOd 64,231 2874
[= L0 6209 6415
BAIDZ G200 4352
BC Loz G61.00 TR
(Rt (R ] EQoz 3,25
ZhAM 0z t=Re=] 6404
MAMO2 == F] £q.22
[ Rt (N E2.70 4911
TC BO1 205 5340
o lelub| t=Ruki By
TCBOG E7.en E4.e0
TC BOGS Lr.2= Lo
RO EDZ E7.a0 F1.32
ALa0 S ] G628
PTCO2 EL.70 346
FoBE CLdG = |
TCBO2 £3.23 ELRT
R c2ez G644
TCBO3 51.70 G043
TC B e 41.21
RO BED2 43,66 8.2
PTCOz 4217 3220
PZEO 4212 2305
BC oA 4787 4316
M DOA 4552 47 60
Tl A hAC 41.51 2749
MHMD02 37ez 3261
CECO ELNE 26,25
GATO2 1516 F11z2
Tokal L0k 491

¢ Add a Pie Chart showing how the C02 emissions from each generation
technology contribute to the whole. Add a Tooltip that shows the Cost when

the user hovers over the Pie Chart
r = ] B |

Wind

PRT

I Matural Bas
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e Add a Clustered Column Chart showing the Sum of Total Hourly Gross
Generation with Technology as the Legend and Weekday as the Axis

Total Hourly Gross Generation by Weekday and Technology

Technology @Coal @HatumlGas @wind
150K

100K
0K
Sun hon Tue Wed Thu Fri

e Add a Clustered Bar Chart showing the Average Hourly Cost with Operator
as the Legend and Technology as the Axis.

Awerage of Costby Technology and Operator

Operatar @ESK @COG @HNOP O PEE @PRT

Wind

Matural Gas

Coa| e ——

oK EK 10K 15K 20K 25K 20K 5K 40K

e Add Slicers for the Operator and Technology
Operator

BEX CoG MHOP PEE PRT

Technology

Coal Matural Gas i

e Optionally improve the look and feel of the report through the use of
formatting. Bump up the font sizes, adjust column names and titles, etc.
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12Final Exercise: Create a Report

Objective:

Determine the carbon footprint of each unit and display on a US map. Also create a
report to analyze downtime (Inactivity) events.

Approach:

Create a new Sheet in the Fleet Generation Report (the imported tables will
be re-used)

Geospatial information for all units in Fleet Generation is located in
C:\Class\Final Exercise\Unit Coordinates.xlIsx. This data will need to be
imported into the data cube.

al | = |

Hame Modeling Help
Cut D |
0 rd

E|’E“| Copy
Faste ) Get | Recent  Enter Edit
Format Painter | Data = |Sources = Data  Queries =
Cliphoard Kost Common

. ‘ Excel e

To get the Inactivity Events, you can either use Pl OLEDB Enterprise or PI
Integrator for BA.

o You need a column to form the relationship between the Unit
Specifications table and the Inactivity Event Frames, it’s probably
easiest to join on Unit Name (GAOOQ1, etc).

o Extract Event frames for the last 7 days

o If using Pl Integrator for BA to publish the event frames, it's
probably easiest to add the Unit Name to the Event Frame template.

o Ifusing PI OLEDB Enterprise, start with the
ft_TransposeEventFrameSnapshot_Inactivity predefined query and
modify it as necessary.

Import the Inactivity events for the last 7 days using whichever method you
prefer.

Create the table relationships (should happen automatically if all columns are
named Units).
o Between the Unit Specifications table and the longitude/latitude table
o Between the Unit Specifications table and the Inactivity query results

:'/--
/
.

$,
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Hints:

Insert a map within the client to display the location of each of the units and the
associated total hourly carbon emissions.

Insert a table showing the number of downtime events (Inactivity Event Frames) and
average duration of event frames for each unit. Add the Average Utilization to the same
table.

Configure the report in such a way that the Table relationships are tested. Use data from
multiple tables in the same Visual.

Customize the display to make it more user friendly for later use and report generation.
Improve the formatting and add slicers.

If using PI Integrator for BA to publish the Inactivity Event frames, the Data Context must
be set to Second or else it will round to the nearest whole hour (which will always be
Zero).

InactivityTest .
S ® Column Details

Name

Star Time Event Frame Duration

va"‘!e e Reset Mame to Default
1marized Walues —
=7 Js52]
Data Content
Ewent Frame Duration Demand

g00 14212

g0 232254

GO0 175,188

g00 276.886

g00 231.862

2000 265.04

200 183 634

300 133182 Femo

a0 182.241

200 254 449

GO0 20843
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A sample of what the report could look like:

Gross Generation by Region (MWh)

Fleet Generation Report

Technology & v
s e, B e,
Operatar ALXO1 0.20 136 98.46
BSX coG NOP PEE PRT om BaJ02 0.21 158 69.34
1 . BCUO1 021 175 69.97
CO2 Emissions by Unit SOUTHEAST CENTRAL NORTH BCUO2 022 161 99.46
Urit Poendt CECO1 020 163 3098
®:2001 S ; GAOO1 0.20 162 85.50
o802 " GAO02 021 156 10.54
®8cU0t O MAMO1 021 171 73.97
BcU02 : MAMO2 020 158 84.48
@cEco g A MAMO3 022 160 65,57
001 . MAMO4 021 146 39.12
MNDO1 021 164 40.76
$ero0z MNDO2 0.19 158 4894
il BRITISH PLTO1 020 161 106.83
@MaMo2 LUMBIA PLTO2 022 160 113.27
MaMO3 POEO1 021 160 40.03
®MAMDA PQE02 020 165 58.66
it PQE03 020 157 11675
. PQE04 022 158 84.47
i JCalgary PTCO1 021 162 39.92
PTCO2 0.20 152 80.34
OFLTE PTCO3 0.20 163 4611
POEQT TCBO1 0.21 152 7853
POEO2 TCBO2 020 161 4151
@POED o : TCBO3 0.21 166 10341
[ Jeldv) Jarcodver O TCBM 0.22 154 60.18
®rTeon TCBOS 020 154 91.09
> ' ms i s s

ictoria 2 5

b Bing ) | @ FASHBRE, © 2018 Misresoft Corporation Terrs ZMN02 020 163 97.32

The above report can be found in C:\Class\Final Exercise\Solution
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13Appendix A Substitution Parameters

Defining the Substitution Parameters
The substitution parameters are listed in the following table. The ones in bold are the commonly
used “Name” substitution parameters for Elements, Attributes, or Event Frames.

Parameter
%..\Element%

%..|Attribute%

% @Attribute%

%\Element%

%<Environment Variable>%

%Analysis%

%Attribute%

%Attributeld%
%Database%

%Description%
%Element%
%ElementDescription%

%Elementld%
%EndTime%

%Model%
%Server%
%StartTime%

%System%
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Will be replaced by this object’s name:

The name of the owning element of the element in
which the attribute resides. To retrieve further
ancestors, use the '..\' notations, such as
%..\..\Element%.

The name of the owning attribute in which the attribute
resides. To retrieve further ancestors, use the "..|
notations, such as %..|..|Attribute%.

The value of the attribute referenced. To retrieve further
ancestors, use the '..|' notations, such as
%@..]..|Attribute%.

The name of the root AF Element in which the attribute
resides.

The matching System Environment Variable’s value. For
example %COMPUTERNAME% is replaced with the
name of the computer on which the Data Reference is
executing.

The name of the analysis if it can be obtained from the
context.

The name of the attribute that holds this data reference.

The attribute ID that holds this data reference.

The name of the AF Database in which the attribute
resides.

The description of the attribute that holds this data
reference.

The name of the AF Element in which the attribute
resides.

The description of the element in which the attribute
resides.

The element ID that holds this data reference.

The local end time if it can be obtained from the time
context.

The name of the model if it can be obtained from the
context.

The name of the default Pl Data Archive of the AF
Database in which the attribute resides.

The local start time if it can be obtained from the time
context.

The name of the Pl System in which the attribute
resides.
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%Time% The local time if it can be obtained from the time
context.

%UtcEndTime% The coordinated universal (UTC) end time if it can be
obtained from the time context.

%UtcStartTime% The coordinated universal (UTC) start time if it can be
obtained from the time context.

%UtcTime% The coordinated universal (UTC) time if it can be
obtained from the time context.

A The current reference

[] The default object of the parent collection. For example

\Elements[.] |Temperature returns the temperature
attribute from the primary element of the current
reference’s Elements collection.

[@filter=text] The search string in text (e.g. Tank*) matches the given
filter. Supported filters are: @Name, @Index,
@Template, @Category, @ReferenceType,
@Description, @Type, @UOM.

[@Index=#] Returns the result at location # from the collection result.
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14Appendix B Performance Equation Operands and
Functions

Taken from the Pl Data Archive Application User Guide

Operands in Performance Equations

Operand Type Syntax Requirements Examples

Numbers (none) 1342 98.6 .0015 1.2e2

Tagnames In single quotes 'sinusoid' 'ba:level.1’
'ba.phase.l’

PI Time Expressions In single quotes '01-dec-03' '16-jul-94" '

Strings In double quotes "string string string"
"sinusoid"

Functions Must be a Performance TagVal('sinusoid")

Equation function TagAvg('sinusoid’)

Cos('sinusoid’)

Functions Listed By Type

The following tables list all functions by type. This list can also be found in the
PIPC\HELP\PEReference.chm help file.

Math Functions

Name Description

Abs Absolute value

Asin Arc sine

Acos Arc cosine

Atn Arc tangent

Atn2 Arc tangent (two arguments)
Cos Cosine

Cosh Hyperbolic cosine

Exp Exponential

Float Conversion of string to number
Frac Fractional part of number
Int Integer part of number
Log Natural logarithm

Log10 Common logarithm

Poly Evaluate polynomial
Round Round to nearest unit
Sgn Numerical sign

Sin Sine

Sinh Hyperbolic sine

Sqr Square root

Tanh Hyperbolic tangent
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Tan Tangent
Trunc Truncate to next smaller unit

Aggregate Functions

Name Description

Avg Average

Max Maximum

Median Median selector

Min Minimum

PStDev Population standard deviation
SStDev Sample standard deviation
Total Sum

Miscellaneous Functions

Name Description

BadVal See if a value is bad (not a number or
time)

Curve Get value of a curve

DigState Get digital state from a string

IsDST Test whether a time is in local daylight
savings time period

IsSet Test if a Pl value is annotated,
substituted, or questionable

StateNo The code number of a digital state

TagBad See if a point has an abnormal state

Pl Archive Retrieval

Name Description

NextEvent Time of a point's next Archive event
NextVal Point's next value after a time
PrevEvent Time of a point's previous Archive event
PrevVal Point's previous value before a time
TagVal Point's value at a time

Pl Archive Search

Name Description
FindEq Timestamp when point = value
FindGE Timestamp when point >= value

(( ' OSlsoft. Page 219



Analyzing Pl System Data

FindGT Timestamp when point > value
FindLE Timestamp when point <= value
FindLT Timestamp when point < value
FindNE Timestamp when point ~= value
TimeEq Total period when point = value
TimeGE Total period when point >= value
TimeGT Total period when point > value
TimeLE Total period when point <= value
TimeLT Total period when point < value
TimeNE Total period when point ~= value

Pl Archive Statistics

Name Description

EventCount Number of Archive events

PctGood Percent of good time in a period
Range Range of minimum to maximum value
StDev Time-weighted standard deviation
TagAvg Time-weighted average

TagMean Event-weighted average

TagMax Maximum value in a period

TagMin Minimum value in a period

TagTot Time integral over a period

Point Attributes

Name Description

TagDesc Get a point's descriptor

TagEU Get a point's engineering unit string
TagExDesc Get a point's extended descriptor
TagName Get a point's name

TagNum Get a point's ID

TagSource Get a point's point source string
TagSpan Get a point's span

TagType Get a point's type character
TagTypVal Get a point's typical value
TagZero Get a point’s zero value

Time Functions

Name Description

Bod Timestamp for beginning of the day for
given time

Bom Timestamp for beginning of the month for
given time

220




Analyzing Pl System Data

Bonm Timestamp for first of the next month for
given time

Day Day of the month from a time

DaySec Seconds since midnight from time

Hour Hour from a time

Minute Minute from a times

Month Month from a time

Noon Timestamp for local noon of day of a
times

ParseTime Convert character string to time

Second Second from a times

Weekday Day of the week from a times

Year Year from a time

Yearday Day of the year from a time

String Functions

Name Description

Ascii ASCII character code for a character

Char String for ASCII character code(s)

Compare Wild comparison of two strings

DigText Text for a digital state

Format Formatting of a numerical number

InStr Instance of a sub-string

LCase Conversion of all characters to lower case

Len Length of a string

Left First characters in a string

LTrim Removal of blanks on the left side of a
string

Mid Extraction of a sub-string from a string

Right Last characters in a string

RTrim Removal of blanks on the right side of a
string

Trim Removal of blanks on both sides of a
string

UCase Conversion of all characters to upper

case

String Conversion

Name Description
Concat Concatenate two or more strings
String String representing any Pl value

fg OSlsoft.

Page 221



Analyzing Pl System Data

Text

Concatenation of strings for a series of Pl
value arguments
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15Appendix C PI SQL Commander Table
Relationships

m ElementHierarchy
ID

- - ID :

= - ElementAttributelD
- Name — - ElementID _ Value
- Description - Path

- ElementTemplatelD

ElementTemplate

+ - ID — ElementAttributelD
- Time
- Name - Value

ElementAttribute

- ID
— - ElementID
- Name

)
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